Import and Export Guide

Release 9.2.1

Part Number: TP1017-9.2.1B

Make sure you check for updates to this manual at the Agile Documentation Website
Copyrights and Trademarks

Copyright © 1995-2006 Agile Software Corporation. All rights reserved.

You shall not create any derivative works of this publication nor shall any part of this publication be copied, reproduced, distributed, published, licensed, sold, stored in a retrieval system or transmitted in any form or by any means: electronic, mechanical, photocopying, or otherwise, without the prior written consent of Agile Software Corporation, 6373 San Ignacio Avenue, San Jose, California 95119-1200 U.S.A.; Telephone 408.284.4000, Facsimile 408.284.4002, or <http://www.agile.com/>.

The material in this document is for information only and is subject to change without notice. While reasonable efforts have been made in the preparation of this document to ensure its accuracy, Agile Software Corporation assumes no liability resulting from errors or omissions in this document or from the use of the information contained herein. Agile Software Corporation reserves the right to make changes in the product design without reservation and without notification to its users.

Agile and Agile Software are registered trademarks and Agile Product Collaboration, Agile Product Cost Management, Agile Product Governance & Compliance, Agile Product Quality Management, Agile Product Interchange, Agile Product Portfolio Management, AgileMD, and the Agile Logo are trademarks of Agile Software Corporation in the U.S. and/or other countries. Guaranteed Business Results is a service mark of Agile Software Corporation. All other brands or product names are trademarks or registered trademarks of their respective holders.

Java and Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. or other countries.

Microsoft, Windows, Excel, and Microsoft Internet Explorer are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Oracle, Oracle9i, and Oracle10g are trademarks or registered trademarks of Oracle Corporation and/or its affiliates in the United States and/or other countries.

NOTICE OF RESTRICTED RIGHTS:
The Software is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of “commercial computer software” and “commercial computer software documentation” as such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and when provided to the U. S. Government, is provided (a) for acquisition by or on behalf of civilian agencies, consistent with the policy set forth in 48 C.F.R. 12.212; or (b) for acquisition by or on behalf of units of the Department of Defense, consistent with the policies set forth in 48 C.F.R. 227.7202-1 (JUN 1995) and 227.7202-4 (JUN 1995).

October 26, 2006
## Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Pages Affected</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>05/10/06</td>
<td>All</td>
<td>Initial release of this manual.</td>
</tr>
</tbody>
</table>
| B        | 10/26/06| 1-3, 11-4     | 9.2.1.3  
Chapter 1 – Updated section “Privileges Required to Use the Import Wizard” to include information about new Import privilege. 
Chapter 11 – Updated section “Required Agile PLM Privileges” to include information about new FileLoad privilege. 
See the Agile PLM 9.2.1.3 Readme for additional information. |


# CONTENTS

## Preface
- Agile PLM Documentation ................................................. .xi
- Readme ................................................................. .xi
- Agile Training ........................................................... .xi
- Developer Documentation and Samples ............................... .xi

## Chapter 1 Import Basics
- About the Import Wizard ................................................. 1-1
- What's New in Importing Data ........................................... 1-2
- Before You Use the Import Wizard .................................... 1-2
- Privileges Required to Use the Import Wizard ...................... 1-3
- Recommended Sequence for Importing Data ....................... 1-3
  - Sequence for Importing Product Content .......................... 1-3
  - Sequence for Importing Published Prices ......................... 1-3
  - Sequence for Importing Product Service Requests ............... 1-3
  - Sequence for Importing Supplier Manufacturer Offerings ...... 1-4
  - Sequence for Importing Product Governance & Compliance Objects ........................................... 1-4
- Objects that Can be Imported in Any Sequence .................... 1-4
- Persistence of Import Settings .......................................... 1-4
- When to Import Large Files ............................................ 1-4
- Starting the Import Wizard ............................................. 1-5
- Import Wizard Steps .................................................. 1-5

## Chapter 2 Preparing and Selecting Source Data
- Supported File Formats .................................................. 2-1
- About Agile PLM Fields ................................................... 2-2
  - Printing the Agile Classes Report .................................. 2-2
  - Data Types ............................................................ 2-2
  - Maximum Length Values for Fields .................................. 2-3
  - Parent and Child Fields ............................................... 2-3
- Supported Formats for Date Values .................................... 2-3
  - Setting the Preferred Date Format and Time Zone ................ 2-3
  - Supported Date Formats .............................................. 2-3
  - Specifying Time Zones ................................................ 2-5
  - aXML and PDX Package Date Formats ............................... 2-5
- Importing Currency Values ............................................. 2-5
- Importing Money Values ................................................ 2-7
- Importing Mass Values .................................................. 2-8
- Importing Geographical Locations ..................................... 2-8
- Importing Values to Dynamic Lists .................................... 2-8
- Importing Cascading Lists ............................................. 2-8
- Using BOM Reference Designators ..................................... 2-9
  - Reference Designator Ranges ......................................... 2-9
- Using Leading Zeros in Reference Designator Ranges ............. 2-10
- Importing Reference Designators from aXML and PDX Packages ........................................... 2-10
Chapter 3 Importing Product Content

Selecting Product Content Objects to Import ........................................ 3-1
Importing Items .......................................................... 3-2
    Importing Parts and Documents ........................................ 3-2
    Importing Parent Items with BOMs or AMLs ...................... 3-3
    Importing Items with Multiple Revisions ....................... 3-3
Importing Bills of Material .................................................. 3-3
    Importing Existing and Non-existing BOM Components .......... 3-4
    Importing Find Numbers ............................................. 3-4
    Importing Partial BOMs ............................................... 3-4
Importing Manufacturers and Manufacturer Parts ....................... 3-4
Importing Approved Manufacturers Lists ................................ 3-5
    Automatic Creation of Child Manufacturer Parts ................. 3-5
    Importing Partial AMLs .............................................. 3-5
Importing Quote Histories, Published Prices, and Price Lines ........ 3-5
    Key Price Fields .................................................. 3-6
    Key Price Lines Fields ........................................... 3-6
    Importing Partial Price Lines .................................... 3-7
Importing Customers and Product Service Requests .................... 3-7
    Importing Customers ............................................... 3-7
    Importing Product Service Requests ............................. 3-8
    Importing PSR Affected Items .................................... 3-8
Using Redlining or Authoring Mode ........................................... 3-8
    Selecting a Change Order ......................................... 3-9
    BOM, AML, and Price Lines Rollbacks ........................... 3-9
Importing Site-specific BOMs and AMLs .................................. 3-10
Importing Agile Product Governance & Compliance Data .............. 3-11
    Importing Declarations .......................................... 3-12
    Using Special Export and Import Commands to Complete Declarations 3-12
Importing Attachments from aXML and PDX Packages .................. 3-13
    Importable Attachment Fields .................................... 3-13
    Importing the Latest Version of Attachments .................... 3-13
    URL Attachments .................................................. 3-14
    Attachments and Rollback of Parent Items ..................... 3-14
### Chapter 4   Importing Supplier and System Data

- Importing Suppliers ................................................................. 4-1
  - Importing Supplier Manufacturer and Commodity Offerings ........ 4-2
- Importing Supplier RFQ Responses .......................................... 4-3
  - Importing Responses from Non-Web Suppliers ......................... 4-3
  - Guidelines for Editing Supplier Response Fields ...................... 4-4
- Adding Suggested Alternate Parts to the Response File ................. 4-5
- Importing Responses to Price Scenarios ................................... 4-6
- Valid Values for Supplier Response Fields ................................ 4-7
- Importing a Currency Conversion Table .................................... 4-7

### Chapter 5   Importing Data into a Sourcing Project

- About Sourcing Projects ......................................................... 5-1
- Starting the Import Wizard from a Sourcing Project ....................... 5-1
  - Calculating Rollup Quantities ............................................. 5-2
- Types of Data You Can Import into a Project ............................... 5-2
- Publishing AMLs from a Project to the Item Master ....................... 5-2
- Mapping and Importing Quantity Breaks and Target Costs ............... 5-2
- How Projects Handle Revisions ............................................. 5-3

### Chapter 6   Mapping Import Fields to Agile Fields

- About Mapping Files ............................................................... 6-1
- Key Fields and Required Fields .............................................. 6-1
  - BOM Mapping Requirements .................................................. 6-5
  - Quote History and Published Price Mapping Requirements ............. 6-5
  - Mapping Classes and Subclasses .......................................... 6-5
- Selecting a Change Order and Mapping File .................................. 6-6
- Creating a New Mapping File .................................................. 6-6
  - Mapping Page Two and Page Three Fields .................................. 6-7
  - How Fields are Sorted in the Edit Mapping File Window ................. 6-7
- Reusing a Mapping File .......................................................... 6-8
- Editing a Mapping File ........................................................... 6-9
- Mapping PDX and aXML Packages ............................................ 6-9

### Chapter 7   Creating Transformation Definition Files

- About Transformation Definition Files ....................................... 7-1
- Required Columns and Column Headings .................................... 7-2
- Using PREFIX, SUFFIX, or REPLACE Operations ............................ 7-2
- Using Regular Expressions in the SourcePattern Field .................... 7-3
- Replacing Blank Fields with a Default Value ................................ 7-4
- Generating a Transformation Template ...................................... 7-4
- Transforming Different Types of Data ....................................... 7-4
  - Transforming Item Numbers .................................................. 7-5
  - Transforming MultiList Values .............................................. 7-5
  - Transforming Manufacturer Names ......................................... 7-6
Transforming AML Data ...................................................... 7-6
Reusing Transformation Definition Files .................................. 7-6

Chapter 8  Setting Import Preferences
About Preferences .............................................................. 8-1
Setting Parsing and Validation Options .................................. 8-1
Setting Business Rule Options ............................................. 8-2
Setting Default Types ....................................................... 8-4
Setting Default AutoNumber Sources .................................. 8-4

Chapter 9  What to Do After You Import
Checking the Status of Your Import Session ............................ 9-1
Canceling an Import Operation ............................................ 9-1
Reading the Import Log ..................................................... 9-2
Troubleshooting ................................................................ 9-2
Common Error Messages .................................................... 9-2
Importing Blank Fields ....................................................... 9-3
Mapping All Required Fields .............................................. 9-3
Configuring Parent/Child Fields ........................................... 9-4
Importing Supplier Offerings .............................................. 9-4
Managing SmartRules ....................................................... 9-4
Updating Pending or Released Items and Prices ....................... 9-5
How Import Handles Duplicate Records ................................ 9-5

Chapter 10  Exporting Data
About the Agile Export Wizard .............................................. 10-1
Export Roles and Privileges ................................................ 10-1
Object Classes that Can Be Exported .................................... 10-2
Export File Formats .......................................................... 10-3
Guidelines for Exporting to Microsoft Excel Files and Text Files .... 10-3
About PDX Packages ........................................................ 10-4
Guidelines for Exporting to PDX Packages ........................... 10-4
Starting the Export Wizard ................................................. 10-4
Export Wizard Steps .......................................................... 10-5
Specifying Filters ................................................................ 10-5
Using Saved Filters ........................................................... 10-6
BOM Filters ................................................................. 10-6
Creating Custom Filters .................................................... 10-6
Default Custom Filters ...................................................... 10-6
Exporting Redline BOMs and AMLs for Affected Items .......... 10-7
Specifying a Header .......................................................... 10-7
Downloading the File .......................................................... 10-8
Viewing an Exported File ................................................... 10-8
Exporting Search Results .................................................. 10-8

Chapter 11  Using FileLoad
Overview ................................................................. 11-1
Choosing a FileLoad Client ................................................. 11-2
Before You Begin ............................................................ 11-3
File Size and Batch Limits .................................................. 11-3
Agile PLM Documentation

The Agile documentation set includes Adobe® Acrobat™ PDF files and API reference documentation. The Agile Documentation Web site contains the latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available on your network from which you can access the Agile documentation (PDF) files.

Note: To read the PDF files, you must use the free Adobe Reader™ version 7.0 or later. This program can be downloaded from www.adobe.com.

The Agile Documentation Web site can be accessed through Help > Manuals in both the Agile Web Client and the Agile Java Client. If applicable, earlier versions of Agile PLM documentation can be found on the Customer Support Web site (www.agile.com/support).

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for assistance.

Before calling Agile Support about a problem with an Agile PLM manual, please have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Agile Documentation Web site (http://docs.agile.com).

Agile Training

Agile offers end user, administrator, developer, and implementation training courses. For more information, go to the Agile Training Web page (http://training.agile.com).

Developer Documentation and Samples

Developer documentation and sample programs, if any, for Agile Integration Services, Agile SDK, and ChangeCAST are available to customers that have purchased the applicable application. If you have a valid license key for one of these applications, you can choose the associated PDF from the Agile Documentation Web site and install the files to a location you specify.
CHAPTER 1
Import Basics

This chapter describes what you need to do to get started using the Import wizard. It includes these topics:

- About the Import Wizard
- What’s New in Importing Data
- Before You Use the Import Wizard
- Privileges Required to Use the Import Wizard
- Recommended Sequence for Importing Data
- Persistence of Import Settings
- When to Import Large Files
- Starting the Import Wizard
- Import Wizard Steps

About the Import Wizard

Agile’s Import wizard is a tool used to import data into the Agile PLM system. You can import the following types of information:

Product Collaboration
- Items – Item Master
- Manufacturers
- Manufacturer parts
- Bills of material (BOMs) – Item Master
- Approved manufacturer lists (AMLs) – Item Master
- Sites – Item Master
- Part Groups
- Attachments

Product Cost Management
- Items – Sourcing Project
- Bills of material (BOMs) – Sourcing Project
- Approved manufacturer lists (AMLs) – Sourcing Project
- Quote histories, published prices, and price lines
- Suppliers and their line cards
Supplier RFQ responses
Currency conversion tables

**Product Service & Improvement**
- Product service requests and affected items
- Customers

**Product Governance & Compliance**
- Declarations
- Substances
- Specifications
- Compositions and Bills of Substances for Manufacturer Parts

**What's New in Importing Data**
- **Importing Manufacturer Part Substances** — You can import Manufacturer Part compositions and Bills of Substances from aXML files.
- **Two Level templates** — The Level Template has been renamed to BOM & AML Level Template, which allows you to specify the hierarchical levels of a BOM to import parts, bills of material, and approved manufacturers. If you don’t want to import approved manufacturers, you can use the new BOM Only Level Template. For more information, see “Using Templates to Import Data” on page 2-18.
- **Persistence** — The settings used in the Import wizard now persist during your session. For more information, see “Persistence of Import Settings” on page 1-4.
- **Logging of SmartRule warnings** — If you choose Accept Objects for the SmartRules Warning Violation Behavior preference, the warning is recorded in the Import log. For more information, see “Smart Rules Warning Violation Behavior” on page 8-2.

**Before You Use the Import Wizard**

Before you use the Import wizard, make sure you have the necessary software and privileges.
- To import data into the Agile PLM system, you must have the appropriate Agile PLM privileges. See the next section, “Privileges Required to Use the Import Wizard.”
- To create PDX packages, use the Agile Web Client.
- To view PDX packages, use Agile eXpress. You can download Agile eXpress from the following Website: [http://www.myagile.com/eservices/express/](http://www.myagile.com/eservices/express/)
- To create aXML files, use Agile Content Service (ACS), Agile Integration Services (AIS), or use the Export aXML command from the Actions menu of a declaration. You can view aXML files in any XML viewer, including Internet Explorer.
- Make sure the Agile PLM system has plenty of hard disk space to accommodate importing many large PDX packages and aXML files.
- If you are importing data from text files, check your source data to make sure that it is properly formatted. *Do not skip this step.* The little time spent here will save you far more time in the end.
Privileges Required to Use the Import Wizard

To import Agile data, you must have Create, Discover, Read, and Modify privileges for each type of Agile object you are importing. You must also have the ability to either create and modify change orders or discover and read them. Change orders are needed to redline BOMs, AMLs, and published prices. In addition, you must also have the Import privilege.

If you have questions about privileges, contact your Agile PLM administrator or refer to the Agile PLM Administrator Guide.

To launch Import, you must have the My User Profile role, the Read User privilege, and the Import privilege.

Recommended Sequence for Importing Data

Although you can import objects in any order, it makes sense to import parent objects before importing data for the children.

Sequence for Importing Product Content

If you are importing product content, use the following recommended import sequence:

1. Manufacturers
2. Manufacturer parts
3. Items
4. Bills of material (BOMs)
5. Approved manufacturers lists (AMLs)
6. Part Groups

   Note: If you are importing data from aXML or PDX packages, you can import all the above objects in one session.

When you import data following this recommended sequence, parent items as well as manufacturers and manufacturer parts will already exist and be populated with data when you reach steps 4, 5, and 6 in the preceding list. If you do not follow the recommended sequence, the Import wizard creates objects referenced in the import data. You can go back to a previous step in the sequence (for example, importing items) to import data to objects you created with the Import wizard.

Sequence for Importing Published Prices

A price object references an item or manufacturer part, supplier, and customer. Therefore, those objects need to be imported before prices.

Sequence for Importing Product Service Requests

Product service requests reference customers and suppliers. Therefore, you should import customers and suppliers before product service requests:

1. Customers
2. Suppliers
3. Product service requests
Sequence for Importing Supplier Manufacturer Offerings
Manufacturers referenced by a supplier’s manufacturer offerings must already exist before the offerings are imported. Therefore, you should import manufacturers before supplier manufacturer offerings.

Sequence for Importing Product Governance & Compliance Objects
If you are importing Product Governance & Compliance data, use the following recommended import sequence:
1. Substances
2. Specifications
3. Declarations

Objects that Can be Imported in Any Sequence
You can import the following data at any time in any sequence:
- Attachments
- Programs
- Suppliers and supplier commodity offerings (however, see “Sequence for Importing Product Service Requests” above)
- Supplier RFQ Responses
- Currency Exchange Rates

Persistence of Import Settings
When you use the Import wizard in the Agile Web Client, its settings persist as long as you maintain the session. Persisted Import wizard settings include:
- Import preferences
- Source file configuration (but not the filename and path, which are not persisted)
- Selected content to import
- Selected mapping file
- Selected transformation file
- Selected change number

If you choose a different type of source file, the Import wizard resets the selected content, mapping file, and transformation file. If you log out of the Agile Web Client and then log back in, the Import wizard resets to the default settings.

When to Import Large Files
Agile Import Server supports aXML files and PDX packages, which can contain thousands of objects. For example, you could import hundreds of items from a PDX package, and each item could have several hundred BOM components. Due to the potential for such large source files, when you perform import sessions is important.

If you are importing large amounts of data during one import session, you should perform the session during non-business hours—on evenings or during the weekend—when system usage is low.

How much data is considered a large amount? It depends on your Agile PLM system and the size of your database. Use your best judgment. If you plan to import a large amount of data, do it after hours.
After the import session is finished, you can view the log file in a browser or save it to a file.
Note For faster results, uncheck the Log Transformations preference before importing a large file. For more information, see Chapter 8, “Setting Import Preferences.”

Starting the Import Wizard

The Import wizard provides a simple process for importing data into the Agile PLM system.

To start the Import wizard in either the Agile Java Client or Web Client, choose Tools > Import.

To import an RFQ response or items, BOMs, and AMLs for a sourcing project, you can start the Import wizard from an RFQ or a sourcing project. For more information, see Chapter 4, “Importing Supplier and System Data” and Chapter 5, “Importing Data into a Sourcing Project.”

Note You can also start the Import wizard by clicking the Import button on the Attachments tab of a package. For more information, see “Importing Attachments from an Agile Package” on page 3-14.

Import Wizard Steps

When you begin to import data into the Agile PLM system, the Import wizard has the following steps:

- Import Source – Specifies the import file and the file type.
- Select Contents to Import – Specifies the type of data to import.
- Select Change Order and Mapping File – If you are importing items or prices in Redlining mode, specify a change order for the import session. Also specify how fields in the import data should be mapped to Agile fields.
- Select Transformation Definition File – Specifies how to modify the import data for the target Agile PLM system by replacing, prefixing, or suffixing certain fields. This is an optional step.
- Review Settings and Begin Import – Lets you review your selections and begin the import process.
To import data successfully, it is important to make sure the file you are importing is formatted correctly. This chapter includes these topics:

- Supported File Formats
- About Agile PLM Fields
- Supported Formats for Date Values
- Importing Currency Values
- Importing Money Values
- Importing Mass Values
- Importing Geographical Locations
- Importing Values to Dynamic Lists
- Importing Cascading Lists
- Using BOM Reference Designators
- Guidelines for Excel Files and Delimited Text Files
- Importing Data from Microsoft Excel Files
- Importing Data from Delimited Text Files
- Importing Data from PDX Packages and aXML Files
- Using Templates to Import Data

### Supported File Formats

The Import wizard lets you import data in the following data formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimited Text File</td>
<td>A standard flat text file where each field of data is delimited by a special character, such as a comma or a tab.</td>
</tr>
<tr>
<td>Product Data eXchange (PDX) Package</td>
<td>An industry standard format for product data based on XML (eXtensible Markup Language) technology.</td>
</tr>
<tr>
<td>Agile XML (aXML) File</td>
<td>Agile’s proprietary XML format that includes data not supported by PDX, including prices and suppliers.</td>
</tr>
</tbody>
</table>
About Agile PLM Fields

Before you import data from source files into the Agile PLM system, you should understand the requirements for each field for which you can import data. Certain fields are required, which means they must be mapped in the Import wizard. Fields also have data types, which determine how the data should be formatted, and maximum lengths, which the Agile PLM system validates on import.

Each Agile object has several fields, which are instances of the attributes defined for that object’s class or subclass. There are many Agile classes and subclasses, and the system can be customized with additional user-defined subclasses.

Printing the Agile Classes Report

Before importing data, print the Agile Classes Report from the Agile Web Client. Read the report and become familiar with the Agile data model. Make sure your source data conforms to the data requirements specified in the report.

To run the Agile Classes Report from the Agile Web Client:

1. Click Reports in the Navigation pane.
2. Select Administrator Reports > Agile Classes Report.
3. Click Execute.
4. Specify parameters used to run the report. Click OK.
5. Select the encoding type. Click Continue. Wait several seconds for a File Download window to appear.
6. Save the report your computer.

The Agile Classes Report is a comma-separated text file. It lists the attributes available on each table of each class. It also indicates whether a field is required for the Import wizard. If a field is required for the Import wizard, source data must be mapped to the target field. Otherwise, the object cannot be imported.

Data Types

Each read/write Agile PLM field has one of the following data types:

Table 2-2: Agile PLM data types

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>A string value.</td>
</tr>
<tr>
<td>MultiText</td>
<td>Text that can span multiple lines.</td>
</tr>
<tr>
<td>Date</td>
<td>A date value.</td>
</tr>
<tr>
<td>Numeric</td>
<td>A number rounded to two decimal places.</td>
</tr>
<tr>
<td>Money</td>
<td>Similar to the number data type, but it defaults to four decimal places and its unit is a particular currency.</td>
</tr>
<tr>
<td>List</td>
<td>A string value selected from a list of possible values.</td>
</tr>
<tr>
<td>MultiList</td>
<td>One or more string values (in comma-delimited format) selected from a list of possible values.</td>
</tr>
<tr>
<td>Unit of Measure (UOM)</td>
<td>A numerical quantitative measurement. The value is expressed as a number multiplied by a standard unit (for example, gram or ounce).</td>
</tr>
</tbody>
</table>
Maximum Length Values for Fields

Many Agile PLM fields have a maximum length. If a value exceeds the maximum length for a field, it is invalid and cannot be imported. The Import wizard has a preference that lets you handle values that fail length validation. You can choose to either reject such values or truncate them so they can be imported. For more information, see “Setting Parsing and Validation Options” on page 8-1.

All text fields have a maximum length. Some text fields are restricted to just a few characters. Others, such as the Parts Class > BOM > BOM Notes field can be much longer.

Date fields do not have a maximum length, but all date values must be a date format supported by the Agile PLM system. For more information, see “Supported Formats for Date Values” on page 2-3.

Parent and Child Fields

Several read-only fields have a child relationship with other parent fields. Child fields derive their values from parent fields. Examples of child fields include BOM table attributes like “BOM.Item List02” and “BOM.Item Text01,” whose parent fields are located on Page Two.

It’s important for the Agile PLM administrator to ensure that all child fields are configured identically to their parent fields. Otherwise, problems could occur when you import data.

Supported Formats for Date Values

The Import wizard supports a variety of date formats based on several different criteria, including user preferences and locale.

Note The upper limit for dates is today’s date + 150 years. Date values later than that are invalid and cannot be imported.

Setting the Preferred Date Format and Time Zone

Each Agile user can select a preferred date format.

To change date format preferences for your Agile account:

1 Use one of the Agile clients to set user preferences:
   - In the Agile Web Client, click Settings > User Profile > Preferences > Edit.
   - In the Agile Java Client, click Settings > Current User > Preferences.
2 Select the desired date format in the Preferred Date Format field.
3 Select a GMT time zone in the Time Zone field.
4 Click Save.

Supported Date Formats

The Import wizard supports all combinations of date and time formats available in the java.text.DateFormat class as well as additional formats. DateFormat provides many date and time formatting styles based on locale. The following table shows date formats available for the U.S. locale, evaluated in order:

Table 2-3: Date formats for the U.S. locale

<table>
<thead>
<tr>
<th>Date Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMM-dd-yyyy HH:mm:ss</td>
<td>Jul-10-2001 14:08:35</td>
</tr>
<tr>
<td>MMM-dd-yyyy HH:mm</td>
<td>Jul-10-2001 14:08</td>
</tr>
<tr>
<td>MMM-dd-yyyy hh:mm:ss a</td>
<td>Jul-10-2001 02:08:35 PM</td>
</tr>
</tbody>
</table>
Each date format is specified using a time pattern string where

- \( y \) = year
- \( M \) = month in year
- \( d \) = day in month
- \( H \) = hour in military time (24-hour clock)
- \( h \) = hour in AM/PM (1–12)
- \( m \) = minute in hour
- \( s \) = second in minute
- \( E \) = day in week
- \( a \) = AM/PM marker
- \( z \) = time zone
- \('\)' = escape for text
- \('\,'\) = single quote

The count of each letter such as “M” in the time pattern determines the format. For example, three “M” characters indicate that the month is represented as text instead of a number; less than three “M” characters means that the month is represented by a number.

For more information about Java date formats and time pattern syntax, see Sun’s documentation for the SimpleDateFormat and DateFormat classes:

http://www.javasoft.com/j2se/1.3/docs/api/index.html
Specifying Time Zones

Date values can specify a GMT time zone. If a date value omits the time zone, the user’s time zone preference is used. Time zones must be entered in the following format:

\[
\text{GMT Sign } hh:mm
\]

where:

\[
\begin{align*}
\text{GMT} &= \text{Greenwich Mean Time} \\
\text{Sign} &= + \text{ or } - \\
\text{h} &= \text{hour in AM/PM (1–12)} \\
\text{m} &= \text{minute in hour}
\end{align*}
\]

For example, “GMT-05:00” and “GMT+02:00” are valid time zones.

**Note**  Do not use three-character codes (such as PST or PDT) to specify time zones. Three-character time zone codes are unreliable because some are used for multiple time zones. Consequently, the Agile PLM server might resolve a three-character time zone code to an incorrect time zone.

aXML and PDX Package Date Formats

For aXML and PDX packages, the Import wizard supports a relaxed version of the ISO String date format: `yyyy/MM/ddTHH:mm:ssZ`. The T and Z characters are optional.

Importing Currency Values

Price Line and Supplier objects allow you to import values to currency fields. Currency values can be imported if they are entered as a three-letter ISO 4217 currency code or the full currency name. For example, “USD” and “U.S. Dollar” are both valid currency values that can be imported. “U.S. Dollar (USD)” cannot be imported.

Agile supports many different currencies. The list of available currencies is determined when the Agile PLM system is installed. For more information about ISO 4217 currency codes, see the following Web site:


The following table lists Agile currency codes:

<table>
<thead>
<tr>
<th>Currency Display Name</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andorran Peseta (ADP)</td>
<td>ADP</td>
</tr>
<tr>
<td>UAE Dirham (AED)</td>
<td>AED</td>
</tr>
<tr>
<td>Afghan i (AFA)</td>
<td>AFA</td>
</tr>
<tr>
<td>Lek  (ALL)</td>
<td>ALL</td>
</tr>
<tr>
<td>Armenian Dram</td>
<td>AMD</td>
</tr>
<tr>
<td>Netherlands Antillean Guilder (ANG)</td>
<td>ANG</td>
</tr>
<tr>
<td>New Kwanza (AON)</td>
<td>AON</td>
</tr>
<tr>
<td>Kwanza Reajustado (AOR)</td>
<td>AOR</td>
</tr>
<tr>
<td>Argentine Peso (ARP)</td>
<td>ARP</td>
</tr>
<tr>
<td>Shilling (ATS)</td>
<td>ATS</td>
</tr>
<tr>
<td>Australian Dollar (AUD)</td>
<td>AUD</td>
</tr>
<tr>
<td>Florin (AWF)</td>
<td>AWF</td>
</tr>
<tr>
<td>Aruban Guilder (AWG)</td>
<td>AWG</td>
</tr>
<tr>
<td>Azerbaijan Manat (AZM)</td>
<td>AZM</td>
</tr>
<tr>
<td>Convertible Mark (BAK)</td>
<td>BAK</td>
</tr>
<tr>
<td>Barbados Dollar (BBD)</td>
<td>BBD</td>
</tr>
<tr>
<td>Taka (BDT)</td>
<td>BDT</td>
</tr>
<tr>
<td>Belgian Franc (BEF)</td>
<td>BEF</td>
</tr>
<tr>
<td>Lev (BGL)</td>
<td>BGL</td>
</tr>
<tr>
<td>Bahraini Dinar (BHD)</td>
<td>BHD</td>
</tr>
<tr>
<td>Burundi Franc (BIF)</td>
<td>BIF</td>
</tr>
<tr>
<td>Bermudian Dollar (BMD)</td>
<td>BMD</td>
</tr>
<tr>
<td>Brunei Dollar (BND)</td>
<td>BND</td>
</tr>
<tr>
<td>Boliviano (BOB)</td>
<td>BOB</td>
</tr>
<tr>
<td>Brazilian Real (BRL)</td>
<td>BRL</td>
</tr>
<tr>
<td>Bahamian Dollar (BSD)</td>
<td>BSD</td>
</tr>
<tr>
<td>Rupee (BTR)</td>
<td>BTR</td>
</tr>
<tr>
<td>Pula (BWP)</td>
<td>BWP</td>
</tr>
<tr>
<td>Belarussian Ruble (BYR)</td>
<td>BYR</td>
</tr>
<tr>
<td>Belize Dollar (BZD)</td>
<td>BZD</td>
</tr>
<tr>
<td>Canadian Dollar (CAD)</td>
<td>CAD</td>
</tr>
<tr>
<td>Congolese Franc (CDF)</td>
<td>CDF</td>
</tr>
<tr>
<td>Swiss Franc (CHF)</td>
<td>CHF</td>
</tr>
<tr>
<td>Chilean Peso (CLP)</td>
<td>CLP</td>
</tr>
<tr>
<td>Yuan Renminbi (CNY)</td>
<td>CNY</td>
</tr>
</tbody>
</table>
### Table 2-4: Currency codes (continued)

<table>
<thead>
<tr>
<th>Currency Display Name</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colombian Peso (COP)</td>
<td>COP</td>
</tr>
<tr>
<td>Costa Rican Colon (CRC)</td>
<td>CRC</td>
</tr>
<tr>
<td>Cuban Peso (CUP)</td>
<td>CUP</td>
</tr>
<tr>
<td>Cape Verde Escudo (CVE)</td>
<td>CVE</td>
</tr>
<tr>
<td>Cyprus Pound (CYP)</td>
<td>CYP</td>
</tr>
<tr>
<td>Czech Koruna (CZK)</td>
<td>CZK</td>
</tr>
<tr>
<td>Deutsche Mark (DEM)</td>
<td>DEM</td>
</tr>
<tr>
<td>Djibouti Franc (DJF)</td>
<td>DJF</td>
</tr>
<tr>
<td>Danish Krone (DKK)</td>
<td>DKK</td>
</tr>
<tr>
<td>Dominican Peso (DOP)</td>
<td>DOP</td>
</tr>
<tr>
<td>Algerian Dinar (DZD)</td>
<td>DZD</td>
</tr>
<tr>
<td>Sucre (ECS)</td>
<td>ECS</td>
</tr>
<tr>
<td>Kroon (EEK)</td>
<td>EER</td>
</tr>
<tr>
<td>Egyptian Pound (EGP)</td>
<td>EGP</td>
</tr>
<tr>
<td>Nakfa (ERN)</td>
<td>ERN</td>
</tr>
<tr>
<td>Spanish Peseta (ESP)</td>
<td>ESP</td>
</tr>
<tr>
<td>Ethiopian Birr (ETB)</td>
<td>ETB</td>
</tr>
<tr>
<td>Euro (EUR)</td>
<td>EUR</td>
</tr>
<tr>
<td>Markka (FIM)</td>
<td>FIM</td>
</tr>
<tr>
<td>Fiji Dollar (FJD)</td>
<td>FJD</td>
</tr>
<tr>
<td>Falkland Islands Pound (FKP)</td>
<td>FKP</td>
</tr>
<tr>
<td>French Franc (FRF)</td>
<td>FRF</td>
</tr>
<tr>
<td>Pound Sterling (GBP)</td>
<td>GBP</td>
</tr>
<tr>
<td>Lari (GEL)</td>
<td>GEL</td>
</tr>
<tr>
<td>Cedi (GHC)</td>
<td>GHC</td>
</tr>
<tr>
<td>Gibraltar Pound (GIP)</td>
<td>GIP</td>
</tr>
<tr>
<td>Dalasi (GMD)</td>
<td>GMD</td>
</tr>
<tr>
<td>Guinea Franc (GNF)</td>
<td>GNF</td>
</tr>
<tr>
<td>Drachma (GRD)</td>
<td>GRD</td>
</tr>
<tr>
<td>Quetzal (GTQ)</td>
<td>GTQ</td>
</tr>
<tr>
<td>Guyana Dollar (GYD)</td>
<td>GYD</td>
</tr>
<tr>
<td>Hong Kong Dollar (HKD)</td>
<td>HKD</td>
</tr>
<tr>
<td>Lempira (HNL)</td>
<td>HNL</td>
</tr>
<tr>
<td>Kuna (HRK)</td>
<td>HRK</td>
</tr>
<tr>
<td>Gourde (GTG)</td>
<td>HTG</td>
</tr>
<tr>
<td>Forint (HUF)</td>
<td>HUF</td>
</tr>
<tr>
<td>Rupiah ( IDR)</td>
<td>IDR</td>
</tr>
<tr>
<td>Irish Pound (IEP)</td>
<td>IEP</td>
</tr>
<tr>
<td>Shekel ( ILS)</td>
<td>ILS</td>
</tr>
<tr>
<td>Indian Rupee (INR)</td>
<td>INR</td>
</tr>
<tr>
<td>Iraqi Dinar (IQD)</td>
<td>IQD</td>
</tr>
<tr>
<td>Iranian Rial (IRR)</td>
<td>IRR</td>
</tr>
<tr>
<td>Icelandic Krona (ISK)</td>
<td>ISK</td>
</tr>
<tr>
<td>Lira (ITL)</td>
<td>ITL</td>
</tr>
<tr>
<td>Jamaican Dollar (JMD)</td>
<td>JMD</td>
</tr>
<tr>
<td>Jordanian Dinar (JOD)</td>
<td>JOD</td>
</tr>
<tr>
<td>Japanese Yen (JPY)</td>
<td>JPY</td>
</tr>
<tr>
<td>Kenyan Shilling (KES)</td>
<td>KES</td>
</tr>
<tr>
<td>Som (KGS)</td>
<td>KGS</td>
</tr>
<tr>
<td>Riel (KHR)</td>
<td>KHR</td>
</tr>
<tr>
<td>Comoro Franc (KMF)</td>
<td>KMF</td>
</tr>
<tr>
<td>North Korean Won (KPW)</td>
<td>KPW</td>
</tr>
<tr>
<td>Korean Won (KRW)</td>
<td>KRW</td>
</tr>
<tr>
<td>Kuwaiti Dinar (KWD)</td>
<td>KWD</td>
</tr>
<tr>
<td>Cayman Islands Dollar (KYD)</td>
<td>KYD</td>
</tr>
<tr>
<td>Tenge (KZT)</td>
<td>KZT</td>
</tr>
<tr>
<td>Kip (LAK)</td>
<td>LAK</td>
</tr>
<tr>
<td>Lebanese Pound (LBP)</td>
<td>LBP</td>
</tr>
<tr>
<td>Sri Lanka Rupee (LKR)</td>
<td>LKR</td>
</tr>
<tr>
<td>Liberian Dollar (LID)</td>
<td>LID</td>
</tr>
<tr>
<td>Loti (LSL)</td>
<td>LSL</td>
</tr>
<tr>
<td>Lithuanian Litas (LTL)</td>
<td>LTL</td>
</tr>
<tr>
<td>Luxembourg Franc (LUF)</td>
<td>LUF</td>
</tr>
<tr>
<td>Latvian Lats (LVL)</td>
<td>LVL</td>
</tr>
<tr>
<td>Libyan Dinar (LYD)</td>
<td>LYD</td>
</tr>
<tr>
<td>Moroccan Dirham (MAD)</td>
<td>MAD</td>
</tr>
<tr>
<td>Moldovan Leu (MDL)</td>
<td>MDL</td>
</tr>
<tr>
<td>Malagasy Franc (MGA)</td>
<td>MGA</td>
</tr>
<tr>
<td>Denar (MKD)</td>
<td>MKD</td>
</tr>
<tr>
<td>Kyat (MMK)</td>
<td>MMK</td>
</tr>
<tr>
<td>Tugrik (MNT)</td>
<td>MNT</td>
</tr>
<tr>
<td>Pataka (MOP)</td>
<td>MOP</td>
</tr>
<tr>
<td>Ouuguia (MRO)</td>
<td>MRO</td>
</tr>
<tr>
<td>Maltese Lira (MTL)</td>
<td>MTL</td>
</tr>
<tr>
<td>Mauritius Rupee (MUR)</td>
<td>MUR</td>
</tr>
<tr>
<td>Rupiyaa (MVR)</td>
<td>MVR</td>
</tr>
<tr>
<td>Kwacha (MWK)</td>
<td>MWK</td>
</tr>
<tr>
<td>Mexican Nuevo Peso (MXN)</td>
<td>MXP</td>
</tr>
<tr>
<td>Malaysian Ringgit (MYR)</td>
<td>MYR</td>
</tr>
<tr>
<td>Metical (MZN)</td>
<td>MZN</td>
</tr>
<tr>
<td>Namibia Dollar (NAD)</td>
<td>NAD</td>
</tr>
<tr>
<td>Naira (NGN)</td>
<td>NGN</td>
</tr>
<tr>
<td>Cordoba Ora (NIO)</td>
<td>NIO</td>
</tr>
<tr>
<td>Netherlands Guilder (NLG)</td>
<td>NLG</td>
</tr>
<tr>
<td>Norwegian Krone (NOK)</td>
<td>NOK</td>
</tr>
<tr>
<td>Nepalese Rupee (NPR)</td>
<td>NPR</td>
</tr>
<tr>
<td>New Zealand Dollar (NZD)</td>
<td>NZD</td>
</tr>
<tr>
<td>Omani Rial (OMR)</td>
<td>OMR</td>
</tr>
<tr>
<td>Balboa (PAB)</td>
<td>PAB</td>
</tr>
<tr>
<td>Nuevo Sol (PEN)</td>
<td>PEN</td>
</tr>
<tr>
<td>Kina (PGK)</td>
<td>PGK</td>
</tr>
<tr>
<td>Philippine Peso (PHP)</td>
<td>PHP</td>
</tr>
<tr>
<td>Pakistan Rupee (PKR)</td>
<td>PKR</td>
</tr>
<tr>
<td>Zloty (PLZ)</td>
<td>PLZ</td>
</tr>
<tr>
<td>Portuguese Escudo (PTE)</td>
<td>PTE</td>
</tr>
<tr>
<td>Guarani (PYG)</td>
<td>PYG</td>
</tr>
<tr>
<td>Qatari Riyal (QAR)</td>
<td>QAR</td>
</tr>
<tr>
<td>Leu (ROL)</td>
<td>ROL</td>
</tr>
<tr>
<td>Russian Ruble (RUB)</td>
<td>RUB</td>
</tr>
<tr>
<td>Rwanda Franc (RWF)</td>
<td>RWF</td>
</tr>
<tr>
<td>Saudi Riyal (SAR)</td>
<td>SAR</td>
</tr>
<tr>
<td>Solomon Islands Dollar (SBD)</td>
<td>SBD</td>
</tr>
<tr>
<td>Seychelles Rupee (SCR)</td>
<td>SCR</td>
</tr>
<tr>
<td>Sudanese Dinar (SDD)</td>
<td>SDD</td>
</tr>
</tbody>
</table>
Chapter 2
Preparing and Selecting Source Data

Table 2-4: Currency codes (continued)

<table>
<thead>
<tr>
<th>Currency Display Name</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swedish Krona (SEK)</td>
<td>SEK</td>
</tr>
<tr>
<td>Singapore Dollar (SGD)</td>
<td>SGD</td>
</tr>
<tr>
<td>St. Helena Pound (SHP)</td>
<td>SHP</td>
</tr>
<tr>
<td>Tolar (SIT)</td>
<td>SIT</td>
</tr>
<tr>
<td>Slovak Koruna (SKK)</td>
<td>SKK</td>
</tr>
<tr>
<td>Leone (SLL)</td>
<td>SLL</td>
</tr>
<tr>
<td>Somaliland Shilling (SOS)</td>
<td>SOS</td>
</tr>
<tr>
<td>Surinam Guilder (SRG)</td>
<td>SRG</td>
</tr>
<tr>
<td>Dobra (STD)</td>
<td>STD</td>
</tr>
<tr>
<td>El Salvador Colón (SVC)</td>
<td>SVC</td>
</tr>
<tr>
<td>Syrian Pound (SYP)</td>
<td>SYP</td>
</tr>
<tr>
<td>Lilangeni (SZL)</td>
<td>SZL</td>
</tr>
<tr>
<td>Bahá'í (THB)</td>
<td>THB</td>
</tr>
<tr>
<td>Tajik Ruble (TJR)</td>
<td>TJR</td>
</tr>
<tr>
<td>Manat (TMM)</td>
<td>TMM</td>
</tr>
<tr>
<td>Tunisian Dinar (TND)</td>
<td>TND</td>
</tr>
<tr>
<td>Pa‘anga (TOP)</td>
<td>TOP</td>
</tr>
<tr>
<td>Turkish Lira (TRL)</td>
<td>TRL</td>
</tr>
<tr>
<td>Trinidad and Tobago Dollar (TTD)</td>
<td>TTD</td>
</tr>
<tr>
<td>New Taiwan Dollar (TWD)</td>
<td>TWD</td>
</tr>
<tr>
<td>Tanzanian Shilling (TZS)</td>
<td>TZS</td>
</tr>
<tr>
<td>Uganda Shilling (UGX)</td>
<td>UGX</td>
</tr>
<tr>
<td>U.S. Dollar (USD)</td>
<td>USD</td>
</tr>
<tr>
<td>Peso Uruguayo (UYU)</td>
<td>UYU</td>
</tr>
<tr>
<td>Uzbekistan Som (UZS)</td>
<td>UZS</td>
</tr>
<tr>
<td>Bolívar (VEB)</td>
<td>VEB</td>
</tr>
<tr>
<td>Dong (VND)</td>
<td>VND</td>
</tr>
<tr>
<td>Vatu (VUV)</td>
<td>VUV</td>
</tr>
<tr>
<td>Tala (WST)</td>
<td>WST</td>
</tr>
<tr>
<td>CFA Franc BEAC (XAF)</td>
<td>XAF</td>
</tr>
<tr>
<td>East Caribbean Dollar (XCD)</td>
<td>XCD</td>
</tr>
<tr>
<td>CFP Franc (XPF)</td>
<td>XPF</td>
</tr>
<tr>
<td>Yemeni Rial (YER)</td>
<td>YER</td>
</tr>
<tr>
<td>New Dinar (YUN)</td>
<td>YUN</td>
</tr>
<tr>
<td>Rand (ZAR)</td>
<td>ZAR</td>
</tr>
<tr>
<td>Kwacha (ZMK)</td>
<td>ZMK</td>
</tr>
<tr>
<td>Zimbabwe Dollar (ZWD)</td>
<td>ZWD</td>
</tr>
</tbody>
</table>

Importing Money Values

The money datatype is a compound datatype that includes a numeric value and a currency code, such as “USD” for U.S. Dollars. When you import values for money fields, only numeric values are imported. The Import wizard assigns the user’s preferred currency to all imported money values.

If the source file is a delimited text file or an Excel file, money values should not include a currency code; the Import wizard will reject non-numeric money values. If the source file is an aXML file or a PDX package, the Import wizard ignores currency codes included with money values and substitutes the user’s preferred currency instead.

To change your preferred currency:

- In the Agile Web Client, click Settings > User Profile > Preferences > Edit.
- In the Agile Java Client, click Settings > Current User > Preferences.
Importing Mass Values

Several Product Governance & Compliance objects, including items, have Mass fields. Mass fields have both a numeric value and a unit of measure, for example, grams, kilograms, ounces, or pounds. The Import wizard allows you to import both the numeric portion of a Mass value and the unit portion. When you import Mass values, make sure you map both the Mass and Mass-measure fields.

Note The default standard unit for Mass fields is Gram, although your Agile PLM administrator can choose a different standard unit.

Importing Geographical Locations

Customer, Supplier, and Manufacturer objects all have country and region fields. You must specify valid country and region names in your source data. Otherwise, the values won’t be imported.

To see valid country names and region names in the Agile Java Client:

1. Click the Admin tab.
2. Choose Data & Workflow Settings > Product Cost Management > Ship-To Location.
3. Click the New button.
4. Click the Continent list, and select a continent.
5. Click the Country list, and select a country.
6. Click the Province/Region/State list, and select a region.

Importing Values to Dynamic Lists

The Import wizard supports importing values to list fields that use dynamic lists. Dynamic lists contain a selection of values that are updated at run time based on data that has been added to the system. The Items, Changes, Users, and Suppliers lists are examples of dynamic lists. Because dynamic lists can contain thousands of value objects, you can’t enumerate values for them.

The Import wizard can’t validate whether a dynamic list requires upper-case or lower-case values before sending the data to the server. Consequently, any list values that are the wrong case are rejected.

Note Prior to Agile 9.0 SP3, the Suppliers list was a static, enumerable list. Now it’s a dynamic list. Although Web Client displays the Supplier field in the form supplierName - supplierNumber, you can import data to that field using either the supplier number or the composite form, supplierName - supplierNumber.

Importing Cascading Lists

An Agile PLM list field can be configured to be a cascading list. A cascading list presents its values in multiple hierarchical levels, letting you drill down to a specific value in the hierarchy.

To import values into a cascading list field, make sure you use the correct delimiter character to separate each level. The Cascade Delimiter Character preference specifies the character used to delimit cascading list values. For information about setting the Cascade Delimiter Character preference, see “Setting Parsing and Validation Options” on page 8-1. The default setting for the Cascade Delimiter Character preference is vertical bar (|).

The following example shows source data that includes cascading list values for a Page Two field called Regional Contact, which has three levels.

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Regional Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>P10011</td>
<td>Central</td>
</tr>
<tr>
<td>P10012</td>
<td>Western</td>
</tr>
<tr>
<td>P10013</td>
<td>Southern</td>
</tr>
<tr>
<td>P10014</td>
<td>Northern</td>
</tr>
</tbody>
</table>
Using BOM Reference Designators

Reference designators are commonly used in the electronics industry as a labeling system to refer to components. If your company uses reference designators, you can use the BOM > Ref Des field to assign and edit reference designators.

You can specify reference designators in several ways:

- Delimited using comma (,), semicolon (;), or vertical bar (|). By default, the Import wizard uses a comma for the reference designator delimiter. To change the delimiter, see “Setting Business Rule Options” on page 8-2.
- Individually (R1, R2, R3) or compressed, using the specified range character (R1–3 or R1–R3). By default, the Import wizard uses a hyphen for the reference designator range character. To change the range character, see “Setting Business Rule Options” on page 8-2.
- Uppercase, lowercase, or mixed case (they will be converted to whatever format is specified by the Agile PLM administrator).
- Using continuation rows if there are too many reference designators to fit in one cell. All other cells must be left empty in these rows.

If you have few reference designators, you can enter them one by one (for example, R1, R2, R3).

To add groups of reference designators that begin with different letters, separate each group with a parse character, usually a comma. For example, to enter the 10 designators A1, A2, A3, B4, B5, B6, B7, C8, C9 and C10 you would type:

A1-3, B4-7, C8-10

Depending on how your Agile database has been configured, the Agile Web Client may automatically contract ranges of reference designators. If you enter 1,2,3,4,5, when you press Tab, the Ref Des field shows 1-5.

If your Agile database has been configured to expand reference designators, then reference designators connected by hyphens (or another specified range character) are expanded when they are imported into the Agile database. For example, R1–5 becomes R1, R2, R3, R4, R5.

Reference designators that end in a letter (for example, R1a, R2a, R3a) must be entered individually. For more information about how Agile Import handles reference designator ranges, see “Reference Designator Ranges” on page 2-9.

Reference Designator Ranges

The following rules determine how ranges of reference designators are treated by the Import wizard. If a reference designator does not qualify for expansion, the Import wizard treats the range as one reference designator.

- The two reference designators in a range statement must end in a numeric character to qualify for expansion. If the last value in a reference designator string is a text character, it does not qualify for expansion.

Examples:
A202-A210 qualifies for expansion.
A202-A210a does not qualify for expansion.
A202a-A210a does not qualify for expansion.

- If two reference designators in a range statement have prefixes, they must have the same prefix to qualify for expansion. Prefixes must be in <CHAR> format.
Examples:
RB202-RB210 qualifies for expansion.
RB202-RC210 does not qualify for expansion.

- If only the first reference designator in a range statement has a prefix, then the range qualifies for expansion.
  Example:
  RB202-210 qualifies for expansion.
- If neither reference designator in a range statement has a prefix, then the range qualifies for expansion.
  Example:
  202-210 qualifies for expansion.

Using Leading Zeros in Reference Designator Ranges

If your Agile database has been configured to remove leading zeros in the numeric portion of reference designators, you should avoid using leading zeros in reference designator ranges in your import file. For example, the Import wizard may parse R0203-R0225 as R203-R225, removing the leading zeros.

In the Agile Java Client, you can click the Admin tab and choose Server Settings > Preferences > Reference Designators Allow Range Expand Collapse to see whether reference designators can be expanded and collapsed on your Agile PLM system. If this preference is set to No, all reference designator range behavior is turned off. This prevents leading zeros from being removed from reference designators, but it also causes each reference designator range, such as R0203-R0225, to be treated as one reference designator. In this case, to enter reference designators with leading zeros, you must enter them individually and not as ranges.

Note: For information about how to change the Reference Designators Allow Range Expand Collapse preference setting in the Agile Java Client, contact Agile Technical Support.

Importing Reference Designators from aXML and PDX Packages

To ensure that reference designator fields in aXML and PDX packages are parsed correctly when they are imported, follow these guidelines:

- Use a comma to separate multiple reference designators (R1,R2,R3).
- Use a hyphen to indicate a range of reference designators (R1–R3).

Guidelines for Excel Files and Delimited Text Files

After the Import wizard parses an Excel file, the data that it sends to the server is no different from data that originated from a delimited text file. Therefore, the structural guidelines that you must follow to successfully import data to the Agile PLM system are the same for both Excel files and delimited text files.

Make sure Excel files and delimited text files conform to the following structural guidelines before importing them:

- Although an Excel workbook can contain multiple sheets, you can import data from only one sheet at a time. Therefore, set up Excel sheets appropriately.
- Numeric values in Excel files are converted to either integers or decimals before being imported. If you want an integer to be treated as a decimal, enter the value as text by preceding it with a single quotation mark. For example, to import the number 1.0 instead of 1, type ‘1.0 in the Excel cell.
Formulas in Excel files must calculate to a numeric value. Otherwise, the Import wizard imports the formula string. If your Excel file has formulas that calculate to nonnumeric values, you can save the file to a .CSV file to ensure that the formula values will be imported correctly.

Column headers cannot be blank. For example, in a comma-separated file the following header row would be invalid due to the blank header between Number and Description:

```
Number,,Description,Product Lines,Category
```

The first row of import data, which is not necessarily the first row in an Excel file, must be the “header” row, which contains field names. When you select the source file, you can click **Configure** to set the location of the header row.

Field names in the header row must be unique. Duplicate field names are not allowed.

Fields in the header row must not contain carriage returns or linefeed characters. If they do, the Import wizard will not parse the file correctly. For more information, see “Removing Carriage Returns and Linefeed Characters” on page 12.

The header row cannot end with a delimiter character, such as a comma.

Rows that follow the header row must contain data. There should not be empty rows between rows of data.

Any rows of data that you do not want imported into the Agile database must be removed.

All fields that are required for the particular object type you are importing should contain data.

Fields must use the same delimiter character. For example, for a comma-separated values file, each field should be separated by a comma.

Your import data must conform to the maximum lengths specified for each Agile field by the Agile PLM administrator. Otherwise, the Import wizard’s **Length Validation** preference will either reject or truncate the value.

An entry for a MultiList field (for example, the Product Line(s) field on the Title Block tab) must delimit separate list values. The default MultiList delimiter is a comma; you can also choose to use a vertical bar (|) or semicolon (;). For more information, see “Setting Parsing and Validation Options” on page 8-1.

Here’s an example of a comma-delimited list of values for a MultiList field:

```
Scorpio,Taurus,Capricorn
```

Money fields must contain numeric values. They should not include currency codes. The user’s default currency is assigned to all imported money values.

For BOMs, parent item rows must be grouped contiguously. That is, all BOM components for a parent item should appear in one group of rows.

For BOMs, the maximum length of individual reference designators is 19 characters.

For BOMs, reference designators can continue on subsequent rows. On each reference designator continuation row, the only field with data should be the reference designator field. Other fields should be blank.

For BOMs, the value in the Quantity field should equal the number of reference designators. Otherwise, the Import wizard may display a warning message when you import the data.

For delimited text files, enclose text values within text qualifier characters (for example, quotation marks). Qualifying a text field allows the field’s delimiting character, such as a comma, to be used within the field’s text. In the following example, 21" Monitor, Tilt Pedestal is the item’s description, which has both a comma (the field delimiter) and a quotation mark within the text:

```
Number,Description,Rev,BOM Component Number,QPA
170-50,"21\" Monitor, Tilt Pedestal",A,172-92,1
```
Removing Carriage Returns and Linefeed Characters

To avoid file parsing errors when importing Excel files or delimited text files, make sure the header fields do not contain carriage returns or linefeed characters. Such characters may be hard to spot in a delimited text file, but you can easily find them and remove them in Excel.

To find and remove carriage returns or linefeed characters from header fields in Excel:

1. Click the Select All button, the gray rectangle in the upper left corner of the worksheet where the row and column headings meet.
2. Choose Format > Row > AutoFit.

Any header fields that have carriage returns or linefeed characters will have more than one line of text. In the following figure, fields A1 and C1 both have carriage returns.

Figure 2-1: Header row with carriage returns in A1 and C1

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item Number</td>
<td>Revision</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>P01</td>
<td>P010</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>P012</td>
<td>P012</td>
</tr>
<tr>
<td>5</td>
<td>P002</td>
<td>P013</td>
</tr>
<tr>
<td>6</td>
<td>P001</td>
<td>P014</td>
</tr>
<tr>
<td>7</td>
<td>P001</td>
<td>P015</td>
</tr>
</tbody>
</table>

3. Delete any extra carriage returns or linefeed characters in the header.
4. Save the file.

Sorting BOM Components

Before importing a BOM from an Excel file or a delimited text file, make sure all BOM components for a parent item are grouped together in contiguous rows. If BOM components for a parent item are listed on noncontiguous rows, the Import wizard imports only the last group of BOM components for that parent item.

For example, the following BOM data is incorrect because the rows 4 and 5 are out of order.

Figure 2-1: BOM data with noncontiguous parent items

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Item Number</td>
<td>BOM Item Number</td>
<td>Part Description</td>
</tr>
<tr>
<td>2</td>
<td>P01</td>
<td>P010</td>
</tr>
<tr>
<td>3</td>
<td>P002</td>
<td>P012</td>
</tr>
<tr>
<td>4</td>
<td>P002</td>
<td>P013</td>
</tr>
<tr>
<td>6</td>
<td>P001</td>
<td>P014</td>
</tr>
<tr>
<td>7</td>
<td>P001</td>
<td>P015</td>
</tr>
</tbody>
</table>

Here is the BOM data after it has been correctly sorted. BOM components for P001 are now grouped together.

Figure 2-2: BOM data with contiguous parent items

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Item Number</td>
<td>BOM Item Number</td>
<td>Part Description</td>
</tr>
<tr>
<td>2</td>
<td>P01</td>
<td>P010</td>
</tr>
<tr>
<td>3</td>
<td>P01</td>
<td>P011</td>
</tr>
<tr>
<td>4</td>
<td>P01</td>
<td>P014</td>
</tr>
<tr>
<td>5</td>
<td>P01</td>
<td>P015</td>
</tr>
<tr>
<td>6</td>
<td>P002</td>
<td>P012</td>
</tr>
<tr>
<td>7</td>
<td>P002</td>
<td>P012</td>
</tr>
</tbody>
</table>

To sort the BOM, open the source file in Microsoft Excel and sort the rows in ascending order by the Parent Item Number column.

Note BOMs in aXML and PDX packages are automatically sorted appropriately.

An XML file declares its encoding within the file. Therefore, you don’t need to specify file encoding when you import data from aXML or PDX packages.
Importing Data from Microsoft Excel Files

Microsoft Excel is a popular spreadsheet program, which lets you format data in a matrix of rows and columns. The Import wizard supports Microsoft Excel 2000 and 2002 versions.

Excel workbook files, which have an XLS filename extension, can have multiple sheets per file. Make sure you specify the sheet to import and the location of the header row on that sheet.

Figure 2-3 shows an example of an importable Microsoft Excel file.

Figure 2-3: An importable Excel file

To import data from an Excel file:

1. Choose Tools > Import.
2. Specify the import source. Select File. Type the filename, or click Browse to select it.
   - Note: The file must be a valid Excel 2000/2002 file.
3. Click Excel Workbook.
4. If necessary, click Configure to specify the file configuration. You can specify the template type, worksheet, and the location of the header row. When you are finished, click OK.
5. Click Next to proceed to the next wizard step.
6. Select the type of object to import, then click Next.
7. Select or create a transformation definition file (optional). Click Next.
   - Note: A change order is required when you use Redlining mode to import. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.
8. Select or create a transformation definition file (optional). Click Next.
9. Review your import settings, then click Import to begin importing.

Editing Delimited Text Files in Excel

If you open a delimited text file in Excel, all cells use the General number format by default. This causes large numbers, such as item numbers and manufacturer part numbers, to be converted into scientific notation (for example, 8.1E+22). You can fix that problem by formatting the cells to use Text format.

To format numbers as text in Excel:

1. Select the cells you want to format.
3. Click the Number tab.
4. In the Category list, select Text, and then click OK.
5. If there are any cells that still display in scientific notation, click each cell, press F2, and then press Enter to reenter the number as text.
After you format cells to use Text format, save the file as an Excel (XLS) file to preserve the formatting. If you save the file as a CSV file, the next time you open it in Excel the sheet will again use the General number format.

**Importing a Delimited Text File into Excel**

If a delimited text file has many item numbers or manufacturer part numbers that need to be reformatted as text, it may be more practical to import the file into a new Excel workbook. Excel’s Text Import Wizard allows you to format the columns appropriately.

To import a delimited text file into an Excel workbook:

1. Open a new workbook.
2. Choose **Data > Get External File > Import Text File**.
3. Select the file and choose **Import**. The Text Import Wizard appears.
4. Select Delimited. Click **Next**.
5. In the **Delimiters** box, make sure only Comma is checked. Click **Next**.
6. In the **Data Preview** box, select columns to change the data format. For example, select the Item Number or Manufacturer Part Number column, and click Text in the **Column Data Format** box.
7. Click **Finish**.
8. Select Existing Worksheet, and click **OK**.

**How the Import Wizard Parses Excel Data**

When you select an Excel file to import, the Import wizard parses the data into a delimited text format before importing it. That is why many of the guidelines for importing delimited text files also apply to Excel files. The parser handles the following types of Excel values specially:

- **Number format** — Numeric values in Excel files are converted to either integers or decimals before they are imported.
- **Date format** — The parser supports native Excel date formats as well as any custom date formats that contain all three of the following identifiers: **d m yy**. For example, **yyy/mm/dd** and **dd–MM–YYY hh:mm** are supported date formats, but **mm/yy** is not.
- **Currency format** — The parser treats any cells containing currency values as numbers. Therefore, a cell with the value $9.99 is treated as 9.99.

**Specifying the Excel File Configuration**

When you select an Excel file to import, you can specify how the file is configured. This allows the Import wizard to identify the template you’re using, the worksheet to import, and the header row where data starts.

To specify the configuration of an Excel file:

1. On the first step of the Import wizard, select **File**.
2. Type the path of the file, or click **Browse** to select it.
3. Select **Excel Workbook**.
4. Click **Configure**. The Excel Workbook Configuration window appears.
5. Specify the template type (BOM Only Level Template, BOM & AML Level Template, Parent-Child Template, or Standard).
6. Specify the sheet to import. The default is the first worksheet in the Workbook.
7. Type the location of the header row. The default is 1.
8 Click OK.

Note The Import wizard maintains Excel file settings for the current import session only.

Importing Data from Delimited Text Files

Delimited text files are flat text files where each field of data is delimited by a special character, such as a comma or a tab. You can create delimited text files in a text editor. You can also export delimited text files using many applications, including Microsoft Excel and other spreadsheet programs.

Caution! A delimited text file must have a CSV or TXT filename extension. Otherwise, the file is invalid and cannot be imported.

Generally, text files allow you to import only one type of Agile object at a time. However, when you import BOMs, AMLs, or price lines from a text file, you can also import the parent items or prices at the same time.

Text files should have a header row. If you are importing a text file, make sure you specify the location of the header row.

To import data from a text file:

1 Choose Tools > Import.

2 Specify the import source. Select File. Type the filename, or click Browse to select it.

Note The filename must have one of the following extensions: csv or txt.

3 Click Delimited Text File.

4 If necessary, click Configure to specify the delimited text file configuration. You can specify the location of the header row, the type of file encoding, and characters used for field delimiters and text qualifiers. When you are finished, click OK.

5 Click Next to proceed to the next wizard step.

6 Select the type of object to import, then click Next.

7 Select a change order and a mapping file. Click Next.

Note A change order is required when you use Redlining mode to import. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.

8 Select or create a transformation definition file (optional). Click Next.

9 Review your import settings, then click Import to begin importing.

About Delimited Text Files Saved by the Agile Export Wizard

Agile's Import wizard doesn't support delimited text files saved by the Agile Export wizard, mainly because the Export wizard adds a header section to the file and includes multiple tables in a flat format. You can reformat the data to import it successfully.

Specifying the Delimited Text File Configuration

When you select a delimited text file, you can specify how the file is configured. This allows the Import wizard to identify the template you’re using, the header row, field delimiter, and text qualifier used in the file.

To specify the configuration of a text file:

1 On the first step of the Import wizard, select File.

2 Type the path of the file, or click Browse to select it.

3 Select Delimited Text File.
Click Configure. The Delimited Text File Configuration window appears.

Specify the template type (BOM Only Level Template, BOM & AML Level Template, Parent-Child Template, or Standard).

Select the field delimiter. The default is Comma (,).

Select the text qualifier. The default is Double quotation mark (").

Type the location of the header row. The default is 1.

Select the file encoding type. The default is based on your locale. For the U.S. (English) locale, the default is ISO-8859-1, which includes all US and Western European characters. For Japan and China, the default encoding is Big5 and SJIS, respectively.

Click OK.

**Note** The Import wizard maintains delimited text file settings for the current import session only.

**Importing Data from PDX Packages and aXML Files**

The Import wizard supports importing data from two different XML formats:

- **Product Data eXchange (PDX)** — A standardized XML format for representing structured product content. It provides a means for partners in the e-supply chain (OEMs, EMS providers, and component suppliers) to exchange product content and changes (BOMs, AMLs, ECRs, ECOs). You can import items, BOMs, manufacturers, manufacturer parts, AMLs, and attachments from a PDX package. You can create PDX packages in the Agile Web Client. In addition, Agile provides a free, Web-based application called Agile eXpress that lets you create and view PDX packages.

  For more information about PDX, including a link to the DTD, see following Web page: [http://webstds.ipc.org/2571/2571.htm](http://webstds.ipc.org/2571/2571.htm)

- **Agile XML (also known as aXML)** — Agile XML format is an XML representation of Agile's business schema. aXML contains all product content managed in Agile including items, change details, manufacturer information, cost, drawings and other files. As a representation of schema elements across all Agile products, aXML will evolve with Agile's business schema over time. Agile Content Service (ACS) and Agile Integration Services (AIS) both export Agile data in aXML format. Agile does not provide a separate tool to view aXML packages. However, you can open the XML file contained within an aXML package in any XML viewer. For example, Internet Explorer can be used to view XML files.

  For the latest aXML schema, please see the following Web site: [http://support.agile.com/misc/axml/2006/03/](http://support.agile.com/misc/axml/2006/03/)

  **Note** The Import wizard does not support importing changes or packages, even though these can be contained within a PDX package or an aXML file.

PDX packages that you want to import must adhere to the following guidelines:

- The embedded XML file contained in a PDX package must be well formed and meet the structural requirements specified by PDX DTD Revision 1.0. (If you have a PDX 0.7 file, you can open it in Agile eXpress 8 and save it as a PDX 1.0 file.)

- The PDX package must contain values for attributes that correspond to Agile key fields.

- The PDX package must not contain multiple revisions of the same item. If you try to import items from a PDX package with multiple revisions, the Import wizard rejects the file.

- The Import wizard supports PDX packages that use Agile’s multi-site PDX 1.0 implementation. It does not support multi-site PDX implementations from other vendors.

**To import data from a PDX package or an aXML file:**

1. Choose Tools > Import.

2. Specify the import source. Select File. Type the filename or click Browse to select it.
Note  PDX packages have a pdx extension, and aXML files have an axml extension.

3  Click Product Data eXchange Package or Agile XML (aXML) File. Click Next.

4  Select one or more types of objects to import, then click Next.

5  Select a change order and a mapping file. Use the default PDX mapping. You can edit the default mapping to add or remove field mappings. Click Next.

   Note  A change order is required when you use Redlining mode to import. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.

6  Select or create a transformation definition file (optional). Click Next.

7  Review your import settings. Click Import to begin importing.

Objects that Can Be Imported from PDX Packages

If you select Product Data eXchange Package as the File Type on the first page of the Import wizard, you can import the following objects:

- Manufacturer
  - Manufacturer Attachment
- Manufacturer Part
  - Manufacturer Part Attachment
- Item
  - Bill of Material
  - Approved Manufacturer List
  - Item Attachment
  - Sites

Objects that Can Be Imported from aXML

If you select Agile XML (aXML) File as the File Type on the first page of the Import wizard, you can import the following objects:

- Manufacturer
  - Manufacturer Attachment
- Manufacturer Part
  - Composition
    - Bill of Substances
  - Approved Supplier List
  - Specifications
  - Manufacturer Part Attachment
- Substance
  - Composition
  - Substance Attachment
- Declaration
  - Items
Using Templates to Import Data

An import template is a predefined format you can use to import items, BOMs, and AMLs from delimited text files or Microsoft Excel files. If you format your data according to one of the provided templates, the import process is simple. Once you specify the source file and select the default field mappings, you can click Import to begin importing.

The Import wizard provides the following templates:

- **BOM Only Level Template** — Represents the hierarchical levels of a BOM by specifying a numeric Level column. The relationship between a parent item and its components is set by the numeric level. Approved manufacturers are not included with this template.

- **BOM & AML Level Template** — Represents the hierarchical levels of a BOM by specifying a numeric Level column. The relationship between a parent item and its components is set by the numeric level. This template includes approved manufacturers for each part.
Chapter 2  Preparing and Selecting Source Data

❑ **Parent-Child Template** — Represents the relationship between a BOM and its components by Parent Number and Child Number columns.

If you use the BOM & AML Level Template or Parent-Child Template to import AMLs, remember that manufacturers listed in the AMLs must already exist in the Agile PLM system. Otherwise, the AML is rejected.

**To import data using an import template:**
1. Format the data appropriately using one of the templates.
   - **Note** Make sure the source file includes a header row and at least one row of data.
2. Start the Import wizard.
3. On the **Import Source** page, select **File**. Type the path of the file, or click **Browse** to select it.
4. Select **Delimited Text File** or **Excel Workbook**, and then click **Configure**.
5. For **Template Type**, select BOM Only Level Template, BOM & AML Level Template, or Parent-Child Template from the list.
6. Select other configuration options if necessary. When you are finished, click **OK**.
7. Select a change order and a mapping file. Use the default mapping. Click **Next**.
   - **Note** A change order is required when you use Redlining mode to import. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.
8. Click **Import** to begin the import operation.

**Using the Level Templates**

There are two level templates, **BOM Only Level Template** and **BOM & AML Level Template**. The BOM Only Level Template should be used to import items and BOMs; it has no effect on AMLs. To import items, BOMs, and AMLs in one pass, use the BOM & AML Level Template.

The source file for the level templates can include the following fields. The column headers in your source file must match the specified level template field names exactly.

<table>
<thead>
<tr>
<th>Category</th>
<th>Field Name</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Level1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Item Number</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Revision</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Product Line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lifecycle Phase</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rev Incorporation Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rev Release Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Effectivity Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Commodity</td>
<td></td>
</tr>
</tbody>
</table>
Note:
1. The level for the first record must be zero or any non-numeric value. Child items have a level other than zero, such as 1, 2, 3, and so on. After the first record, the Import wizard ignores any non-numeric characters in the Level column.
2. If you are using the BOM Only Level Template, do not include AML fields in your source file. The MFR Name and MFR Part Number fields are not required for BOM Only Level Template.

The following figure shows an example of level template data for items and BOMs.

Figure 2-5: Level template data for items and BOMs

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>B00233597C</td>
<td>NTB001 AD XPM FRAME</td>
<td>San Jose</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>910-134-0</td>
<td>CB1 BAYST TR REDUN D</td>
<td>San Jose</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>900-440-C</td>
<td>TESTED TOKEN RING C</td>
<td>Austin</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>920-401-E</td>
<td>BAYSTACK TOKEN RING A</td>
<td>Taipei</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>111-063</td>
<td>IC, 74HCT064, 40[4]-1</td>
<td>Taipei</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>5</td>
<td>111-170</td>
<td>IC, 74ABT245, 40[4]-1</td>
<td>San Jose</td>
<td>2</td>
</tr>
</tbody>
</table>

When the level template data includes AML information, each item can have multiple AML rows. The item information does not need to be repeated for each AML row. The following figure shows an example of level template data for items, BOMs, and AMLs.

Figure 2-6: Level template data for items, BOMs, and AMLs

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>B00233597C</td>
<td>NTB001 AD XPM FRAME</td>
<td>San Jose</td>
<td>1</td>
<td>ADVANCED CABLE TECHNOLOGY</td>
<td>910-134-0</td>
<td>Preferred</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>910-134-0</td>
<td>CB1 BAYST TR REDUN D</td>
<td>San Jose</td>
<td>1</td>
<td>JPM COMPANY</td>
<td>910-134-0</td>
<td>Preferred</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>900-440-C</td>
<td>TESTED TOKEN RING C</td>
<td>Austin</td>
<td>1</td>
<td>SOLECTRON TECHNOLOGY</td>
<td>900-440-C</td>
<td>Preferred</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>920-401-E</td>
<td>BAYSTACK TOKEN RING A</td>
<td>Taipei</td>
<td>1</td>
<td>TEXAS INSTRUMENTS</td>
<td>900-440-C</td>
<td>Preferred</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>111-063</td>
<td>IC, 74HCT064, 40[4]-1</td>
<td>Taipei</td>
<td>1</td>
<td>PHILLIPS ELECTRONICS</td>
<td>74HCT064</td>
<td>Preferred</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>MOTOROLA INC</td>
<td>74HCT123</td>
<td>Alternate</td>
</tr>
<tr>
<td>7</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>HARRIS SEMICONDUCTOR</td>
<td>74HCT123</td>
<td>Alternate</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>HARRIS SEMICONDUCTOR</td>
<td>74HCT123</td>
<td>Alternate</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>PHILLIPS ELECTRONICS</td>
<td>74HCT123</td>
<td>Preferred</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>HARRIS SEMICONDUCTOR</td>
<td>74HCT123</td>
<td>Alternate</td>
</tr>
<tr>
<td>11</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>PHILLIPS ELECTRONICS</td>
<td>74HCT123</td>
<td>Preferred</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>HARRIS SEMICONDUCTOR</td>
<td>74HCT123</td>
<td>Alternate</td>
</tr>
<tr>
<td>13</td>
<td>3</td>
<td>111-042</td>
<td>IC, 74HCT123, RETRIS MCA</td>
<td>Hong Kong</td>
<td>2</td>
<td>PHILLIPS ELECTRONICS</td>
<td>74HCT123</td>
<td>Preferred</td>
</tr>
</tbody>
</table>

Table 2-4: Level template fields (continued)
Using the Parent-Child Template

To use the parent-child template, the source file can include the following fields. The column headers in your source file must match the specified parent-child template field names exactly.

Table 2-7: Parent-child template fields

<table>
<thead>
<tr>
<th>Category</th>
<th>Field Name</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Parent Number</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Parent Revision</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Parent Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Child Number</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Child Revision</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Child Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sites</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Product Line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lifecycle Phase</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rev Incorporation Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rev Release Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Effectivity Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Commodity</td>
<td></td>
</tr>
<tr>
<td>BOM</td>
<td>Quantity</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Find Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reference Designator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BoM Notes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BoM Site</td>
<td></td>
</tr>
<tr>
<td>AML</td>
<td>MFR Namen&lt;sup&gt;2&lt;/sup&gt;</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>MFR Part Number&lt;sup&gt;n&lt;/sup&gt;</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>MFR Part Site&lt;sup&gt;n&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Preferred Status&lt;sup&gt;n&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reference Note&lt;sup&gt;n&lt;/sup&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Note:
1. Parent Revision and Child Revision fields are imported only if both are included in the source file.
2. To include multiple manufacturer parts per item, expand the row horizontally. That is, add separate columns for each manufacturer part. Append a number to the manufacturer part field names from 1 to m, where m is the total number of manufacturer parts the item has.
The following figure shows an example of parent-child template data for items and BOMs.

Figure 2-8: Parent-child template data for items and BOMs

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Number</td>
<td>Child Number</td>
<td>Quantity</td>
<td>Description</td>
</tr>
<tr>
<td>2</td>
<td>70695001</td>
<td>70694-01</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>70695010</td>
<td>7086-60</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>70695011</td>
<td>7089-03</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>70695001</td>
<td>7456-00</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>70695001</td>
<td>6054-61</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>70695011</td>
<td>6031-64</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>70695001</td>
<td>63815-64</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>71375050</td>
<td>71375050</td>
<td>1</td>
</tr>
</tbody>
</table>

The next example shows a parent-child template data for items, BOMs, and AMLs. Multiple manufacturer parts are specified for each component, and revision information is included in the optional Parent Revision and Child Revision columns.

Figure 2-9: Parent-child template data with revisions

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Number</td>
<td>Child Number</td>
<td>Description</td>
<td>Quantity</td>
</tr>
<tr>
<td>2</td>
<td>AX100</td>
<td>AX200</td>
<td>NTB5606 BUSR BAR A</td>
</tr>
<tr>
<td>3</td>
<td>AX100</td>
<td>AX200</td>
<td>TDB5606 CABLE BRAD</td>
</tr>
<tr>
<td>4</td>
<td>AX100</td>
<td>AX200</td>
<td>TDB5606 CABLE BRAD</td>
</tr>
<tr>
<td>5</td>
<td>AX100</td>
<td>AX200</td>
<td>STANDOFF INSULATORS</td>
</tr>
<tr>
<td>6</td>
<td>AX200</td>
<td>AX200</td>
<td>MOUNTING BRACKETS</td>
</tr>
<tr>
<td>7</td>
<td>AX200</td>
<td>AX200</td>
<td>SCREW 290-290</td>
</tr>
<tr>
<td>8</td>
<td>AX200</td>
<td>AX200</td>
<td>V/SICAL 280D, 560D</td>
</tr>
</tbody>
</table>

**Grouping and Sorting Parent Items**

Before importing parent-child data, make sure all parent items are grouped together in contiguous rows. If the same parent item is listed on noncontiguous rows, the Import wizard imports only the last group of component parts for that parent item. This requirement to presort the parent-child data is similar to the way BOM data in Excel files and text files must be sorted. For more information, see “Sorting BOM Components” on page 2-12.
The Agile PLM system lets you import several different types of data. This chapter includes these topics:

- Selecting Product Content Objects to Import
- Importing Items
- Importing Bills of Material
- Importing Manufacturers and Manufacturer Parts
- Importing Approved Manufacturers Lists
- Importing Quote Histories, Published Prices, and Price Lines
- Importing Customers and Product Service Requests
- Using Redlining or Authoring Mode
- Importing Site-specific BOMs and AMLs
- Importing Agile Product Governance & Compliance Data
- Importing Attachments from aXML and PDX Packages
- Importing Attachments from an Agile Package

Selecting Product Content Objects to Import

For Excel files and delimited text files, you can select only one object type to import. If the source format is an aXML or PDX package, you can select multiple object types to import.

The following table describes the types of objects you can import.

Table 3-1:  Product content objects that can be imported

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>A manufacturer with which your organization collaborates</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>A manufacturer part that your organization uses. A manufacturer part is identified by its manufacturer part number, not an internal part number.</td>
</tr>
<tr>
<td>Item</td>
<td>A unique part, material, subassembly, or product. Agile provides two out-of-the-box Item classes, Parts and Documents.</td>
</tr>
<tr>
<td>Bill of Material (BOM)</td>
<td>A listing of all the subassemblies, parts, and raw materials that go into a parent assembly. It shows the quantity of each part required to make an assembly.</td>
</tr>
<tr>
<td>Approved Manufacturer List (AML)</td>
<td>The list of manufacturers that have been approved to supply a particular item. The list identifies the manufacturer part for that item.</td>
</tr>
<tr>
<td>Quote History and Quote History Lines</td>
<td>Price quotes from previous projects or legacy data.</td>
</tr>
</tbody>
</table>
Agile PLM 9.2.1

For information about importing supplier data and currency conversion tables, see Chapter 4, “Importing Supplier and System Data.”

From within a Sourcing Project, you can also import project items, project BOMs, and project AMLs. For more information, see Chapter 5, “Importing Data into a Sourcing Project.”

Importing Items

An item is any unique manufactured or purchased part, material, subassembly, or product. An item can contain a BOM, which defines relationships with other items or subassemblies, and an AML, which defines the approved manufacturers and their respective manufacturer parts for that item.

Items in the Item Master represent the approved product content for your enterprise. Because an item can go through several changes during a product lifecycle, it can have multiple revisions. The Item Master stores an item’s revision history. Items contained within a project do not have multiple revisions. They serve as temporary data used to generate RFQs.

To import an item, you must map the **Title Block > Number** field. To specify a particular revision, you must also map the **Title Block > Rev** field. You can import items into the Item Master or a sourcing project.

Importing Parts and Documents

Agile provides two classes of items, Parts and Documents. If you want to import both Parts and Documents from the same source file you must map fields for both. If you only map field for Documents and your source file contains both Parts and Documents, only the Documents are imported. Remember, the Import wizard ignores any fields that aren’t mapped.

The Parts class has an optional field called Part Type. Documents has a similar field called Document Type. These fields specify the subclass for a Part or Document. If you don’t map these fields, the Import wizard uses the Default Part Type and Default Document Type set in Import Preferences; for more information, see “Setting Default Types” on page 8-4.

Note  Once an item is created, the Part Type and Document Type fields cannot be modified.

### Table 3-1: Product content objects that can be imported (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Published Price and Published Price Lines</td>
<td>Published prices or contract prices on current items and manufacturer parts.</td>
</tr>
<tr>
<td>Product Service Request (PSR)</td>
<td>A routable object used to issue problem reports and nonconformance reports for products.</td>
</tr>
<tr>
<td>Customer</td>
<td>A customer that provides feedback on your company’s products, alerting you to quality issues or problems they encounter.</td>
</tr>
<tr>
<td>Attachment</td>
<td>File(s) attached to an object.</td>
</tr>
<tr>
<td>Substance</td>
<td>Elements or compounds used in the composition of items, manufacturer parts, and part families.</td>
</tr>
<tr>
<td>Declaration</td>
<td>Declarations are routable objects used to bring information concerning the environmental compliance of parts (Items, Manufacturer Parts, and Part Families).</td>
</tr>
<tr>
<td>Specification</td>
<td>A list of banned substances (or substances of concern) and their threshold values.</td>
</tr>
<tr>
<td>Part Groups</td>
<td>A group of similar items or manufacturer parts. For PG&amp;C, items and manufacturer parts are similar if they have the same chemical composition and thus similar compliance requirements. For PCM, items and manufacturer parts are similar if they belong to the same commodity class.</td>
</tr>
</tbody>
</table>
Importing Parent Items with BOMs or AMLs

Each bill of material and approved manufacturers list is contained within an item. An item has separate **BOM** and **Manufacturers** tabs that hold the bill of materials and approved manufacturers, respectively.

When you import bills of material or approved manufacturers lists, you can also import the parent items. This is true regardless of the source format. If you import data from a delimited text file or an Excel file, you can import parent items and BOMs or parent items and AMLs in one import operation. If you import items from an aXML file, a PDX package, or one of the predefined template formats, you can import parent items, BOMs, and AMLs all at once.

Importing Items with Multiple Revisions

For speed and efficiency, the Import wizard imports items in batches. Consequently, problems can occur if you attempt to import multiple revisions of the same item from one import file.

- If you try to import items from an aXML file or PDX package containing multiple revisions of the same item, the Import wizard rejects the package.
- If you try to import items from an Excel file or a delimited text file, and the file contains multiple revisions of the same item in adjacent rows, the Import wizard imports only the first revision. It does not log an error.
- If you try to import items from an Excel file or a delimited text file, and the file contains multiple revisions of the same item in nonadjacent rows, the Import wizard rejects all revisions of the item.

Importing Bills of Material

A bill of material is a listing of all the subassemblies, parts, and raw materials that go into a parent assembly. It shows the quantity of each part required to make an assembly.

You can import bills of material into the Item Master or a sourcing project. If you are importing BOMs from a text file or a Microsoft Excel file, make sure all BOM components for a parent item are grouped together in contiguous rows. For more information, see “Sorting BOM Components” on page 2-12.

**Note** When you import bills of material, the Import wizard automatically creates any items listed in the source data that don't already exist in the Agile PLM system.

To import BOMs from a text file or an Excel spreadsheet:

1. Start the Import wizard.
   a. Choose **Tools > Import**.

2. Set import preferences.
   a. Click the **Preferences** button in the bottom left corner of the Import wizard. The Specify Preference Settings window appears.
   b. From the Preferences list, select Business Rule Options. For more information on these options, see “Setting Business Rule Options” on page 8-2.
   c. For **Change Mode**, select Redlining (the default) or Authoring. If you select Redlining, the Import wizard redlines any BOM fields that changed as a result of the import session. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.
   d. For **Change Number**, click to select a change order. A change order is required only if you selected Redlining for the Change Mode preference. You can search for an existing change order or create a new one. After you finish selecting or creating a change order, click **Finish** to return to the Specify Preference Settings window.
   e. For **Redline Mode Behavior**, select which items to add to the specified change order: all items, new items, or new items and existing items that have been redlined.
For Multi Row Update Mode, select Complete Replace or Add/Update Only. If you are importing data that includes partial BOMs and not complete BOM structures, select Add/Update Only.

Click OK to save your import preferences for this session.

3 Select the Import source file.
   a Specify the import source. Select File. Type the filename, or click Browse to select it.
   b Click Delimited Text File or Excel Workbook.
   c If necessary, click Configure to specify the template type or file configuration. Click OK.
   d Click Next to proceed to the next wizard step.

4 Select the BOM type.
   a Select Item, and then select Bill of Material.
   b Click Next.

5 Select a mapping file.
   a Select Use an Existing Mapping File or Create a New Mapping.
   a If you selected Use an Existing Mapping File, click Browse to select the file.
   a If you selected Create a New Mapping, click the Create a New Mapping button to define the mapping. The Edit Mapping File window appears. Map the import fields to target Agile fields, and then click Finished.
   b Click Next to proceed to the next wizard step.

6 Select or create a transformation definition file (optional). Click Next.

7 Review your import settings, and then click Import to begin importing.

Importing Existing and Non-existing BOM Components

When you import BOMs, the Import wizard automatically creates any items that don’t already exist in the Agile PLM system. If a BOM item already exists in the Agile PLM system, the Import wizard associates the item with its latest revision.

Under either of the following two conditions, the Import wizard fails to automatically create child items on a BOM:
   ❑ If the parent item’s required fields (such as Cover Page > Number) are invalid.
   ❑ If you imported BOMs to a project and the BOMs were subsequently rolled back.

Importing Find Numbers

If the BOM > Find Num field isn’t mapped, its default value is 0.

Importing Partial BOMs

To update a BOM without deleting existing BOM components, set the Multi Row Update Mode preference to “Add/Update Only.” The Import wizard imports new BOM components and updates any existing components. For more information, see “Setting Business Rule Options” on page 8-2.

Importing Manufacturers and Manufacturer Parts

Each manufacturer name in the Agile PLM system is unique, just as an item number must be unique to an item.

While different manufacturers can use the same manufacturer part number, the combination of manufacturer plus manufacturer part number must be unique to one manufacturer part.
You can import manufacturers and manufacturer parts into the Item Master but not into a project.

**Note** You must follow the recommended sequence and import manufacturers first, then manufacturer parts. Agile PLM doesn’t allow you to import a manufacturer part for a manufacturer that doesn’t exist.

### Importing Approved Manufacturers Lists

An approved manufacturers list, or AML, is the list of manufacturers that have been approved to supply a particular item. The list identifies the manufacturer part for that item.

You can import approved manufacturers lists into the Item Master or a project. The Import wizard does not automatically create manufacturers when you import AMLs. It does, however, automatically create manufacturer parts listed on AMLs.

When you import AMLs to the Item Master, manufacturers listed in the AMLs must already exist in the Agile PLM system. Otherwise, the AML is rejected.

### Automatic Creation of Child Manufacturer Parts

When you import AMLs, the Import wizard checks whether manufacturer parts listed in the AMLs exist in the Agile PLM system. If they don’t, the Import wizard automatically creates them. Under either of the following two conditions, the Import wizard fails to automatically create manufacturer parts:

- If the parent item’s required fields (such as Cover Page > Number) have invalid data.
- If you imported AMLs to a project and the AMLs were subsequently rolled back.

### Importing Partial AMLs

To update an AML without deleting existing AML rows, set the Multi Row Update Mode preference to “Add/Update Only.” The Import wizard imports new AML rows and updates any existing rows. For more information, see “Setting Business Rule Options” on page 8-2.

### Importing Quote Histories, Published Prices, and Price Lines

A price object is used to manage the price terms for a part with relation to a supplier, customer, and program. Each price object has a Price Lines table that stores the prices and terms related to shipping locations, effectivity periods, and quantities.

There are two classes of price objects that can be imported: Quote Histories and Published Prices. Functionally, there is no difference in importing either type of price object. However, if you are importing data from delimited text files or Microsoft Excel files, you must import Quote Histories and Published Prices in separate import operations. You must also maintain separate mapping files for them.

**Note** When you import price lines, your source data must provide the same consistent set of parent price fields for each row. For example, if your data uses the General Information > Number field to identify the parent price object, every row of the source data must include a value for that field. Otherwise, the import session may produce unexpected results.
Key Price Fields

The price object can be defined in many ways due to the number of required and optional key fields the object has. A price is associated with either an item or a manufacturer part. At a minimum, your source data should include one of the following sets of key fields:

Table 3-2: Minimum Price fields needed for import

<table>
<thead>
<tr>
<th>Set 1</th>
<th>Set 2</th>
<th>Set 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Information &gt; Mfr. Part Number</td>
<td>General Information &gt; Mfr. Name</td>
<td>General Information &gt; Item Number</td>
</tr>
<tr>
<td>General Information &gt; Supplier</td>
<td>General Information &gt; Item Rev</td>
<td>General Information &gt; Supplier</td>
</tr>
<tr>
<td>General Information &gt; Supplier</td>
<td>General Information &gt; Item Number</td>
<td>General Information &gt; Supplier</td>
</tr>
</tbody>
</table>

Note:
1. The Item Rev field specified in Set 2 above is required only for items with released or pending revisions.

General Information > Supplier supports two types of source values, either the supplier number or “supplierName - supplierNumber”. In either case, values are case-insensitive. If you use the “supplierName - supplierNumber” format for supplier values, the spaces and hyphen are required.

Your data can include other optional fields, such as Manufacturing Site, Program, and Customer. Values for the Customer field should be the customer name, not the customer number. Customer names are case-sensitive; the Import wizard rejects a price record if the customer name has the wrong case. If your source data doesn’t include Program and Customer, the Import wizard automatically assumes a value of “All” for those fields.

The General Information > Allow Qty Breaks field determines whether prices are broken out by different quantities. If the Allow Qty Breaks field is not mapped, the Import wizard uses the Price Quantity Break Default preference to determine which value to use for it; for more information, see Chapter 8, “Setting Import Preferences.” After a price object is created, you cannot change the value of its Allow Qty Breaks field.

Optionally, the source data can also include the General Information > Number field. If you are importing data to an existing price object, the General Information > Number field and all other required fields must match the target system exactly. Otherwise, the Import wizard rejects the object. If you don’t provide the price number, the Import wizard attempts to find the price object using other key fields. If a price object with the specified key fields doesn’t exist in the system, the Import wizard creates it and assigns it a number based on the AutoNumber sequence for the price class.

Note You cannot import price lines in Redline mode if the parent price object has a pending change order.

Key Price Lines Fields

At a minimum, your source data for Price Lines must include General Information > Price Number or the minimum fields that identify a price object (see “Key Price Fields” above) and the following key Price Lines fields:

- Price Lines > Price Effective From Date
- Price Lines > Ship To

In addition, if the Allow Qty Breaks field is set to Yes for the price object, then the Price Lines > Qty field is required and must be mapped.
All list fields on the Price Lines table, such as Ship From, Ship To, Currency, Country of Origin, and Transportation Terms must have valid values. For Ship To, only values listed in the Authorized Ship To list in the user’s profile are supported. For Transportation Terms, you can enter three-letter abbreviations like FOB or the full description, “FOB - FREE ON BOARD VESSEL.” Here’s a full list of values for Transportation Terms:

<table>
<thead>
<tr>
<th>Value</th>
<th>Full Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFR</td>
<td>CFR - COST AND FREIGHT</td>
</tr>
<tr>
<td>CIF</td>
<td>CIF - COST INSURANCE AND FREIGHT</td>
</tr>
<tr>
<td>CIP</td>
<td>CIP - CARRIAGE AND INSURANCE PAID TO</td>
</tr>
<tr>
<td>CPT</td>
<td>CPT - CARRIAGE PAID TO</td>
</tr>
<tr>
<td>DAF</td>
<td>DAF - DELIVERED AT FRONTIER</td>
</tr>
<tr>
<td>DDP</td>
<td>DDP - DELIVERED DUTY PAID</td>
</tr>
<tr>
<td>DDU</td>
<td>DDU - DELIVERED DUTY UNPAID</td>
</tr>
<tr>
<td>DEQ</td>
<td>DEQ - DELIVERED EX QUAY (DUTY PAID)</td>
</tr>
<tr>
<td>DES</td>
<td>DES - DELIVERED EX SHIP</td>
</tr>
<tr>
<td>EXW</td>
<td>EXW - EX WORKS</td>
</tr>
<tr>
<td>FAS</td>
<td>FAS - FREE ALONGSIDE SHIP</td>
</tr>
<tr>
<td>FCA</td>
<td>FCA - FREE CARRIER</td>
</tr>
<tr>
<td>FOB</td>
<td>FOB - FREE ON BOARD VESSEL</td>
</tr>
</tbody>
</table>

**Importing Partial Price Lines**

To update a Price Lines table without deleting existing rows, set the Multi Row Update Mode preference to “Add/Update Only.” The Import wizard imports new price lines and updates any existing rows. For more information, see “Setting Business Rule Options” on page 8-2.

**Importing Customers and Product Service Requests**

If your Agile PLM system includes the Product Service and Improvement license, you can use the system to manage quality issues that arise with customers. A customer can submit problem reports or nonconformance reports that alert you to quality issues or problems they encounter. Problem reports and nonconformance reports are two types of Product Service Requests.

**Importing Customers**

Customer data may be created in a Customer Relationship Management (CRM) system. If you haven’t integrated your CRM system with the Agile PLM system, you can use the Import wizard to import customers and Product Service Requests.

The Customer class is the only out-of-the-box subclass for customers. You can define other Customer subclasses.

The Customers > General Info > Customer Name field is required to import customers. All other fields are optional.

The Customers > General Info > Customer Number field is a key field, but it does not need to be mapped. If you do not map the Customer Number field, the Import wizard uses the AutoNumber preference to assign numbers to new customers. For more information, see “Setting Default AutoNumber Sources” on page 8-4.
Importing Product Service Requests

Product Service Requests (PSRs), like customers, may be created in a CRM system that is integrated with the Agile PLM system. If the two systems are not integrated, you can import Product Service Request data into the Agile PLM system.

The following fields are required to import PSRs:

- Problem Reports > Cover Page > Number
- Non-Conformance Reports > Cover Page > Number

If you are importing only one class of PSR at a time, you don’t need to map fields for both Problem Reports and Non-Conformance Reports. If your source data includes both Problem Reports and Non-Conformance reports, you must map fields for both classes.

Other Cover Page PSR fields you can map include PSR Type, Description, Customer, Supplier, Severity, Disposition, and Expected Resolution Date. Values for the Customer field should be the customer name, not the customer number. Customer names are case-sensitive.

Importing PSR Affected Items

You can import items to the Affected Items table of a PSR. The following fields are required to import PSR Affected Items:

- Problem Reports > Affected Items > Item Number
- Problem Reports > Affected Items > Rev Found
- Non-Conformance Reports > Affected Items > Item Number
- Non-Conformance Reports > Affected Items > Rev Found

Affected items for a PSR can be in any revision state, including Introductory. If you try to import an affected item and it doesn’t exist, the Import wizard rejects the row.

Using Redlining or Authoring Mode

If you use the Import wizard in Redlining mode (the default setting), you must specify a change order to import items, BOMs, AMLs, and prices. Redlining mode, as its name implies, highlights in red any fields that have changed. All items and prices imported in Redlining mode are placed on the Affected Items and Affected Prices tabs of the specified change order.

For released items and prices, the Import wizard redlines data based on changes made to the latest released revision. For prices, the Import wizard doesn’t allow you to redline the Price Lines table if the price object has a pending revision.

When you import items in Redlining mode, all items are unconditionally added to the Affected Items tab of the selected change order. The Import wizard does not allow you to interactively select which items should be placed on the Affected Items tab.

When you make changes to a BOM, Manufacturers, or Price Lines table in Redlining mode, entire rows and partial rows can be redlined. If you add or remove a row, the entire row is treated as a redline addition or deletion. If you modify only a few fields in a row but do not update its key fields, the Import wizard redlines only the fields you have changed. For example, if you modify some BOM fields but don’t modify the BOM > Item Number field, then the row is partially redlined.

If you use the Import wizard in Authoring mode, you can update an existing BOM, AML, or price lines if the parent item or price is unreleased and does not have a pending change. Authoring mode is helpful when you are importing BOM, AML, or price lines data for preliminary items or prices. Once an item or price has a pending change, you can no longer use Authoring mode to update its BOM, AML, or price lines.
For information on how to set the Change Mode preference to Redlining or Authoring mode, see “Setting Business Rule Options” on page 8-2.

Selecting a Change Order

On the Select Change Order and Mapping File step of the Import wizard, you can specify a change order to use for the import session. In Redlining mode, a change order is required to import items, BOMs, AMLs, prices, and price lines. In Authoring mode, a change order is optional.

Click ![Image](image) to select a change order. The Select Change For Import window appears. This new window is another wizard that lets you specify the change order to use for the current import session. You can search for an existing change order or create a new ECO, MCO, SCO, or PCO, or a change order of a similar user-defined subclass.

**Note** If you search for an existing change order, make sure it is in a non-released state. If you’re importing prices in Redlining mode, search the Agile PLM system to see if there is a pending PCO for the price object. If there is already a pending PCO associated with a price, you cannot add the same price object to a different PCO.

BOM, AML, and Price Lines Rollbacks

To preserve the integrity of BOMs, AMLs, and Price Lines imported to the Agile PLM system, the Import wizard doesn’t allow you to import partial import data to a new revision. If a BOM, AML, or Price Line row cannot be imported because it is invalid, the revision is rejected and the Import wizard rolls back the entire table to its original state prior to the import session.

During BOM, AML, and Price Lines rollbacks, parent items and prices are not removed from the **Affected Items** or **Affected Prices** tabs of the specified change order. Also, changes made to Title Block, Page Two, or Page Three fields are unaffected by rollbacks.

If a fatal error (for example, a database error) occurs while you are importing to a new revision of an item, the Import wizard rolls back the revision. Despite the rollback, any child items automatically created during the import process are not removed; they remain in the Agile PLM system.

If you import a BOM, AML, or Price Lines table to the latest revision and a validation error occurs, the replacement table is rejected.

If a fatal error occurs while you are importing BOMs, AMLs, or Price Lines to the latest revision, any replacement tables that were accepted before the error occurred cannot be rolled back. If this happens, try importing to the latest revision again.

If there are existing redlines for a pending Change order, the Import wizard clears them before importing new redline data from the import file. The clearing of redlines and the importing of new data are separate operations. After the redlines are cleared, the transaction is committed, and then the import process starts. Therefore, if the import operation fails for any reason (such as a duplicate item number), the table rolls back to its pre-redlined state.

The following table shows how import errors affect released BOMs, AMLs, and Price Lines tables:

<table>
<thead>
<tr>
<th>Revision</th>
<th>Type of Error</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>New revision — importing a new revision to the parent item or price</td>
<td>Validation error</td>
<td>The new revision and the related BOM, AML, or Price Lines table rejected.</td>
</tr>
<tr>
<td>Fatal error</td>
<td>The new revision and the related BOM, AML, or Price Lines table are rolled back.</td>
<td></td>
</tr>
<tr>
<td>Current revision — importing changes to the current revision of the parent item or price</td>
<td>Validation error</td>
<td>The replacement BOM, AML, or Price Lines table is rejected.</td>
</tr>
<tr>
<td>Fatal error</td>
<td>Any replacement BOM, AML, or Price Lines tables imported before the fatal error cannot be rolled back.</td>
<td></td>
</tr>
</tbody>
</table>
Note: The Import wizard rolls back BOM, AML, or Price Lines data only when there are errors with the data. It does not roll back BOMs, AMLs, or Price Lines if the warnings or errors pertain only to associated objects, such as fields for items, manufacturers, manufacturer parts, and prices.

### Importing Site-specific BOMs and AMLs

You can import site-specific BOMs and AMLs from all supported import file formats except MS Project Export File. However, you must format the site-specific data appropriately and map the fields correctly. In particular, you must include the **Title Block > Sites** field for the parent item as well as the **BOM > Site** field for BOMs and **Manufacturers > Site** field for AMLs.

The **Title Block > Sites** field is a virtual field that represents the list of sites on the Sites tab of an item. You do not need to map the **Title Block > Sites** field to import BOMs or AMLs. If you don’t map the field, the Import wizard assumes that the value for **Title Block > Sites** is the complete list of site names specified for **BOM > BOM Site** or **Manufacturers > Site** in your source file.

Note: The Import wizard does not remove site associations from existing parent items. In other words, although you can add sites to the **Title Block > Sites** field, you cannot use the Import wizard to remove sites from the Sites tab of an item.

When you import site-specific BOMs and AMLs, the Import wizard imports data only for sites specified in your source file. If your source file does not include a particular site already specified for an existing item, the Import wizard does not update that section of the site-specific BOM or AML.

The following figure shows a BOM import source file with site-specific information. There are two columns with site information: **Item Sites** and **BOM Site**.

![Sample BOM import source file with site information](image)

The Item Sites column is mapped to the **Title Block > Sites** field in the mapping window. It contains a comma-delimited list of the sites with which the parent part is associated.

The columns BOM Item, Qty, and BOM Site pertain to BOM components. The BOM Site column is mapped to the **BOM > Site** field in the mapping window. It indicates the site to which a component applies. Each row in this column can contain only one site. If the BOM Site field is empty, the component is used for all sites.

In the preceding figure, B0001, B0002, and B0003 do not have a specified BOM site. Consequently, those BOM components are common to all sites. B0004_Site has San Jose as the BOM site. This means that B0004_Site applies only to the portion of the BOM specific to the San Jose site.

The following figure shows an AML import source file with site-specific information. There are two columns with site information: **Item Sites** and **Mfr Site**.

![Sample AML import source file with site information](image)

The Item Sites column is mapped to the **Title Block > Sites** field in the mapping window. It contains a comma-delimited list of the sites with which the parent part is associated.
Chapter 3 Importing Product Content

The Item Sites column, like the same column in the BOM import source file discussed previously, is mapped to the Title Block > Sites field in the mapping window.

The columns Mfr Name, Mfr Part, and Mfr Site are related to approved manufacturers. The Mfr Site column is mapped to the Manufacturers > Site field in the mapping window. It indicates the site to which an approved manufacturer applies. Each row in this column can contain only one site. If the Mfr Site field is empty, the approved manufacturer is used for all sites.

In the preceding figure, ZETEX has San Jose as the Mfr Site. This means that this approved manufacturer applies only to the portion of the AML that is specific to the San Jose site.

**Note** If you use an SCO to import site-specific BOMs and AMLs in Redline mode, you can specify only one site per BOM/AML. BOMs or AMLs with multiple sites will be rejected.

### Importing Agile Product Governance & Compliance Data

The following table lists the Agile PG&C-related objects you can import.

<table>
<thead>
<tr>
<th>Object</th>
<th>Supported Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declaration¹</td>
<td>Cover Page, Page Two, Page Three, Items², Manufacturer Parts, Part Groups, Item Bill of Substances³, Manufacturer Part Bill of Substances³, Part Group Bill of Substances³, Specifications, Attachments</td>
</tr>
<tr>
<td>Item</td>
<td>Title Block, Page Two, Page Three, BOM, Manufacturers, Sites, Compliance &gt; Specifications⁴, Suppliers, Attachments</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>General Info, Page Two, Page Three, Compliance &gt; Specifications⁴, Compliance &gt; Compositions &gt; Bill of Substances³, Suppliers, Attachments</td>
</tr>
<tr>
<td>Part Group</td>
<td>General Info, Page Two, Page Three, Parts, Compliance &gt; Specifications⁴, Suppliers, Attachments</td>
</tr>
<tr>
<td>Specification</td>
<td>General Info, Page Two, Page Three, Substances⁵, Attachments</td>
</tr>
<tr>
<td>Substance</td>
<td>General Info, Page Two, Page Three, Composition⁶, Attachments</td>
</tr>
</tbody>
</table>

**Notes:**

1. There are several declaration classes with different restrictions on what can be imported. See “Importing Declarations” on page 3-12.
2. If you don’t map the Items > Item Rev field, the latest released revision of the item is imported. If the item doesn’t have a released revision, then the Introductory revision is imported.
3. Substances can be imported to the Bill of Substances tables for Declarations and Manufacturer Parts from aXML files only. This integration is supported if you have Agile Product Interchange, which allows you to retrieve Bill of Substances information from external content sources.
4. Only specifications can be imported into the Compliance table of items and part groups.
5. Only Substances that belong to the Substance Groups or Substances class can be added to the Substances table of specifications. Materials or Subparts are not allowed.
6. The Composition table varies per class.
   - **Substances class:** The Composition table is not supported.
   - **Substance Groups class:** The Composition table can have only substances.
   - **Materials class:** The Composition table can have substance groups or substances.
   - **Subparts class:** The Composition table can have other subparts, materials, substance groups, and substances.

Several Agile PG&C objects, including items, have Mass fields. For information about importing data to Mass fields, see “Importing Mass Values” on page 2-8.

For a list of Agile PG&C fields that must be mapped to be imported, see “Key Fields and Required Fields” on page 6-1.
**Importing Declarations**

Agile PG&C has several different declaration classes. Based on the declaration class and the type of source file, there are restrictions on the tables you can import, as shown in the following table.

Table 3-2: Tables that can be imported per Declaration type and source file type

<table>
<thead>
<tr>
<th>Declaration Type</th>
<th>Supported Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Declaration of Conformance</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Specifications, Attachments</td>
</tr>
<tr>
<td></td>
<td>File Type = Delimited Text or Microsoft Excel: Cover Page, Page Two, Page Three, Specifications</td>
</tr>
<tr>
<td>Part Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Specifications, Attachments</td>
</tr>
<tr>
<td></td>
<td>File Type = Delimited Text or Microsoft Excel: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Specifications</td>
</tr>
<tr>
<td>Homogeneous Material Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Item Bill of Substances, Manufacturer Part Bill of Substances, Part Group Bill of Substances, Specifications, Attachments</td>
</tr>
<tr>
<td>IPC 1752-1 Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Item Bill of Substances, Manufacturer Part Bill of Substances, Part Group Bill of Substances, Specifications, Attachments</td>
</tr>
<tr>
<td>IPC 1752-2 Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Item Bill of Substances, Manufacturer Part Bill of Substances, Part Group Bill of Substances, Specifications, Attachments</td>
</tr>
<tr>
<td>JGPSSI Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Item Bill of Substances, Manufacturer Part Bill of Substances, Part Group Bill of Substances, Specifications, Attachments</td>
</tr>
<tr>
<td>Substance Declaration</td>
<td>File Type = aXML: Cover Page, Page Two, Page Three, Items, Manufacturer Parts, Part Groups, Item Bill of Substances, Manufacturer Part Bill of Substances, Part Group Bill of Substances, Specifications, Attachments</td>
</tr>
</tbody>
</table>

**Note**  Declarations created in Agile PLM 9.2 cannot be imported in Agile PLM 9.2.1

**Using Special Export and Import Commands to Complete Declarations**

Declaration classes have special export and import commands provided that let suppliers integrate the data with other Agile PLM systems or complete the compliance request form in other clients, such as Microsoft Excel or Adobe Reader. The following table lists these export and import commands.

Table 3-3: Special export and import commands for Declarations

<table>
<thead>
<tr>
<th>Class(es)</th>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Declaration classes</td>
<td>Export AXML</td>
<td>Exports and imports Agile XML for integration with Agile PLM systems.</td>
</tr>
<tr>
<td>IPC 1752-1 Declaration</td>
<td>Export IPC XML</td>
<td>Exports and imports XML data that can be used to complete IPC-1752-1 and IPC-1752-2 data compliance request forms.</td>
</tr>
<tr>
<td>IPC 1752-2 Declaration</td>
<td>Import IPC XML</td>
<td>Exports and imports XML data that can be used to complete IPC-1752-1 and IPC-1752-2 data compliance request forms.</td>
</tr>
<tr>
<td>JGPSSI Declaration</td>
<td>Export JGPSSI</td>
<td>Exports and imports a text file in block format for integration with the JGPSSI Excel template.</td>
</tr>
<tr>
<td></td>
<td>Import JGPSSI</td>
<td>Exports and imports a text file in block format for integration with the JGPSSI Excel template.</td>
</tr>
<tr>
<td></td>
<td>Open In Excel</td>
<td>Opens the Declaration in Microsoft Excel.</td>
</tr>
</tbody>
</table>

**Note**  The commands in Table 3-3 are enabled by process extensions that are assigned to Declaration classes. If the commands are not available, your Agile PLM system has a custom configuration.

The data format for these special export and import commands is predefined by Agile’s aXML format, the JGPSSI template, and the IPC-1752-1 and IPC-1752-2 forms. For more information about these commands, see the *Product Governance & Compliance User Guide*. 

---

3-12 Import and Export Guide
Chapter 3 Importing Product Content

Importing Attachments from aXML and PDX Packages

You can import attachments—such as CAD drawings, images, and documents—from a PDX package or an aXML file. Attachments are usually binary files, sometimes quite large. Consequently, they cannot be imported from a text file. The following table shows the objects for which you can import attachments from PDX and aXML files.

Table 3-4: Objects for which attachments can be imported

<table>
<thead>
<tr>
<th>Object</th>
<th>Attachments in PDX</th>
<th>Attachments in aXML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Price</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Substance</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Declaration</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Specification</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Part Group</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

When you import a BOM or an AML, attachments are not automatically imported for the associated items, manufacturers, and manufacturer parts; you must explicitly import them.

Importable Attachment Fields

The following fields can be imported to the Attachments tab:

- **File Description**
- **File Name**

aXML and PDX packages also support custom fields on the Attachments tab. If the Agile PLM administrator enables Attachments fields such as Text01, List01, and Numeric01 by making them visible, you can import data into them.

Importing the Latest Version of Attachments

The Import wizard always imports the latest version of attachments. For example, if an item has attachments **Rev A version 1**, **Rev A version 2**, and **Rev B version 1**, then **Rev A version 2** and **Rev B version 1** are imported.

Items can have multiple revisions with different attachments for each revision. For example, suppose there is an item with three revisions, A, B, and C. Each revision can have different attachments and different versions of those attachments.

For example, say you import attachments for each revision in five separate import sessions:

- **Session 1**: Revision A with File 1 Version 1
- **Session 2**: Revision A with File 1 Version 2
- **Session 3**: Revision B with File 1 Version 3
- **Session 4**: Revision C with File 1 Version 4
- **Session 5**: Revision C with File 1 Version 5 and File 2 Version 1
After completing the five import sessions, the following table shows the attachments that would be visible for each revision.

### Table 3-5: Example of item revisions and their attachments

<table>
<thead>
<tr>
<th>Revision</th>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev A</td>
<td>File 1 Version 1, File 1 Version 2</td>
</tr>
<tr>
<td>Rev B</td>
<td>File 1 Version 3</td>
</tr>
<tr>
<td>Rev C</td>
<td>File 1 Version 4, File 1 Version 5, File 2 Version 1</td>
</tr>
</tbody>
</table>

#### URL Attachments

An attachment can be an URL instead of an actual file. An URL is the address of a file on the Internet, which means the file is not secured on the file management server. URL attachments have a file size of 0 bytes and cannot be checked out from the file management server.

#### Attachments and Rollback of Parent Items

If an attachment fails to be imported for some reason, its parent object (an item, manufacturer, or manufacturer part) is not rolled back.

#### Importing Multiple-file (Folder) Attachments

PDX supports multiple-file attachments. In previous versions of Agile software, multiple-file attachments were represented as a folder. When you import an attachment folder from a PDX package, the Import wizard imports each file in the folder as a separate attachment.

#### Attachment Redlines

The Agile PLM system supports attachment redlines, that is, annotation layers added to the file. Attachment redlines cannot be imported. Only the attached file and its associated fields can be imported.

#### Transforming Values for Attachments

Do not use a transformation definition file to modify attachment filenames. Otherwise, the Import wizard will fail to import the files.

#### Importing Attachments from an Agile Package

An Agile package is an object that has files and documents describing a proposed product. It can be routed to other Agile users, including supply-chain partners.

Once an Agile package has been reviewed and approved by the approvers and accepted by the program manager, the program manager can process the Agile package data using the internal procedures specific to your company. When the package is accepted, its attachments that are PDX files or delimited text files can be imported into your Agile PLM system.

**To import an attachment from an Agile package:**

1. Open the Agile package in the Agile Web Client.
2. Click the **Attachments** tab.
3. Select an attachment (either a PDX file or a delimited text file).
4 Click **Import**.

**Note** The Import button is enabled only when the package is released. For the default package workflow, the released status is called Accepted.

5 A message box appears. Click **OK**.

6 The Import wizard appears. Follow the steps in the wizard.
Importing Supplier and System Data

Supplier data that you can import includes suppliers, manufacturer and commodity offerings for suppliers, and RFQ responses. Agile also lets you import currency conversion rates. This chapter includes these topics:

- Importing Suppliers
- Importing Supplier RFQ Responses
- Importing a Currency Conversion Table

Importing Suppliers

You can collaborate with external suppliers to gather and prepare product content. Suppliers also negotiate pricing and directly respond to Requests for Quotes (RFQs).

The following two fields are required to import suppliers:

- Suppliers > General Info > Name
- Suppliers > General Info > Corporate Currency

The Suppliers > General Info > Number field is a key field, but it does not need to be mapped.

If you don’t map the Suppliers > General Info > Number field, the Import wizard uses the supplier name to find an existing supplier. If the supplier name matches the names of multiple existing suppliers, the Import wizard rejects the row. If no supplier with that name exists, the Import wizard creates a new supplier and uses the AutoNumber preference to assign a number to it. For more information, see “Setting Default AutoNumber Sources” on page 8-4.

In the source data, make sure you specify the supplier type. There are five out-of-the-box supplier types, but you can add more to your Agile PLM system. The five supplier types are:

- Broker
- Component Manufacturer
- Contract Manufacturer
- Distributor
- Manufacturer Representative

The Suppliers > General Info > Maximum Number of Licensed Contact Users and Suppliers > General Info > Maximum Number of Power Contact Users fields specify the maximum number of contact users and power users that can be added to the supplier organization, respectively. Both contact users and power users can respond to RFQs, but only power users can generate and view reports.

Currency values for the Corporate Currency field must be specified using a three-letter code. For more information, see “Importing Currency Values” on page 2-5.
Importing Supplier Manufacturer and Commodity Offerings

A supplier’s manufacturer offerings define which manufacturer’s products are sold by the supplier. For example, a supplier called ACME might sell Motorola and Kemet products. When you import manufacturer offerings, the Import wizard validates the manufacturer name against existing manufacturer names in the Agile PLM system. If the manufacturer doesn’t exist, the Import wizard rejects the offering.

The following fields are required to import supplier manufacturer offerings:

- Suppliers > General Info > Name
- Suppliers > General Info > Corporate Currency
- Suppliers > Manufacturers > Mfr. Name

The Suppliers > General Info > Number field is a key field, but it does not need to be mapped. If you do not map the Number field, the Import wizard uses the AutoNumber preference to assign numbers to new suppliers. For more information, see “Setting Default AutoNumber Sources” on page 8-4.

A supplier’s commodity offerings define the product categories sold by the supplier. For example, a supplier called ACME might sell commodities like fuses, integrated circuits, and resistors. When you import a supplier’s commodity offerings, the Import wizard validates the commodity name against existing commodity names in the Agile PLM system. If the commodity doesn’t exist, the Import wizard rejects the offering.

The following fields are required to import supplier commodity offerings:

- Suppliers > General Info > Name
- Suppliers > General Info > Corporate Currency
- Suppliers > Commodities > Commodity

Once again, the Suppliers > General Info > Number field is a key field, but it does not need to be mapped. If you do not map the Number field, the Import wizard uses the AutoNumber preference to assign numbers to new suppliers.

You can import either the Ship-To location or geographical values (Continent, Country/Area, and Region/Province/State fields) for each offering.

Only valid Ship-To locations can be specified. Otherwise, the offering is ignored. The Ship-To value can consist of multiple delimited locations (for example, “Milwaukee, Nagoya, Taipei”). If multiple Ship-To locations are specified for a particular row, multiple offerings are created when you import the file.

**Note** The Agile PLM administrator can define valid Ship-To locations by logging into the Agile Java Client and choosing Admin > System Settings > Product Cost Management > Ship To Locations.

Offerings can be given a rating for each Ship-To location. This rating allows the buyer to describe their relationship with the supplier and a specific offering. Although suppliers have restricted access to the Agile PLM system, they do not have privileges to see the ratings that have been assigned.

By default, there are four possible values for the Rating field:

- Approved
- Offered Active
- Offered Inactive
- Strategic

**Note** The Agile PLM administrator can configure the available values for the Rating field by logging into the Agile Java Client and choosing Admin > Data & Workflow Settings > Lists > Supplier Offering Rating.
Importing Offerings and Ratings in One Operation

To import supplier offerings and ratings in one operation, you must provide either the Ship-To location or geographical values for the offering. Again, only valid Ship-To locations can be specified.

If a row in the source data includes a Ship-To value and it corresponds to a valid Ship-To location that has not yet been associated with the supplier, the Import wizard creates a new offering with the Ship-To value and the Rating value (if provided). If the specified Ship-To location is already associated with the supplier, the Import wizard updates the Rating field (if provided). If the specified Ship-To location isn’t valid, the entire row is rejected.

If a row in the source data doesn’t include a Ship-To value but does include geographical values (Continent, Country/Area, and Region/Province/State fields), the Import wizard creates an offering and automatically associates the appropriate Ship-To locations with it. However, the following rules apply:

- The Continent value is required. If values for Country/Area or Region/Province/State fields are blank or missing, the default value “All” is used, which results in a broad offering.
- Only single values can be imported for each geographical value. Multiple delimited values (for example, “Arizona, California, Texas”) are not supported.

Note When you create an offering, make sure the geographical data you specify isn’t narrower than an existing offering for the same manufacturer or commodity. For example, if the Region/Province/State field for an existing offering is set to “All,” you can’t create a new offering for the same manufacturer or commodity with the Region/Province/State field set to “California” because the existing offering covers a broader region.

Importing Supplier RFQ Responses

Suppliers that quote on items in an RFQ can export items to prepare a response. When a supplier exports items, the Agile PLM system generates a comma-delimited text file. The exported supplier response file is named RFQNumber.csv. Suppliers can use a spreadsheet program, such as Microsoft Excel, to edit the file. They can also use a quoting tool to complete responses offline. After suppliers complete the fields in a response file, they can import the file back into the Agile PLM system to send the response to the sourcing manager.

Unlike other types of objects that you can import, supplier responses do not require that you map import fields to Agile PLM fields. Since the response is a modified version of the exported text file, the mapping is automatic.

To import a supplier response:

1. Select an RFQ.
2. Click the Responses tab.
3. Choose Responses > Import. The Import wizard appears.
4. Click Browse, select the file, then click Open.
5. Click Import.

Importing Responses from Non-Web Suppliers

If a supplier does not have Web access to the Agile PLM client, the sourcing manager can import the supplier’s response file. Since the response is a modified version of the exported text file, the Import wizard maps response fields automatically.

To import an RFQ response from a non-Web supplier:

1. Select an RFQ.
2. Click the Response Status tab.
3. Select a non-Web supplier.

Note Non-Web suppliers are indicated by the icon.
4 Click **Import**. The Import wizard appears.

5 Click **Browse**, select the file, then click **Open**.

6 Click **Import**.

**Guidelines for Editing Supplier Response Fields**

To successfully import a supplier response text file, you must follow these guidelines when you edit the file:

- You can reorder column headings, but do not edit or add any data to the headings. If you modify column headings, the file cannot be imported.
- Do not add new columns of data.
- Do not modify any date fields except for **EOL Date** and **Expiration Date**.
- Do not enter values in any fields with the comment “do not fill out.” Those fields are not supposed to contain data, and the “do not fill out” comment is intended to prevent you from editing the fields. For component parts, **Nonmaterial Price** fields should not be filled out. For assembly items, **Material Price** fields should not be filled out.
- A required field has an asterisk (*) to the right of its column heading. In the following figure, all columns shown are required.

![Figure 4-1: Supplier response fields](image)

If you fail to complete all required fields, you can still successfully import the file. However, you won’t be able to send the response to the sourcing manager. Required and requested fields are specified by the sourcing manager that set up the project.

- Empty fields are not imported. They are not equal to 0. To set a numeric field or a price field to 0, you must explicitly enter the value 0.

- If you prefer, you can remove the `<HEADER>` section at the top of the file since it is not imported. To remove this section, make sure you remove the two rows containing the `<HEADER>` and `</HEADER>` tags and all rows in between.

- When you import the supplier response file, the imported data replaces existing response field data.

When you edit a supplier response file, make sure you edit only fields you are allowed to edit. Generally, this means the **Bid Decision** field and fields to the right of it. Other fields are for viewing only.

You can import the supplier response file multiple times. Each time you import the file, only the editable fields are imported, replacing the previous values. The fields that appear in a supplier response file depend on whether the sourcing manager specified them as requested and required.

The Agile PLM system supports different price scenarios, so RFQ fields vary based on the price periods and/or quantity breaks specified for a particular project. Prices can be based on multiple quantity breaks (up to 6) or on multiple price periods, with one or more quantities per price period.
The following table shows all possible supplier response fields:

Table 4-1: Supplier response fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Editable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adder</td>
<td>✓</td>
</tr>
<tr>
<td>Bid Decision</td>
<td>✓</td>
</tr>
<tr>
<td>Country of Origin</td>
<td>✓</td>
</tr>
<tr>
<td>EOL Date</td>
<td>✓</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>✓</td>
</tr>
<tr>
<td>Inventory</td>
<td>✓</td>
</tr>
<tr>
<td>Item Number</td>
<td></td>
</tr>
<tr>
<td>Item or Mfr Part Description</td>
<td></td>
</tr>
<tr>
<td>Lead Time</td>
<td>✓</td>
</tr>
<tr>
<td>Material Cost</td>
<td>✓</td>
</tr>
<tr>
<td>Min</td>
<td>✓</td>
</tr>
<tr>
<td>Mult</td>
<td>✓</td>
</tr>
<tr>
<td>Mfr Name</td>
<td></td>
</tr>
<tr>
<td>Mfr Part Number</td>
<td></td>
</tr>
<tr>
<td>NCNR</td>
<td>✓</td>
</tr>
<tr>
<td>Nonmaterial Price</td>
<td>✓</td>
</tr>
<tr>
<td>NRE</td>
<td>✓</td>
</tr>
<tr>
<td>Period Start Date Quantity Break 1...6 - Quantity</td>
<td></td>
</tr>
<tr>
<td>Period Start Date Quantity Break 1...6 - Target Price</td>
<td></td>
</tr>
<tr>
<td>Quantity Break 1...6</td>
<td></td>
</tr>
<tr>
<td>Response Flex Fields</td>
<td>✓</td>
</tr>
<tr>
<td>RFQ Number</td>
<td></td>
</tr>
<tr>
<td>Rev</td>
<td></td>
</tr>
<tr>
<td>Terms of Sale</td>
<td>✓</td>
</tr>
<tr>
<td>UOM</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
1. This field can be configured by the sourcing manager. Consequently, it may have a different display name.
2. The availability of this field depends on the price scenario selected for a particular project.
3. There are 25 response flex fields that can be configured and enabled in the Agile PLM system: 5 date fields, 10 text fields, 5 number fields, and 5 currency fields.

Adding Suggested Alternate Parts to the Response File

Suppliers are often requested to quote on parts they are unable to supply for various reasons. For example, the part may be obsolete, on allocation, or have an End of Life (EOL) status. The part may also be unnecessarily expensive, or perhaps the supplier doesn't have the full quantity available within the required lead time. To remedy this problem, the supplier can suggest alternate parts in the RFQ response.
When you suggest an alternate part, you can also suggest new manufacturers for the part, including manufacturers the sourcing manager did not consider.

To add suggested alternate parts to the RFQ response:

1. Open the exported response file in a spreadsheet program (such as Microsoft Excel) or another application that supports comma-delimited files.

2. Insert a row for the part you wish to replace.

3. Enter appropriate values in the **Mfr Part Number**, **Mfr Name**, and **Item or Mfr Part Description** fields. The value in the **Item Number** field must be identical to the part you’re replacing. In the **Bid Decision** field, enter **Bid – Alternate**. Leave the **Rev** and **UOM** fields blank; those fields are inherited from the parent item. Fill out other fields as appropriate.

   You can insert additional rows to suggest more alternate parts.

4. Save the file in comma-delimited (CSV) format.

**Importing Responses to Price Scenarios**

Supplier response files display price scenarios horizontally. The supplier can therefore fill out all response information for each component part on a single row.

Each price scenario represents either one quantity break or one quantity per price period. The following table shows quantity breaks and target prices that have been entered for one period for several different items.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Q 4 30-Dec-2002 QuantityBreak1 - Quantity</th>
<th>Q 4 30-Dec-2002 QuantityBreak1 - Target Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-007</td>
<td>1</td>
<td>0.04</td>
</tr>
<tr>
<td>10-008</td>
<td>10</td>
<td>12.80</td>
</tr>
<tr>
<td>10-009</td>
<td>1</td>
<td>0.04</td>
</tr>
<tr>
<td>10-010</td>
<td>10</td>
<td>16.60</td>
</tr>
<tr>
<td>10-011</td>
<td>1</td>
<td>0.04</td>
</tr>
<tr>
<td>10-012</td>
<td>1</td>
<td>0.09</td>
</tr>
<tr>
<td>10-013</td>
<td>5</td>
<td>2.95</td>
</tr>
<tr>
<td>10-014</td>
<td>100</td>
<td>122.00</td>
</tr>
</tbody>
</table>

The Import wizard ignores empty fields. To set a price value to 0, you must explicitly enter 0.

**Note** Price values in the exported supplier response file are formatted according to the user’s currency preference. To change your Agile user preferences in the Agile Web Client, click **Settings > User Profile > Preferences > Edit.**
Valid Values for Supplier Response Fields

Certain supplier response fields require specific values that must be spelled correctly. If you type an invalid value in the field, it won’t be imported. The following table shows the valid values for the supplier response fields that require specific values.

Note The header for the supplier response file also lists values for these fields.

Table 4-3: Valid values for supplier response fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid values</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bid Decision</td>
<td>Bid, Bid - Alternate Part, No Bid - Non-Franchise, No Bid - Obsolete Part, No</td>
<td>Enter a valid country name. Make sure the spelling is correct.</td>
</tr>
<tr>
<td></td>
<td>Bid - On Allocation, No Bid - Other, No Bid - Unknown Part, Not Responded</td>
<td></td>
</tr>
<tr>
<td>Country of Origin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCNR</td>
<td>Yes, No</td>
<td></td>
</tr>
<tr>
<td>Terms of Sale</td>
<td>CFR, CIF, CIP, CPT, DAF, DDP, DDU, DEQ, DES, EXW, FAS, FCA, FOB</td>
<td>Cost and Freight, Cost, Insurance, and Freight, Carriage and Insurance Paid To, Carriage Paid To, Delivered at Frontier, Delivered Duty Paid, Delivered Duty Unpaid, Delivered Ex Quay (Duty Paid), Delivered Ex Ship, Ex Works, Free Alongside Ship, Free Carrier, Free on Board Vessel</td>
</tr>
</tbody>
</table>

Note In addition to the three-letter abbreviations for Terms of Sale, you can enter the full Terms of Sale value, for example, “CFR - COST AND FREIGHT” or “CIF - COST, INSURANCE AND FREIGHT.” The value must be all uppercase.

Importing a Currency Conversion Table

Agile allows you to maintain up-to-date currency conversion rates that convert currency values to the selected corporate currency. You can use the Import wizard to update the conversion rates for all currencies enabled in the Agile PLM system. To import a currency conversion table, you must log in as a user assigned the Administrator role.

The currency conversion table that you import must meet the following requirements:

- It must be either a Microsoft Excel file or a delimited text file.
- The file should have two columns containing the currency code and the conversion factor.
- Each currency specified in the source file must be enabled in the Agile PLM system. To see which currencies are enabled, log into the Agile Java Client as an administrator and choose Admin > System Settings > Product Cost Management > Currency Exchange Rates.
- Currencies must be specified using three-letter codes. For example, EUR and USD are the codes for the Euro and the U.S. Dollar, respectively. For a complete list of currency codes, see “Importing Currency Values” on page 2-5.
Make sure you map the following Agile fields:

- Currency Conversion > Currency Exchange Rates > Currency Code
- Currency Conversion > Currency Exchange Rates > Conversion Factor

The following figure shows an example of a currency conversion table:

### Figure 4-4: Currency conversion table

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Currency Code</td>
</tr>
<tr>
<td>2</td>
<td>GBP</td>
</tr>
<tr>
<td>3</td>
<td>FRF</td>
</tr>
<tr>
<td>4</td>
<td>RUR</td>
</tr>
<tr>
<td>5</td>
<td>SGD</td>
</tr>
<tr>
<td>6</td>
<td>INR</td>
</tr>
<tr>
<td>7</td>
<td>JPY</td>
</tr>
</tbody>
</table>

**To import a currency conversion table:**

1. Format the source file appropriately using either a Microsoft Excel file or a delimited text file.
2. Start the Import wizard.
3. On the first step of the Import wizard, select Delimited Text File or Excel Workbook.
4. Type the path of the file, or click Browse to select it.
5. Click Next.
7. Select a mapping file, or create new field mappings.
8. Click Import to begin the import operation.
Importing Data into a Sourcing Project

Projects allow multiple users to work as a team to complete sourcing and pricing activities. This chapter includes these topics:

- About Sourcing Projects
- Starting the Import Wizard from a Sourcing Project
- Types of Data You Can Import into a Project
- Publishing AMLs from a Project to the Item Master
- Mapping and Importing Quantity Breaks and Target Costs
- How Projects Handle Revisions

About Sourcing Projects

A project holds data you gather during product sourcing activities. Buyers can use projects to gather information to prepare RFQs, assign suppliers, track and analyze responses, and negotiate final pricing. Buyers can also perform cleanup of AMLs in a project and publish them to the Item Master, where they are available for all future projects.

You can create a project using one of the following price scenarios:

- **Quantity Breaks** — prices are based on multiple quantity breaks to determine the best suppliers and components for a product.

- **Effectivity Periods** — prices are based on multiple effectivity periods, with one or more quantities per period, to manage the ongoing cost of products throughout a product’s lifecycle. This price scenario provides forward-looking visibility into product costs to help you uncover opportunities to reduce costs and meet targets.

Starting the Import Wizard from a Sourcing Project

Project objects, such as items, BOMs, and AMLs, are different from Item Master objects. They have different sets of fields, and therefore different field mappings, than Item Master objects. When you import items into a project, they are not imported automatically into the Item Master.

**Note** After you import BOMs into a project, you may need to recalculate quantities for BOM components. For more information, see “Calculating Rollup Quantities” on page 5-2.

To import data into a new sourcing project:

1. Choose **Create > Sourcing Project**.
2. Complete the Project Creation wizard.
3. On the Add Items step of the wizard, click **Add**. The Add Project Items wizard starts.
4. Under **Create New Items**, select **Import**. Click **Next**. The Import wizard appears. Follow the wizard steps.
To import items and BOMs into an existing sourcing project:
1. Open a sourcing project.
2. Click the **Items** tab.
3. Choose **Items > Import**. The Import wizard appears. Follow the wizard steps.
   **Note** If items you import from the **Items** tab have both BOMs and AMLs, you can import them at the same time.

To import items and AMLs into an existing sourcing project:
1. Open a sourcing project.
2. Click the **AML** tab.
3. Choose **AML > Add/Modify > Import**. The Import wizard appears. Follow the wizard steps.

For a list of the Import wizard steps, see “Import Wizard Steps” on page 1-5.

**Calculating Rollup Quantities**

After you import data into a sourcing project, you need to calculate the quantities for BOM components. At the top of the **Items** and **AML** tabs of a project, it shows the date and time when quantities were last calculated. When the calculated date and time is red, you need to click 🔄 to recalculate quantities.

Within a sourcing project, you specify quantities for top-level assemblies, not for BOM components. For BOM components, you specify quantities per assembly (QPA).

For each price scenario in your project, component level quantities are based on the assembly quantities and the QPA. When you calculate quantities, the project aggregates the quantities across assemblies for common items. If partner splits have been specified, the project also applies the splits to the calculated quantities.

**Types of Data You Can Import into a Project**

You can import the following object types into a project:
- Project items
- Project bills of material
- Project approved manufacturers lists
- Project item attachments

An assembly item is any item that has a BOM. Any project items that have a BOM can also have an AML. You can import a BOM and an AML into the same project item.

**Publishing AMLs from a Project to the Item Master**

Although you can import product content from the Item Master into a project, you cannot copy items and bills of material from a project into the Item Master. Approved manufacturers lists (AMLs), however, are different. You can validate AMLs in a project against the Item Master. You can also perform cleanup on AMLs in a project. After you finish cleaning up an AML, you can publish the AML changes back to the Item Master.

**Mapping and Importing Quantity Breaks and Target Costs**

Depending on the price scenario specified for a particular project, you can import multiple quantity breaks per item, or multiple effectivity periods per item with one or more quantities per period. This means that you can import quantity breaks or quantities per price period for each top-level assembly. You can also import the target cost per quantity break or target cost per price period, depending on the price scenario you select.
Chapter 5  Importing Data into a Sourcing Project

If the project’s price scenario is based on quantity breaks, you can select up to six quantity breaks. The Edit Mapping File window lets you map **Cover Page > QuantityBreak** fields for the number of quantity breaks in your project.

Figure 5-1: Mapping quantity breaks and target cost per quantity break

If the project’s price scenario is based on multiple effectivity periods, the Edit Mapping File window lets you map the quantity breaks and the target costs for each specified period. The following figure shows quantity break and target cost fields that can be mapped for two quarterly periods (there are two quantities per period).

Figure 5-2: Mapping quantity breaks and target cost per period

### How Projects Handle Revisions

Projects do not hold multiple revisions of items. Consequently, you can import preliminary, pending, and released revisions of an item into a project. If you reimport an item, it replaces the previous item in the project. This means that you can import preliminary items as well as back, current, or pending revisions to replace released or unreleased revisions in a project.

**Important**  When you reimport an item into a project, all data for the original item (such as BOMs and AMLs) are removed before the new data is imported. Therefore, you should always export complete BOMs and AMLs before updating the data and then reimporting. Also, make sure you map the **Title Block > Rev** field when you import items. Otherwise, items will be imported as an Introductory revision.
To successfully import data, you must map source fields to the target Agile PLM system. This chapter includes these topics:

- About Mapping Files
- Key Fields and Required Fields
- Selecting a Change Order and Mapping File
- Creating a New Mapping File
- Reusing a Mapping File
- Editing a Mapping File
- Mapping PDX and aXML Packages

**About Mapping Files**

When you import data into the Agile PLM system, you must indicate where to put the data. You do this in the Import wizard by mapping fields in the source data to Agile fields. Only mapped fields are imported. The Import wizard ignores any source fields that are not mapped.

Mapping files are XML files that can be reused to map data for subsequent import sessions. You can save the files locally or on a network drive. They are not stored on the Agile PLM system.

*Note* The Import wizard does not support mapping files created with previous Agile Product Cost Management or Agile Product Collaboration releases.

**Key Fields and Required Fields**

*Key fields* uniquely identify an object in the Agile PLM system. Therefore, key fields are required to import all objects, whether they are new or already exist. An example of a key field is the *Title Block > Number* field for a part. In fact, most of the key fields for Agile PLM objects are used to set the unique number for objects. When you map fields for import, all key fields in the Edit Mapping File window are shown in *blue boldface* type.
The following table lists key fields for all objects supported by the Import wizard. These fields must be mapped.

Table 6-1: Agile PLM key fields

<table>
<thead>
<tr>
<th>Object</th>
<th>Tab</th>
<th>Key Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency Conversion</td>
<td>Currency Conversion</td>
<td>Currency Code</td>
</tr>
<tr>
<td>Customer</td>
<td>General Info</td>
<td>Customer Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Customer Number¹</td>
</tr>
<tr>
<td>Declaration</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>Cover Page</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supplier</td>
</tr>
<tr>
<td></td>
<td>Item Composition</td>
<td>Item Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Substance Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Substance Type</td>
</tr>
<tr>
<td>Items</td>
<td></td>
<td>Item Number</td>
</tr>
<tr>
<td>Manufacturer Parts</td>
<td>Mfr Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mfr. Part Number</td>
<td></td>
</tr>
<tr>
<td>Manufacturer Part Composition</td>
<td>Mfr Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mfr. Part Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substance Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substance Type</td>
<td></td>
</tr>
<tr>
<td>Part Group Composition</td>
<td>Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substance Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substance Type</td>
<td></td>
</tr>
<tr>
<td>Part Groups</td>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Specifications</td>
<td>Specification</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td>BOM</td>
<td>Item Number</td>
<td></td>
</tr>
<tr>
<td>Compliance</td>
<td>Specification</td>
<td></td>
</tr>
<tr>
<td>Manufacturers</td>
<td>Mfr. Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mfr. Part Number</td>
<td></td>
</tr>
<tr>
<td>Sites</td>
<td>Site Name</td>
<td></td>
</tr>
<tr>
<td>Suppliers</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>Title Block</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td>General Info</td>
<td></td>
<td>Name</td>
</tr>
<tr>
<td>Object</td>
<td>Tab</td>
<td>Key Fields</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>Compliance</td>
<td>Specification</td>
</tr>
<tr>
<td></td>
<td>Composition</td>
<td>Composition Type$^2$</td>
</tr>
<tr>
<td></td>
<td>General Info</td>
<td>Manufacturer Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manufacturer Part Number</td>
</tr>
<tr>
<td></td>
<td>Substance</td>
<td>Substance Name</td>
</tr>
<tr>
<td></td>
<td>Suppliers</td>
<td>Supplier</td>
</tr>
<tr>
<td>Part Group</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>Compliance</td>
<td>Specification</td>
</tr>
<tr>
<td></td>
<td>General Info</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>Parts</td>
<td>Part Number</td>
</tr>
<tr>
<td></td>
<td>Suppliers</td>
<td>Supplier</td>
</tr>
<tr>
<td>Product Service Request</td>
<td>Cover Page</td>
<td>Number$^1$</td>
</tr>
<tr>
<td></td>
<td>Affected Items</td>
<td>Item Number</td>
</tr>
<tr>
<td>Project Item</td>
<td>AML</td>
<td>Mfr Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Part Number</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>BOM</td>
<td>Component Part Number</td>
</tr>
<tr>
<td></td>
<td>Items</td>
<td>Number$^1$</td>
</tr>
<tr>
<td>Published Price</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>General Information</td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Rev</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manufacturing Site</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Part Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number$^1$</td>
</tr>
<tr>
<td></td>
<td>Price Lines</td>
<td>Price Effective From Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price Effective To Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Qty</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship From</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship To</td>
</tr>
</tbody>
</table>
Table 6-1: Agile PLM key fields (continued)

<table>
<thead>
<tr>
<th>Object</th>
<th>Tab</th>
<th>Key Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quote History</td>
<td>General Information</td>
<td>Customer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Rev</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manufacturing Site</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Part Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supplier</td>
</tr>
<tr>
<td></td>
<td>Price Lines</td>
<td>Price Effective From Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price Effective To Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Qty</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship From</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship To</td>
</tr>
<tr>
<td>Specification</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>General Info</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>Substances</td>
<td>Name</td>
</tr>
<tr>
<td>Substance</td>
<td>Attachments</td>
<td>File Identifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File Name</td>
</tr>
<tr>
<td></td>
<td>Composition</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>General Info</td>
<td>Name</td>
</tr>
<tr>
<td>Supplier</td>
<td>Commodities</td>
<td>Commodity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship-To</td>
</tr>
<tr>
<td></td>
<td>General Info</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>Manufacturers</td>
<td>Continent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mfr. Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ship-To</td>
</tr>
</tbody>
</table>

Notes:
1. If you don’t map the Number field or the data is not provided in the source file, the Import wizard uses an AutoNumber source to assign a number to a new object it creates. You can set the default AutoNumber sources used by the Import wizard. For more information, see “Setting Default AutoNumber Sources” on page 8-4.

2. Composition Type determines what type of substances can be imported into the composition:
   - **Substance Composition** – Substances and substance groups can be imported.
   - **Homogeneous Materials Composition** – Subparts, materials, substance groups, and substances can be imported.
   - **Part Composition** – No substances can be imported.
In addition to key fields, Agile PLM also has *required fields*. The Agile PLM administrator can configure any field on Page One (Title Block, Cover Page, or General Information), Page Two, or Page Three of an object to be a required field. To import new objects in Agile PLM, you must complete all required fields. However, if you are importing data to existing objects, required fields don’t need to be mapped. When you map fields for import, all required fields in the Edit Mapping File window are shown in *green boldface* type.

For a full list of required Agile PLM fields, print the Agile Classes Report from the Agile Web Client.

In the following figure, the **Number** field is a key field and **Description** and **Product Line(s)** are required fields. If you are importing new parts, all three fields must be mapped. If you are importing data to existing parts, only the **Number** field must be mapped.

![Figure 6-1: Key fields and required fields](image)

Some Agile PLM objects have special mapping requirements. See the following sections for more information.

### BOM Mapping Requirements

**Title Block > Number** and **BOM > Item Number** are required fields. However, **BOM > Find Num** and **BOM > Qty** are optional key fields. If you don’t map the **BOM > Find Num** field, the BOM tab shows 0 as the find number for all imported items. If you don’t map the **BOM > Qty** field, all quantities on the BOM tab use the default quantity value set by the Agile PLM administrator.

### Quote History and Published Price Mapping Requirements

Quote histories and published prices have special mapping requirements due to the multiple required and optional key fields that can be used to import them. For more information about the minimum required fields for quote histories, published prices, and price lines, see “Importing Quote Histories, Published Prices, and Price Lines” on page 3-5.

### Mapping Classes and Subclasses

For item, BOM, and AML imports, there are two separate target classes that may need to be mapped depending on what the source file contains. If the source file contains both parts and documents, then you must map both the Parts class and Documentation class, even if the mappings are the same.
If you do not map the **Type** field for the object, or the **Type** column of a particular row is blank, then the default type for the object is used, regardless of whether the object currently exists or not. For example, if your import file contains documents, but you don’t map the **Type** field, documents could be imported as parts if that is the default item type selected in Import preferences. For items in the import file that already exist in the target system, a type mismatch rejection error occurs if the default type assumed by import does not match the existing object in the target system.

For information about how to specify default types for an import session, see “Setting Default Types” on page 8-4.

**Selecting a Change Order and Mapping File**

When the Select Change Order and Mapping File page appears in the Import wizard, you can specify a change order and select a mapping file using the following options:

- **Change Order** — If you are importing in Redlining mode (the default), click to select a change order. If you are using Authoring mode, you may optionally specify a change order. For more information about redlining, see “Using Redlining or Authoring Mode” on page 3-8.

  **Note** To change from Redlining mode to Authoring mode, click **Preferences**, select **Business Rule Options**, and change the value for the **Change Mode** field.

- **Use an Existing Mapping File** — After selecting this option, type the path of a mapping file or click **Browse** to select one. The mapping file must exist on your local system or on a network computer. Mapping files are not stored on the Agile PLM server.

- **Create a New Mapping** — After selecting this option, click **Create New Mapping** to define a new mapping file.

- **Use Currently Defined Mapping Definition** — Use a mapping definition previously selected during this import session. If you have not specified a mapping file yet, this option does not appear.

- **Use Default Mapping Definition** — Use the default field mappings for the specified file type. This option is not available for Excel files and delimited text files that do not use a predefined template format.

- **Edit Chosen Mapping** — Display the Edit Mapping File window for the selected mapping definition.

Once you select or create a mapping definition, the Import wizard stores it in memory for the current import session. After this, you can click **Import** to begin the import process, or click **Next** to select other options.

**Creating a New Mapping File**

If you are importing data from a new source, you need to create a mapping file. To create a mapping file, you select fields from the import data and map them to Agile fields.

**To create a new mapping file:**

1. In the Import wizard, proceed to the Select Change Order and Mapping File page.

2. Select **Create a New Mapping**, and then click the **Create New Mapping** button. The Edit Mapping File window appears.

   **Note** If the Edit Mapping File window has no fields, the source file may be invalid. If the source file is a delimited text file, make sure fields in the header row do not have carriage return or linefeed characters.

3. Click a field in the **Import Fields** list.

   **Note** Only one field can be selected at a time in the Edit Mapping File window. However, you can map an import field to multiple Agile PLM fields.

4. Navigate to the corresponding field in the **Agile Fields** list. Click the field to map it. An arrow appears next to the field along with the name of the import field to which it is mapped.

5. Repeat steps 3 and 4 for all fields that you want to map.

6. When you finish mapping all fields, click **Save As**. The File Download dialog box appears.
7. Select **Save this File to Disk**. Click **OK**.

8. Type the name of the file, and click **Save**.

9. Click **Finished** to close the Edit Mapping File window.

**To unmap a field in the Edit Mapping File window:**

Click **X** to the right of the mapped field.

**To show all fields in the Edit Mapping File window:**

Click **Expand All**.

**Mapping Page Two and Page Three Fields**

Only visible Agile fields can be mapped in the Edit Mapping File window. To map source fields to Page Two or Page Three fields, the Agile PLM administrator must configure those fields to be visible.

**How Fields are Sorted in the Edit Mapping File Window**

When you are importing data from a PDX package, the Edit Mapping File window displays import fields sorted in alphabetical order within each node in the package. The following figure shows how fields in a PDX package are sorted for the Item subclass.

Figure 6-2: Sorted import fields in a PDX package

When you import data from a delimited text file, the Edit Mapping File window does not sort the import fields. Instead, it displays the fields in the order in which they appear in the text file, as shown in the following figure.

Figure 6-3: Unsorted import fields in a text file

To make it easier to map fields in a text file, you may want to sort the fields in another application, such as Excel, before attempting to import the data.
Agile fields are sorted in alphabetical order by the tab on which the field appears, as shown in the following figure.

Figure 6-4: Sorted Agile fields

Reusing a Mapping File

If you routinely import data from the same source (such as PDX packages originating from the same source system), you can maintain mapping files that correctly map source fields to Agile fields.

Mapping files are flexible and are designed to be reused for subsequent import sessions. The import source data generally varies from one import session to another. However, it’s possible to reuse the same mapping file for multiple source files if the mapping file contains fields common to them. For example, if you create a mapping file that contains mappings for all PDX objects, you can reuse that particular mapping file for any PDX file, including a file that only includes one type of object, such as Items. If a target field is mapped but doesn’t exist in the import source file, the Import wizard ignores the field and doesn’t import it.

Target fields in the Agile PLM system can also change from one import session to another. For example, the Agile PLM administrator can make fields invisible that may have been used in your mapping files. When a target field is mapped but isn’t visible in the Agile PLM system, the Import wizard ignores the field and doesn’t import it.

If you rename column headings in your import source file, any mapping files that you created for that particular source file will be invalid. To successfully import the data, you need to remap all fields that have been renamed. The Import wizard ignores any mapped fields that are not found in the source file.

If the Agile PLM administrator renamed classes or attributes used in a mapping file, the Import wizard resolves target fields by referencing their internal IDs. Therefore, mapping files that reference renamed fields are still valid. The Debug Mapping Window shows a warning message for every field that the Import wizard resolves to a different name.

To use an existing mapping file:

1. In the Import wizard, proceed to the Select Change Order and Mapping File page.
2. Select Use an Existing Mapping File.
3. Type the path of the mapping file, or click Browse to select it.
   - Note After you select the file, you can confirm the field mappings by clicking Edit Chosen Mapping.
4. Click Next to continue.
Chapter 6  Mapping Import Fields to Agile Fields

Editing a Mapping File

If an import file has been modified (for example, new columns of data have been added), you need to modify its associated mapping file. Otherwise, the mapping file could be invalid for the revised data.

To edit a mapping file:

1. In the Import wizard, proceed to the Select Change Order and Mapping File page.

2. Select Use an Existing Mapping File.

3. Type the path of the mapping file, or click Browse to select it.
   
   Note  Mapping files have an XML filename extension.


   When you reuse a mapping file to import a new source file, the Import wizard ensures that the mapping file correctly matches the source data. If the mapping file has errors, an Errors/Warnings box appears at the top of the window. You can click an error or warning in the box to highlight its related field.

5. Edit the mappings.

6. Click Save As to save the file. The File Download dialog box appears.

7. Select Save this File to Disk. Click OK.

8. Type the name of the file, and click Save.

9. Click Finished to close the Edit Mapping File window.

Mapping PDX and aXML Packages

When you select Use Default Mapping Definition on the Select Change Order and Mapping File page, the Edit Mapping File window provides default mappings for core Agile fields. Custom fields are not mapped by default; you have to map those fields manually.

Only PDX and aXML elements present in the source file are assigned default mappings. For example, if the file contains only items and no other types of import data, then the Edit Mapping File window shows default mappings for item fields only. If you save the mapping file to reuse it later, you can use it only to import items.

To create a mapping file with mappings for all types of import data, make sure all objects are selected in the Select Contents to Import page of the Import wizard. That way, default mappings are assigned for all objects, regardless if all objects are contained in the selected source file.
CHAPTER 7
Creating Transformation Definition Files

If your import data originated in another system, you can use a transformation definition file to modify it for the target Agile PLM system. This chapter includes these topics:

- About Transformation Definition Files
- Required Columns and Column Headings
- Using PREFIX, SUFFIX, or REPLACE Operations
- Using Regular Expressions in the SourcePattern Field
- Replacing Blank Fields with a Default Value
- Generating a Transformation Template
- Transforming Different Types of Data
- Reusing Transformation Definition Files

About Transformation Definition Files

Source data that originates from a supplier or partner can contain incompatible data. That is, the data may be invalid or inconsistent with your company’s Agile PLM system. Before you import data, you may need to transform the values in some fields to make them compatible with the target system.

Transformation definition files are especially helpful for importing data from PDX or aXML packages. Generally, PDX or aXML packages are read-only. You cannot change the values contained in an archived file. If there are data inconsistencies in a PDX or aXML package, you must try to correct them using a transformation definition file.

A transformation definition file is a comma-delimited text file. Optionally, you can qualify text strings in the file using double-quotes ("'). The file must contain a set of required fields needed to transform import data.

Transformation definition files are optional for the Import wizard. If your source data does not need to be modified for your target system, you can skip the Select Transformation Definition File step in the Import wizard.

Every transformation that occurs during an import session is noted in the import log file.

Note The Import wizard does not support transformation definition files created with previous Agile Product Cost Management or Agile Product Collaboration releases.
**Required Columns and Column Headings**

A transformation definition file must have the following six columns:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectType Name</td>
<td>The class or subclass name on the target system, for example, Parts Class.</td>
</tr>
<tr>
<td>Property Group Name</td>
<td>The name of the group (or tab) containing the property, for example, Title Block.</td>
</tr>
<tr>
<td>Property Name</td>
<td>The name of a target field.</td>
</tr>
<tr>
<td>Operation</td>
<td>The transformation operation. Valid operations are “REPLACE,” “PREFIX,” or “SUFFIX.”</td>
</tr>
<tr>
<td>Source Pattern</td>
<td>A string to match the entire source value for the specified field. You can use regular expressions to match patterns of text. The pattern you specify is case-sensitive.</td>
</tr>
<tr>
<td>Parameter Value</td>
<td>The replacement, prefix, or suffix text used to transform the Source Pattern string.</td>
</tr>
</tbody>
</table>

**Note** You can add an optional Comments column to document each row of the file.

Optionally, you can include the following three columns: ObjectType Id, Property Group Id, and Property Id. These columns appear automatically in a transformation template that you can generate from the Import wizard. The columns are not required, but they map the ObjectType Name, Property Group Name, and Property Name columns to unique internal Agile ID numbers. The ID columns ensure the validity of the transformation definition file in the event that an Agile field name—such as the name of a custom field—changes.

**Caution!** You cannot change the column names. They must match the specified names exactly. Otherwise, the transformation definition file is invalid.

You can change the order of columns as long as you also change the respective column header. For example, you can make column A the Property Name column.

The header row (that is, the row with column names) must be the first row in the file. There should be no blank columns to the left of the first data column. For example, in an Excel file, the table should start at column A.

You can perform only one transformation per target value. This means that you cannot, for example, use a PREFIX and SUFFIX transformation on the same value. Nor can you chain transformations together in sequence to modify a value iteratively.

Transformations occur in sequential order from top to bottom in the transformation definition file. Only the first transformation for a target field's value is used; other transformations for the same value are ignored.

**Using PREFIX, SUFFIX, or REPLACE Operations**

Transformation definition files allow you to add a prefix or suffix to values, or replace values.

A PREFIX operation simply adds a specified string to the beginning of a value.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Source Pattern</th>
<th>Parameter Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>PREFIX</td>
<td>12345</td>
<td>P-</td>
<td>12345 -&gt; P-12345</td>
</tr>
<tr>
<td>PREFIX</td>
<td>1</td>
<td>P-</td>
<td>1 -&gt; P-1</td>
</tr>
</tbody>
</table>

A SUFFIX operation adds a specified string to the end of a value.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Source Pattern</th>
<th>Parameter Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUFFIX</td>
<td>12345</td>
<td>-S</td>
<td>12345 -&gt; 12345-S</td>
</tr>
<tr>
<td>SUFFIX</td>
<td>1</td>
<td>-S</td>
<td>1 -&gt; 1-S</td>
</tr>
</tbody>
</table>
A **REPLACE** operation replaces the entire value. You cannot replace a portion of a value. You also cannot replace a value with an empty string.

<table>
<thead>
<tr>
<th>Operation</th>
<th>SourcePattern</th>
<th>ParameterValue</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPLACE</td>
<td>12345</td>
<td>67890</td>
<td>12345 -&gt; 67890</td>
</tr>
<tr>
<td>REPLACE</td>
<td>1</td>
<td>Agile</td>
<td>1 -&gt; Agile</td>
</tr>
</tbody>
</table>

### Using Regular Expressions in the SourcePattern Field

When you specify values in the **SourcePattern** field of the transformation definition file, you can use regular expressions to match patterns of text. A regular expression can contain symbols or syntactic elements used to represent one or more characters.

The simplest regular expression is a literal text string, such as **IPN100012**. Any alphanumeric character in the **SourcePattern** field matches the same character in the source data.

You can also use special symbols to match text patterns in a generalized way, much like wildcards. The following table lists the regular expression symbols you can use in the **SourcePattern** field.

Table 7-2: **Regular expression symbols**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period (.)</td>
<td>Matches any single character.</td>
</tr>
<tr>
<td>Asterisk (*)</td>
<td>The preceding character appears zero or more times.</td>
</tr>
<tr>
<td>Plus (+)</td>
<td>The preceding character appears one or more times.</td>
</tr>
<tr>
<td>Question mark (?)</td>
<td>The preceding character appears zero or one time.</td>
</tr>
</tbody>
</table>

**Note** The source pattern you specify must match the entire incoming value. Otherwise, the value won’t be transformed.

Although regular expressions enhance the types of transformation you can specify, they are optional. If you don’t find them helpful, you don’t have to use them. The following table shows several examples of regular expressions.

Table 7-1: **Regular expression examples**

<table>
<thead>
<tr>
<th>SourcePattern</th>
<th>Matching values</th>
</tr>
</thead>
<tbody>
<tr>
<td>.*</td>
<td>Any value, including an empty string.</td>
</tr>
<tr>
<td>.+</td>
<td>Any value except an empty string.</td>
</tr>
<tr>
<td>A.*</td>
<td>Values that start with A.</td>
</tr>
<tr>
<td>AGILE.*</td>
<td>Values that start with AGILE.</td>
</tr>
<tr>
<td>.*AGILE</td>
<td>Values that end with AGILE.</td>
</tr>
<tr>
<td>.<em>AGILE.</em></td>
<td>Values that contain AGILE.</td>
</tr>
<tr>
<td>P0012+</td>
<td>P0012, P00122, P001222, P0012222, and so on. However, it does not match P001.</td>
</tr>
<tr>
<td>P0012*</td>
<td>P001, P0012, P00122, P001222, P0012222, and so on.</td>
</tr>
<tr>
<td>P0012?</td>
<td>P001 or P0012.</td>
</tr>
<tr>
<td>P00*20</td>
<td>P020, P0020, P00020, P000020, P0000020, and so on.</td>
</tr>
<tr>
<td>P00+.20</td>
<td>P00020, P00120, P00220, P00320, P00123456789020. However, it does not match P020.</td>
</tr>
</tbody>
</table>
Replacing Blank Fields with a Default Value

You can use a transformation template to provide default values for blank fields in your source file that have been mapped. This is a particularly handy use for transformation templates. For example, if the Product Line(s) field is blank in your source data, you can still map the field and set it to import a default product line value for your Agile PLM system.

Remember, you must map the empty field you want to replace with a default value. Otherwise, the Import wizard skips the unmapped field.

Use the following SourcePattern string to represent an empty field: `^$` (the caret and dollar sign characters). The ParameterValue you specify must be a valid value for the specified field.

The following figure shows how to replace all empty Product Line(s) fields in the source file with a default value Ultra.

Figure 7-1: Replacing empty Product Line(s) fields with a default value

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Parts Class</td>
<td>Title Block</td>
<td>Product Line(s)</td>
<td>REPLACE ^$</td>
<td>Ultra</td>
<td>If the Product Line(s) field is empty, set it to Ultra</td>
</tr>
</tbody>
</table>

Generating a Transformation Template

The Import wizard lets you generate a transformation template, a comma-delimited text file that has the appropriate fields for the target Agile PLM system.

To create a transformation template:

1. From the Select Transformation Definition File page of the Import wizard, select Apply Transformations.
2. Click Download Transformation Template. The File Download dialog box appears.
3. Save the file to your local computer.
4. In the popup Download Transformation Template window, click OK.

The default transformation template filename is TransformTemplate.csv. It is a comma-separated file that can be edited in a text editor or spreadsheet program.

After you create a transformation template, fill in the following columns:

- **Operation**
- **SourcePattern**
- **ParameterValue**

The Import wizard skips lines in the transformation definition file that don’t have an operation defined. If you specify an operation in a row, you must also specify a source pattern and parameter value in that row.

The Comments column is optional and is used to document each transformation. The three rightmost columns, ObjectTypeid, PropertyGroupId, and PropertyId, should not be edited. They show the internal Agile PLM ID numbers for each field.

Transforming Different Types of Data

Depending on the fields you are trying to transform and their data types, there are different transformation considerations. This section describes issues involved in transforming item numbers, manufacturer names, and product lines.
The following topics describe how you can use transformation definition files to modify different types of import data to make it valid for your Agile PLM system:

- Transforming Item Numbers
- Transforming MultiList Values
- Transforming Manufacturer Names
- Transforming AML Data

Note If you are importing attachments from an aXML file or a PDX package, you cannot use a transformation definition file to modify attachment filenames.

Transforming Item Numbers

In the Agile PLM system, the Title Block > Number field uniquely identifies an item. Similarly, the BOM > Item Number field identifies a component part of an assembly. The same item number can be used for both fields.

If you are importing bills of material and you are transforming Title Block > Number values for items, you should also use the same transformation for the BOM > Item Number field.

Do not specify a blank ParameterValue. Remember, the Import wizard skips blank fields.

The following figure shows an example of a transformation definition file that modifies the values for both the BOM > Item Number and Title Block > Number fields, adding a prefix to each item number.

Figure 7-2: Transforming item numbers

Transforming MultiList Values

Although the value for a MultiList field is displayed as a comma-delimited string, the Agile PLM system validates the string against the full list of values. To transform values for a MultiList field, you specify source and target values for each individual list value, not for the entire delimited string of values.

The Product Line(s) field for items is an example of a MultiList field. To import a value into a MultiList field, the value must be a comma-delimited string. (You can click the Preferences button in the Import wizard to specify another character, such as a semicolon, for the MultiList delimiter.) For example, a Product Line(s) value might look like this:

“Analog, Tools, Memory”

Suppose you want to change these individual values to “Analog & Interface Products,” “Development Tools,” and “Memory Products,” respectively. You can specify a simple REPLACE operation for each value in the transformation template, as shown in the following figure:

Figure 7-3: Transforming MultiList values

Important Product Line(s) values, like all Agile lists, are case-sensitive.
Transforming Manufacturer Names

If you are importing approved manufacturers lists, manufacturers, or manufacturer parts, it is possible that the manufacturer names in the source data do not match exactly the manufacturer names used in the Agile PLM system. Any difference in manufacturer names, however slight, should be corrected using a transformation definition file. If you do not transform invalid manufacturer names, you can end up with multiple objects representing the same manufacturer, such as CPQ and Compaq.

The following figure shows a transformation definition file that modifies manufacturer names when you import manufacturers. There are six different manufacturer names in the source file: CPQ, DELL, FLEX, MARSHALL, SLCTRGN, and TI. The transformation definition file specifies the six replacement values for these names.

![Figure 7-4: Transforming manufacturer names](image)

Here is a similar transformation definition file that modifies the manufacturer names in an AML.

![Figure 7-5: Transforming AML manufacturer names](image)

Transforming AML Data

If you are importing AML data from a PDX package, and you are using a transformation definition file, you should include the same transformations for fields in related objects (Manufacturer Part Number, Manufacturer Name) so that the corresponding attributes for AML rows, manufacturers, and manufacturer parts will have the same values.

Reusing Transformation Definition Files

You can maintain a transformation definition file that correctly transforms data for all types of import data. You may also find it helpful to create a transformation definition file for each manufacturer, as your manufacturers may use different conventions for entering product data.

**Note** Make sure you give recognizable names to transformation definition files so that they can easily be associated with a particular manufacturer or an Agile PLM system. Otherwise, you may use the wrong transformation definition file and modify the import data the wrong way.

**To use an existing transformation definition file:**

1. From the Select Transformation Definition File page of the Import wizard, select **Apply Transformations**.
2. Type the path of the transformation definition file, or click **Browse** to select it.
3. Click **Next** to continue.
You can configure the Import wizard by setting preferences. This chapter includes these topics:

- About Preferences
- Setting Parsing and Validation Options
- Setting Business Rule Options
- Setting Default Types
- Setting Default AutoNumber Sources

### About Preferences

The Import wizard has several preference settings that you can set from any step in the wizard. These preferences set how the Import wizard behaves. Import wizard preferences persist during the current Agile PLM client session, but they are not permanently saved with each user’s profile.

**To set import preferences:**

1. Click the **Preferences** button in the bottom left corner of the Import wizard. The Specify Preference Settings window appears.
2. Select one of the following preferences groups from the list: Parsing and Validation Options, Business Rule Options, Default Types, or AutoNumber Sources.
3. Select preference settings, then click **OK**.

### Setting Parsing and Validation Options

When you select the **Parsing and Validation Options** preference group, the following options appear:

- **Log Transformations**
  - The **Log Transformations** checkbox sets whether to record all value transformations in the import log file. If you are importing an extremely large file, uncheck the Log Transformations box to achieve faster results.

- **Multilist Delimiter Character**
  - The **Multilist Delimiter Character** list specifies the character used in the import file to delimit values for MultiList fields. You can select a semicolon (the default), a comma, or a vertical bar.

- **Cascade Delimiter Character**
  - The **Cascade Delimiter Character** list specifies the character used in the import file to delimit values for cascading list fields. You can select a vertical bar (the default), a comma, or a semicolon.

- **Whitespace Validation Action**
  - The **Whitespace Validation Action** preference sets how the Import wizard handles a value with whitespace characters (space, linefeed, newline, or tab) in a field that does not allow them. Select Rejected (the default) to reject the value or Strip to remove the whitespace characters.

- **Case Validation Action**
  - Some Agile fields can be configured to require upper case or lower case values. The **Case Validation Action** preference sets how the Import wizard handles a value that has the wrong case for a field. Select Convert (the default) to convert the value to the proper case or Reject to reject the value.
When you select the **Business Rule Options** preference group, the following options appear:

### Length Validation Action

The **Length Validation Action** preference sets how the Import wizard handles a value that exceeds the maximum length for a field. Select Reject (the default) to reject the value or Truncate to remove any characters from the value that exceed the maximum length.

### Setting Business Rule Options

SmartRules are systemwide settings that govern the Agile Application Server’s behavior. The Agile PLM administrator can modify these settings to customize the system’s change control process. When you use the Import wizard, SmartRules can generate warnings about actions you are not supposed to perform. You can set a preference for how the Import wizard handles these warnings.

The **SmartRules Warning Violation Behavior** preference applies only to the following SmartRules that have been set to Warning in the Agile Java Client. It does not apply to SmartRules that have been set to other values, such as Allow or Disallow.

- DuplicateFindNumbers
- DuplicateItemNumbers
- DuplicateRefDes
- MultipleItemsPerManufPart
- Overlap Price Line Effectivity Periods

Objects that violate other SmartRules set to Warning are accepted by the Import wizard, and the warning is ignored. All objects that violate SmartRules set to Disallow are rejected by the Import wizard.

If you select Reject Objects (the default), any object that triggers a SmartRules warning is rejected. If you select Accept Objects, SmartRules warnings are logged but the objects are imported.

### Change Mode

The Import wizard lets you import items, BOMs, and AMLs, prices, and price lines in Redlining or Authoring mode.

In Redlining mode, the default setting, the Import wizard uses the redlining process to update BOM, AML, and price lines rows. Any fields that have changed are highlighted in red. A change order is required regardless of the revision state. Redlining mode is required to import data to any item or price with a pending change or a released revision.

In Authoring mode, the Import wizard does not use the redlining process to update BOM, AML, and price lines rows. It therefore doesn’t require a change order. Authoring mode is useful if you are importing data to preliminary items and you don’t want to roll the revision.

**Note:** If you select Authoring mode, you can still specify a change order in the **Change Number** field. If you specify a change order, items with a pending change or a released revision are redlined and are added to the Affected Items tab of the change order. If you don’t specify a change order, the Import wizard rejects any items that have a pending change or a released revision.

### Change Number

The **Change Number** preference allows you to specify a change order for this import session. The change order is used to redline any items or prices that have a pending change or a released revision.

**Note:** If you selected Redlining for the **Change Mode** preference, a change number is required.
Redline Mode Behavior  
The Redline Mode Behavior preference allows you to determine which items get added to the Affected Items tab of a change when you import them in Redlining mode. You can choose to add all items to the change, add only new items, or add new items and existing items that require redlining.

Select one of the following options:

- **New/Existing items onto the change** (default) — adds new items and existing items that have been redlined to the Affected Items tab of the change. Any existing items contained in the import data that have not been redlined are not added to the change.

- **All items onto the change** — adds all items listed in the import data to the Affected Items tab of the change, regardless whether the items are new or whether they have been redlined.

- **New items only onto the change** — adds only new items to the Affected Items tab of the change. Existing items, whether they have been redlined or not, are not added to the change.

**Note:** BOM and AML fields can be redlined, as well as Title Block fields that are under change control, such as **Title Block > Description**, **Title Block > Lifecycle Phase**, and **Title Block > Rev.**

BOM & AML Import Behavior  
The BOM & AML Import Behavior preference specifies the behavior to use when importing BOMs and AMLs. You can import all items (including BOM components) or only items that have BOMs or AMLs.

Select one of the following options:

- **Import assys, amls, and components** (default) — imports all items, including BOM components.

- **Only import assys and amls** — imports only items that have BOMs or AMLs. BOM components are not imported.

Multi Row Update Mode  
The Multi Row Update Mode preference determines how source data should be used to update the target tables such as BOMs, AMLs, and price lines. You can choose “Complete Replace” (the default) or “Add/Update Only.” If you choose “Complete Replace,” the target data is completely replaced with the source data. Any rows in the target data that don’t appear in the source data are deleted. If you choose “Add/Update Only,” new rows in the source data are added and existing rows are modified but no rows are deleted. The “Add/Update Only” setting is helpful if you want to import partial BOM, AML, or price lines data.

Price Quantity Break Default  
A price object has a General Information field named Allow Qty Breaks that determines whether prices are broken out by different quantities. If the Import wizard automatically creates a new price object during the import of price lines, it sets the value of the Allow Qty Breaks field based on the **Price Quantity Break Default** preference.

If you want to allow quantity breaks for new price objects created by the Import wizard, select Yes. Otherwise, select No (the default).

**Note:** You can’t change the Allow Qty Breaks setting for an existing price object. You can only set its value for a new price.

Reference Designator Range Character  
Select either Hyphen (-) (the default), Backward Slash (\), Forward Slash (/), or Vertical Bar (|). The range character separates reference designator values that expand to a sequence of values. For example, R4-R6 expands to R4, R5, R6.

If you are importing BOMs from a PDX package or an Agile XML (aXML) file, the reference designator range character must be a hyphen.

For more information about reference designators, see “Using BOM Reference Designators” on page 2-9.

Reference DesignatorDelimiter Character  
Select either Comma (,) (the default), Semicolon (;), or Vertical Bar (|). The delimiter character separates reference designator values that don’t need expansion, for example: R1, R2, R3.

If you are importing BOMs from a PDX package or an Agile XML (aXML) file, the reference designator delimiter must be a comma.
**Setting Default Types**

To create a new object on the Agile PLM system, you must specify the subclass of the object. Every Agile PLM system can be configured to have different subclasses. To simplify the importing of new objects, you can specify the default subclass to use for each object type that can be imported. If the subclass is not specified by one of the mapped fields (such as **Parts Class > Title Block > Part Type**), the Import wizard creates the new object using the default type.

The default type is also used when the Import wizard automatically creates parent items for BOMs, AMLs, and price lines.

**To set default types for the Import wizard:**

1. Click the **Preferences** button in the bottom left corner of the Import wizard. The Specify Preference Settings window appears.
2. Select **Default Types**.
3. Specify default subclasses for each object type, and then click **OK**.

**Setting Default AutoNumber Sources**

An AutoNumber source is a predefined, consecutive number series used to automatically number objects for many Agile classes. The Import wizard uses AutoNumber sources to assign numbers to new objects it creates when the **Number** field is either not required or not provided in the source data. When the Import wizard automatically creates published prices, quote histories, activities, gates, customers, and suppliers, it uses the selected AutoNumber sources to number objects. For example, if you are importing new customers with source data that includes only the customer name, the Import wizard assigns a number to each customer using the default AutoNumber source for the customer class.

---

**Note** The Agile PLM administrator can define new AutoNumber sources using the Agile Java Client.

**To set default AutoNumber sources for the Import wizard:**

1. Click the **Preferences** button in the bottom left corner of the Import wizard. The Specify Preference Settings window appears.
2. Select **AutoNumber Sources**.
3. Specify default AutoNumber sources for each class, and then click **OK**.
After your import session is finished, you can do several things to ensure that the data was imported successfully. This chapter includes these topics:

- Checking the Status of Your Import Session
- Canceling an Import Operation
- Reading the Import Log
- Troubleshooting

Checking the Status of Your Import Session

If you are importing a large amount of data, the Import wizard may take a while to process the data. As it processes records, it keeps a running count of records that were imported or rejected. It also displays messages related to each object that it processes.

When all the data for an import session has been processed, the Import wizard formats the warning and error messages into a log that you can read onscreen or save to a file.

Canceling an Import Operation

When you click Import in the Import wizard, the wizard begins to import the data. You can cancel the import operation at any time.

To cancel a running import operation:

1. From the Import Status page, click Cancel.
2. A message box appears that reads “Cancel running import operation? All unsaved data will be lost.”
3. Click OK. The Import Summary Report page appears.

When you cancel an import operation, any data that was already imported by the time you clicked Cancel remains in the database. Also, data is imported in batches, and the Import wizard finishes importing the current batch before the import operation stops as a result of cancellation. The Records Processed section of the Import Summary Report page shows how many objects were accepted, as shown in the following figure.

Figure 9-1: Records processed section showing Accepted records
Reading the Import Log

When you click Import in the Import wizard, the Import Server starts to process the data. When it finishes processing the data, it displays a log, which includes the following sections:

- **Time Information** — Shows the duration of the import session.
- **Records Processed** — Shows how many records were imported to the Agile PLM system and how many were rejected.
- **Message Summary** — Shows messages generated for each object.

To print the log file:

Right-click the message summary, and choose Print.

To save the import log to an XML file:

2. Select Save This File to Disk. Click OK.
3. Type the filename, or use the default filename: LogFile.xml. Click Save.

Note LogFile.xml is an XML file, which is not ideal for viewing in most applications. You can use your own XSL templates to create custom reports from the log file. In addition to errors and warnings, the log file also contains other information that may be useful to Agile Customer Support. For example, it contains the mapping file used during the import session.

To save the import log to an HTML file:

1. Right-click the Import Summary Report page, and choose View Source. The HTML source for the page appears in Notepad.
2. Choose File > Save As to save the HTML file.

To return to the Web Client or Java Client:

Click Done.

Troubleshooting

If you have problems importing data into the Agile PLM system, read this section for help.

Common Error Messages

The following table provides additional information about common error messages you may encounter when you try to import data into the Agile PLM system.

<table>
<thead>
<tr>
<th>Problem Area</th>
<th>Error Message</th>
<th>Cause</th>
</tr>
</thead>
</table>
| General      | Could not import record because key fields within the import data are blank. | This error can occur for a couple reasons:  
  - The mapping file is wrong. Key fields must be mapped.  
  - The source file is tab delimited, but the Import wizard field delimiter is set to comma. |
| General      | Could not convert value 'text' into the appropriate datatype (java.lang.Double). | You tried to import a text value into a numeric field. |
| Text values  | [Character Set Name(s)] character sets are valid for [AttributeName] field. | A text value you are trying to import contains one or more characters that are invalid for the field’s character set(s). |
Importing Blank Fields

When you use the Import wizard, it cannot perform a destructive operation. Existing Agile data is always preserved, never destroyed. Therefore, you can’t import a blank value to a non-empty Agile field. The Import wizard ignores blank source fields.

**Note** A transformation can be applied to source data to change blank values into nonblank values.

Mapping All Required Fields

To import data for an object, you must always map all required fields, even if you are importing data to an existing object. This includes required fields on Page Two and Page Three. If you are trying to update a BOM table for an item, you may not want to update required fields that have already been entered on Page Two and Page Three. In such a case, you can map the Page Two and Page Three required fields to blank columns in your source data. As mentioned above, the Import wizard ignores blank source fields.
Configuring Parent/Child Fields

Several fields have a child relationship with other parent fields. Child fields derive their values from parent fields. The administrator of the Agile PLM system must ensure that parent/child fields are configured identically for the system to work properly.

An item’s Title Block.Rev field and a change order’s Affected Item.New Rev field are perfect examples of parent-child fields. The Agile PLM administrator must ensure that both these fields are configured identically. Otherwise, problems could occur when you import data. For example, if you set the Title Block.Rev field to include all characters, you cannot set the Affected Items.New Rev field to include only “Alpha Upper Case” characters. Otherwise, problems will occur when you import items in Redline mode.

Another example of parent/child fields are the Title Block.Number field for an item and the Affected Items.Item Number field for a change. If these fields are configured differently, you may experience problems importing items.

Importing Supplier Offerings

When you import supplier offerings, the Import wizard determines if a rating exists based on either the Ship-To location or the geographical values. It does this by checking the status of the supplier before importing the source file. If the source file has conflicting offerings, you may see unexpected results. Here’s an example:

Suppose an existing supplier named ACME has no commodity offerings. On the Agile PLM server, the defined Ship-To locations include San Jose and Milpitas. Let’s say you attempt to import a source file with two offerings:

Figure 9-2: Source data for supplier commodity offerings

<table>
<thead>
<tr>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commodity Continent</td>
<td>Ship-To</td>
<td>Rating</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>North America</td>
<td>San Jose</td>
<td>Approved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>United States</td>
<td>Milpitas</td>
<td>Active</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Import wizard creates the first offering based on its geographical values. The second offering is rejected because the Ship-To location San Jose is covered by the first offering’s region, California. Remember, you cannot create an offering with a location already covered by a broader offering. The end result is that one broad offering and two ratings are created. The ratings for San Jose and Milpitas, which are located in the California region defined by the offering, both have a value of “Approved.”

Workaround: To import different ratings for offerings located in the same geographical region, import the offerings and their ratings in two separate import operations.

Managing SmartRules

The Agile PLM server checks for SmartRule violations after each row of a table is updated, not after the entire table is updated. This can cause problems if you are importing BOM, Manufacturers, or Price Lines tables in Redline mode and have set the Multi Row Update Mode preference to “Complete Replace.” In such situations, you want to update the entire table before validating it.

Workaround: To avoid SmartRule problems in import, the Agile PLM administrator should use the Agile Java Client to set the following SmartRules from “Disallow” to “Warning”:

- DuplicateFindNumbers
- DuplicateItemNumbers
- DuplicateRefDes
- MultipleItemsPerManufPart
- Overlap Price Line Effectivity Periods
In the Import wizard, set the Smart Rules Warning Violation Behavior preference to “Accept Objects.” That setting allows you to import objects that would otherwise trigger a SmartRules warning.

**Updating Pending or Released Items and Prices**

If you are importing pending or released items and prices in Authoring mode (instead of Redline mode), don’t specify a change order (ECO or PCO) if you are importing only items or prices AND you are not updating any fields related to change control. If you are updating any fields related to change control, such as Title Block.Lifecycle Phase, you must specify a change order to import the object.

**How Import Handles Duplicate Records**

For performance reasons, the Import wizard groups records into batches of 100 that it sends to the server for processing. When the server finishes processing a batch, the client sends the next batch of 100 records to the server. The Import wizard does not reject duplicate records, whether they are contained within one batch or in different batches. If a duplicate record is encountered within the same batch, it is combined with the earlier matching record and counted as only one object. If a duplicate record is encountered in two different batches, the count of imported records is incremented by one.
CHAPTER 10
Exporting Data

This chapter describes how to export Agile data to text files or PDX files. It contains the following topics:

- About the Agile Export Wizard
- Export Roles and Privileges
- Object Classes that Can Be Exported
- Export File Formats
- Starting the Export Wizard
- Export Wizard Steps
- Specifying Filters
- Specifying a Header
- Downloading the File
- Viewing an Exported File
- Exporting Search Results

About the Agile Export Wizard

Agile PLM provides a simple Export wizard that lets you extract data from selected objects and export it to a Microsoft Excel file, a comma-delimited (CSV) text file, or a PDX package. You can launch the Export wizard from either the Agile Web Client or the Java Client. Exporting data is an easy process. After downloading the export file to your desktop, you can either email or FTP it to a supply chain partner or import it into another application.

Note  PDX packages can be viewed or imported only with PDX-enabled applications. Agile provides a free PDX viewer called Agile eXpress.

Export Roles and Privileges

To use the Export wizard, you must have the Export privilege. The Export privilege is included with the following provided roles:

- (Restricted) Material Provider
- Change Analyst
- Compliance Manager
- Content Manager
- Item Content Manager
- Price Administrator
- Price Manager
Object Classes that Can Be Exported

The following table lists the types of objects that the Export wizard allows you to export.

Table 10-1: Object classes that can be exported

<table>
<thead>
<tr>
<th>Base Class</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Parts</td>
</tr>
<tr>
<td></td>
<td>Documents</td>
</tr>
<tr>
<td>Manufacturers</td>
<td>Manufacturers</td>
</tr>
<tr>
<td>Manufacturer Parts</td>
<td>Manufacturer Parts</td>
</tr>
<tr>
<td>Prices</td>
<td>Historical Quotes</td>
</tr>
<tr>
<td></td>
<td>Published Prices</td>
</tr>
<tr>
<td>Changes</td>
<td>Change Orders (ECOs)</td>
</tr>
<tr>
<td></td>
<td>Change Requests (ECRs)</td>
</tr>
<tr>
<td></td>
<td>Deviations</td>
</tr>
<tr>
<td></td>
<td>Manufacturer Orders (MCOs)</td>
</tr>
<tr>
<td></td>
<td>Price Change Orders (PCOs)</td>
</tr>
<tr>
<td></td>
<td>Site Change Orders (SCOs)</td>
</tr>
<tr>
<td></td>
<td>Stop Ships</td>
</tr>
<tr>
<td>Declarations</td>
<td>Homogeneous Material Declarations</td>
</tr>
<tr>
<td></td>
<td>Part Declarations</td>
</tr>
<tr>
<td></td>
<td>IPC 1752-1 Declarations*</td>
</tr>
<tr>
<td></td>
<td>IPC 1752-2 Declarations*</td>
</tr>
<tr>
<td></td>
<td>JGPSSI Declarations’</td>
</tr>
<tr>
<td></td>
<td>Substance Declarations</td>
</tr>
<tr>
<td></td>
<td>Supplier Declarations of Conformance</td>
</tr>
<tr>
<td>Part Groups</td>
<td>Commodities</td>
</tr>
<tr>
<td></td>
<td>Part Families</td>
</tr>
<tr>
<td>Specifications</td>
<td>Specifications</td>
</tr>
<tr>
<td>Substances</td>
<td>Materials</td>
</tr>
<tr>
<td></td>
<td>Subparts</td>
</tr>
<tr>
<td></td>
<td>Substance Groups</td>
</tr>
<tr>
<td></td>
<td>Substances</td>
</tr>
</tbody>
</table>

* This Declaration class has special export and import commands provided that let suppliers integrate the data with other Agile PLM systems or complete the compliance request form in other clients, such as Microsoft Excel or Adobe Reader. See “Using Special Export and Import Commands to Complete Declarations” on page 3-12.
Export File Formats

You can export Agile PLM data to Microsoft Excel, comma-delimited text file (CSV), or PDX package formats. The following table lists the objects that can be exported for each format.

Table 10-2: Objects that can be exported to Microsoft Excel, CSV, and PDX file formats

<table>
<thead>
<tr>
<th>Object</th>
<th>Excel</th>
<th>CSV</th>
<th>PDX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manufacturers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Manufacturer Parts</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Changes</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Prices</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Declarations</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Commodities</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Specifications</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Substances</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

In addition to text data, PDX packages can also contain attachment files and redlines.

Note CSV files created by the Export wizard contain additional header information that cannot be imported using the Agile PLM Import wizard. To import data from these files into Agile PLM, make sure you set the header row correctly in the Import wizard’s Delimited Text File Configuration dialog box.

Guidelines for Exporting to Microsoft Excel Files and Text Files

When you export data to a Microsoft Excel file, you end up with a single worksheet. When you export data to a text (CSV) file, you end up with a file of comma-delimited data. Both file types can be opened in Microsoft Excel to see the data in cell format.

Keep these guidelines in mind as you export data to Microsoft Excel files and text files using the Agile Web Client:

- You can export a single object or multiple objects. Each object’s tab is a separate delimited text output, placed one after the other in the text file. If you export multiple objects, they are added to the export file one after the other.
- You can export only the information that appears on the tabs of the included objects. So, for example, if you export a single part with a BOM, the resulting file includes information on the part’s BOM tab, but it does not include actual BOM items.
- You cannot add deleted objects, objects for which you don’t have appropriate privileges, or objects that are already in the export file.
- You can export Attachments tab information to a text file, but you cannot export the actual attachments. Only PDX files support actual attachments.
- You can export the Sites tabs of items and the Where Used tab of items, manufacturers, and manufacturer parts. PDX packages do not support these tabs.
- If you select Manufacturers Tab when filtering items, and you select BOM Items, All Levels for the BOM, your export file will include the AML information for all levels of the BOM.
- If you include both BOM and AML data in your export file, the AML data is interlaced with the BOM data in the resulting file.
About PDX Packages

Product Data Exchange (PDX) packages contain product content, such as item or change details, plus BOM data, manufacturer information, drawings, and other attached files. They differ from Agile package objects in that they are XML-based documents that conform to the PDX 1.0 standard. PDX packages are based on an industry-standard format for encoding structured data in an XML format. This standard provides an application-independent way to describe product content.

PDX packages can be used to send data from one Agile system to another. In addition, users can download PDX packages to their desktops, email or FTP the PDX packages, or import them into a PDX-enabled application. They can be viewed and modified using Agile eXpress.

For more information about PDX, including a link to the DTD, see following Web page: http://webstds.ipc.org/2571/2571.htm

The information in each PDX package is secure because all data that flows between the user, the Agile Web Client, and Agile servers is encrypted (where legal), and supply chain partners cannot view the contents of each other’s PDX packages. Login, Discovery, and Read privileges can be set in Agile Administrator to protect partners’ information from access by unauthorized users. (In the Agile Web Client, you can’t view PDX packages at all, only create them.)

Guidelines for Exporting to PDX Packages

Keep these guidelines in mind as you export data to PDX packages using the Agile Web Client:

- You must have the Export privilege to export data to PDX packages.
- You cannot add deleted objects, objects for which you don’t have appropriate privileges, or objects that are already added to the Objects To Extract table.
- The Agile Web Client supports direct access to latest released revisions of items. It also lets you access back revisions or pending revisions.
- If you export Change objects, you can use a custom filter to export redline changes to BOMs and AMLs of affected items. See “Exporting Redline BOMs and AMLs for Affected Items” on page 10-7.
- PDX packages include Sites and Where Used tab information, but they are exported as additional attributes, without their own element tags like <sites> or <whereUsed>.
- If you choose PDX export, the Compliance tab of items and manufacturer parts is not exported.
- Agile eXpress does not support the Sites tab of items or the Where Used tab of items, manufacturers, or manufacturer parts.

Starting the Export Wizard

You can start the Export wizard from either the Agile Web Client or Java Client using one of the following methods:

Java Client

- Open an object to export, and then choose Tools > Export.

Web Client

- Choose Tools > Export.
- Open an object to export, and then choose Actions > Export.
- Search for objects that can be exported, select one or more objects on the Search Results page, and then choose Tools > Export.

Note You can also export data directly from the Search Results page after running a search. See “Exporting Search Results” on page 10-8.
Export Wizard Steps

This section describes all Export wizard steps, although most are optional. You can choose to download the export file at any step without completing the remaining steps.

To export data to a file:

1. Start the Export wizard. See “Starting the Export Wizard” above.
   The Objects to Extract page appears. If you started the Export wizard from Actions > Export or after selecting objects in search results, some objects are already listed on this page.

2. In the Export To field, use the drop-down list to specify whether you want to export to a PDX package or a text file.

3. In the Site field, select a site. To export data for all sites, select All.
   - Note  The Site field is unavailable if your Agile system does not include the Sites server license.

4. If you don’t need to add any more objects to the list, proceed to step 6. To add more objects, click Add.
   The Identify Items page appears.

5. Search to find appropriate objects.

6. Click Finish to add the objects to the export file.

7. Adjust values in Revision column, if necessary.

8. When you have found and added all objects to include in the export file, click Next to display the Select Filters page.

9. Filters let you specify which information is added to the export file. For details about filters, see “Specifying Filters” on page 10-5.
   - To use predefined filters, select Saved Filters and then select the filters you want to use from the drop-down lists. To see the details of the filters, click .
   - To define a custom filter for this operation, select Customize; the wizard will step you through filter definitions for each object type in the file.

10. Click Next to proceed from the Select Filters step.

11. If you selected Customize, on each Filter page, select the information to include in the file, and click Next to proceed to the Define Header page.

12. Enter the file type and description, then click Next. (If you are exporting to a text file, header information appears at the top of the file.)
   The Summary page appears.

13. Review the contents of the export file.

14. When everything is complete, click Export to compile and download the export file.
   - If you are exporting to a text file, the Export wizard prompts you to choose an encoding type so that the export file displays correctly. Choose one from the drop-down list (the default is Unicode), and then click Continue.

15. Click Save to save the file to your computer.

16. Click Close to close the File Download window.

17. Click Exit to close the Export wizard.

Specifying Filters

Filters let you specify which information is added to the export file. You can use saved filters, defined by your Agile administrator, or you can create custom filters.
Using Saved Filters

When you select Saved Filters in the Select Filters step of the Export wizard, you can select from lists of defined filters for all supported object types. These filters are defined by the Agile administrator using the Agile Java Client. For more information, see the “Agile Content Service Settings” chapter in the Agile PLM Administrator Guide.

To see the details about the selected filter, click the corresponding button. If you select the Saved Filters option, but you do not select filters to use, the Export wizard uses the default customized filters. See “Default Custom Filters” on page 10-6 for information.

For items and changes, only filters for the superclasses (Item and Change) are included in the Export filter lists. Any filters defined specifically for classes—for example, part, document, ECO, and MCO—are not included in the Export filter lists. This means that, for example, if your export file includes an ECO and an ECR, the Change filter selected applies to both of the objects. Likewise, if your export file includes a part and a document, the Item filter selected applies to both of the objects.

BOM Filters

When you choose to include BOM information in the export file, you specify the level of BOM information to include from the following options:

- **Tab Only** (saved filters, set by the Administrator) or **BOM Tab** (custom filters) – For PDX and CSV formats, includes the information in the BOM tab itself, with only references to the items on the BOM tab (first level only). If this BOM option is the only one selected, the BOM items themselves are not included.

- **Tab and Items, First Level** (saved filters, set by the Administrator) or **BOM Items, First Level** (custom filters) – For PDX format, includes the items on the first level of the BOM. Does not include child components of subassemblies. For CSV format, includes references to the items on the first level of the BOM tab, but does not include the items themselves.

- **Tab and Items, All Levels** (saved filters, set by the Administrator) or **BOM Items, All Levels** (custom filters) – For PDX format, includes all items in all levels of the BOM. For CSV format, includes references to the items on all levels of the BOM tab, but does not include the items themselves.

Creating Custom Filters

Custom filters let you specify the particular tabs to export for each type of object you’ve selected.

**To create a custom filter:**

1. On the Filters page of the Export wizard, click Customize.
2. Click Next.
3. Subsequent wizard pages appear for each type of object selected. For each type of object, click the checkboxes for information to include in the export file, and then click Next.
   
   **Note** To use the default custom filters, click Next on each filter page.

Default Custom Filters

The default custom filters are the same as those that are used if you choose Customize and then proceed through each filter step without changing the settings.

If you create an export file without specifying the content filters to use, the Export wizard follows these guidelines:

- If you download the export file in step 1 of the wizard, the content to be exported is filtered according to default custom filters.
If you download the export file in step 2 of the wizard, content is filtered according to the selection made in that step. In this case, if you select **Customize**, but you don’t then proceed through the steps that define those filters, Export uses the default custom filters. If you select **Saved Filters**, but you do not select filters to use, the Export wizard uses the default custom filters.

If you use the default custom filters, the export file contains the following information:

- **Items** – Title Block tab, Page Two, Page Three, BOM tab (and all levels of BOM items), Manufacturers tab (and manufacturer parts on that tab if the export file is a PDX package), Item Prices, Sites tab (if the export file is a text file), and Attachments tab (and attached files, if the export file is a PDX file).
- **Manufacturer parts** – General Info tab (and the manufacturer on that tab, if the export file is a PDX package), Page Two, Page Three, Attachments tab (and attached files, if the export file is a PDX file).
- **Manufacturers** – General Info tab, Page Two, Page Three, Attachments tab (and attached files, if the export file is a PDX file).
- **Changes** – Cover Page tab, Page Two, Page Three, Affected Items tab (and the items on that tab, if the export file is a PDX file), Attachments tab (and attached files, if the export file is a PDX file).
- **Prices** – General Info tab, Page Two, Page Three, Price Lines, Attachments tab.
- **Substance** – General Info tab, Page Two, Page Three, Composition, Attachments tab.
- **Declaration** – Cover Page tab, Items, Page Two, Page Three, Item Bill of Substances, Manufacturer Parts, Manufacturer Part Bill of Substances, Part Groups, Part Group Bill of Substances, Compliance, Attachments tab.
- **Specifications** – General Info tab, Page Two, Page Three, Substances, Attachments tab.
- **Part Groups** – General Info tab, Page Two, Page Three, Parts, Compliance, Suppliers, Attachments tab.

### Exporting Redline BOMs and AMLs for Affected Items

If you choose the PDX export format, an additional filtering option is available when you export Change objects: **Redline Changes Only**. This option allows you to export the redline BOM and AML tables for any affected items. The exported PDX file could then be used to communicate BOM and AML changes to supply chain partners.

This feature is targeted for ERP adaptors that are designed to process deltas. Agile Content Service (ACS) can be used to send the exported PDX file to an ERP adaptor.

To export redline BOMs and AMLs:

1. Open a Change object (such as an ECO).
2. Choose **Actions > Export**.
3. Select **PDX** as the export format. Click **Next**.
4. On the Filters page of the Export wizard, click **Customize**. Click **Next**.
5. On the Filter Changes page, make sure both the **Affected Items Tab > Affected Items** and the **Redline Changes Only** boxes are checked.
   
   **Note**  If you check the **Redline Changes Only** box without checking the **Affected Items** box, affected items as well as the redline tables are not exported.
6. Click **Export**.

### Specifying a Header

On the Define Header page of the Export wizard, you can specify optional header information that describes the export file. Enter values in the **Type** and **Description** fields. The **Creator** field is filled automatically with your name.
**Downloading the File**

You can choose to download the export file at any step of the Export wizard without completing the remaining steps. If you didn’t specify filtering information before downloading the export file, see “Default Custom Filters” on page 10-6 for information on the default filters that are used.

**To download the export file:**

1. In the Export wizard, click **Export**.
2. If you are downloading a PDX package, skip to step 4. Otherwise, select an **Encoding Type** for the text file. The default encoding type is Unicode (UTF-8).
3. Click **Continue**. The File Download window appears.
4. Click **Save** to save the file to your computer.

**Viewing an Exported File**

If you export a text file, you can view it in a spreadsheet program, like Microsoft Excel, or in any text editor. If you export a PDX package, you can view it using Agile eXpress or another PDX-enabled application.

You can download the free Agile eXpress viewer from the following Web site: [http://www.myagile.com/eservices/express/](http://www.myagile.com/eservices/express/)

**Exporting Search Results**

From the Agile Java Client or Web Client, you can search for objects and export them to a comma-delimited (CSV) text file. This feature works for any type of search (Quick Search, Simple Search, Advanced Search, or Saved Search).

**Note** When you export search results, all objects listed in the search results are exported even if only some objects are selected when you click **Export**. In Web Client, you can also export selected objects from the search results by choosing **Tools > Export** to launch the Export wizard. However, the Export wizard does not support all object types.

**To export search results in Web Client:**

1. Run a search.
2. On the Search Results page, click **Export**.
3. Select an **Encoding Type** for the text file, and click **Continue**.
   - The File Download window appears.
4. Click **Save** to save the file to your computer.
5. Specify the filename, and click **Save**.

**To export search results in Java Client:**

1. Run a search.
2. In the Search Results window, click the **Export** button.
3. Select an **Encoding Type** for the text file, and click **OK**.
4. Specify the filename, and click **Save**.
This chapter describes Agile’s FileLoad utility. The following topics are covered:

- Overview
- Before You Begin
- Process Outline
- Preparing the Index File
- Processing Attachments
- Evaluating the Results
- Revising and Reloading Rejected Attachments
- Error Messages

Overview

FileLoad is a utility that helps load legacy attachment files directly from a source system into the Agile File Manager where they are attached to the appropriate Agile PLM objects. Files can be attached to most Agile PLM objects.

FileLoad is activated by choosing Tools > FileLoad from the menu bar of either the Agile Java Client or Web Client.

Files can be attached to the following Agile PLM object types:

Table 11-1: FileLoad supported object types

<table>
<thead>
<tr>
<th>Solution</th>
<th>Object Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Agile PLM Solutions</td>
<td>File Folder</td>
</tr>
<tr>
<td>Product Collaboration</td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>Manufacturer</td>
</tr>
<tr>
<td></td>
<td>Manufacturer Part</td>
</tr>
<tr>
<td>Product Governance &amp; Compliance</td>
<td>Declaration</td>
</tr>
<tr>
<td></td>
<td>Part Group</td>
</tr>
<tr>
<td></td>
<td>Specification</td>
</tr>
<tr>
<td></td>
<td>Substance</td>
</tr>
<tr>
<td>Product Cost Management</td>
<td>Price</td>
</tr>
<tr>
<td></td>
<td>Requests for Quote</td>
</tr>
<tr>
<td></td>
<td>RFQ Response</td>
</tr>
<tr>
<td></td>
<td>Sourcing Project</td>
</tr>
<tr>
<td></td>
<td>Supplier</td>
</tr>
</tbody>
</table>
FileLoad uses an attachment Index file that you prepare to identify the files to be loaded as attachments, and to identify the Agile PLM objects to which they will be connected. FileLoad places the attached files into the Agile File Manager vault and then updates the Agile PLM database.

**Note** Once legacy files have been loaded into your Agile PLM system, they may be attached to Agile PLM objects “as is,” and they may also be recast (using the Save As command) as new objects in the File Folders class.

### Choosing a FileLoad Client

Both the Agile Web Client and Java Client have FileLoad utilities. Although they are very similar, they perform differently and offer slightly different options.

**Table 11-2: FileLoad features in Agile Java Client and Web Client**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Java Client</th>
<th>Web Client</th>
<th>For More Info, See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loads files</td>
<td>✓</td>
<td>✓</td>
<td>page 11-9</td>
</tr>
<tr>
<td>Loads references to URLs (Web locations)</td>
<td>✓</td>
<td>✓</td>
<td>page 11-10</td>
</tr>
<tr>
<td>Loads references to files in a Custom (read-only) file vault (INPLACE attachments)</td>
<td>✓</td>
<td>✓</td>
<td>page 11-9</td>
</tr>
<tr>
<td>Supports files up to 40 Gb in size</td>
<td>✓</td>
<td>✓</td>
<td>page 11-3</td>
</tr>
<tr>
<td>Supports multiple dedicated threads</td>
<td>✓</td>
<td></td>
<td>page 11-12</td>
</tr>
<tr>
<td>Supports uploading files remotely</td>
<td>✓</td>
<td>✓</td>
<td>page 11-4</td>
</tr>
<tr>
<td>Locates files on the local machine (unless a network location is specified)</td>
<td>✓</td>
<td></td>
<td>page 11-3</td>
</tr>
<tr>
<td>Locates files on the Web proxy server (unless a network location is specified)</td>
<td></td>
<td>✓</td>
<td>page 11-3</td>
</tr>
<tr>
<td>Can load data into attachment flex fields</td>
<td>✓</td>
<td>✓</td>
<td>page 11-6</td>
</tr>
<tr>
<td>Can load multiple files into one file folder</td>
<td>✓</td>
<td>✓</td>
<td>page 11-10</td>
</tr>
<tr>
<td>Can attach files to the latest revision when the specified revision cannot be found</td>
<td>✓</td>
<td>✓</td>
<td>page 11-12</td>
</tr>
<tr>
<td>Can attach files to incorporated items</td>
<td>✓</td>
<td>✓</td>
<td>page 11-13</td>
</tr>
<tr>
<td>Generates log files in the location you specify</td>
<td>✓</td>
<td></td>
<td>page 11-13</td>
</tr>
<tr>
<td>Generates log files on the server. You can download them to your local machine.</td>
<td></td>
<td>✓</td>
<td>page 11-13</td>
</tr>
</tbody>
</table>

**Performance**

Generally, FileLoad performs faster in the Java Client, although performance varies depending on the capacity of the client and server computers. If the client and server computers are multiprocessor machines, you may see a significant improvement in FileLoad performance when you use the Java Client.
How FileLoad Locates Files

Unless you specify a network location for files, the Java Client FileLoad utility locates files on the local machine, whereas the Web Client FileLoad utility locates files on the Web proxy server (which can be on the same computer as the application server).

The FileLoad utility in both Agile PLM clients can access files remotely through a network path. For more information, see “Uploading Files Remotely” on page 11-4.

Loading References to Files

The FileLoad utility in the Agile Java Client supports an additional attachment type, INPLACE. You can use the INPLACE attachment type value to upload a reference to a file located in a Custom file vault. The reference to the file is stored in the Agile PLM database, but the actual physical file resides in the Custom vault. The Custom vault is read-only; files stored in a Custom vault cannot be checked out or modified.

Before trying to load references to files, make sure the Custom vault is set up. See “Setting Up a Custom File Vault” on page 11-4.

The Agile Web Client FileLoad utility doesn’t support INPLACE attachments.

FileLoad Options

The FileLoad user interface varies slightly depending on the Agile PLM client you use. For a complete list of FileLoad options, see Table 11-5 on page 11-12.

Before You Begin

Before you begin using FileLoad, make sure you have set up your environment correctly and have proper privileges described in this section.

File Size and Batch Limits

FileLoad can handle files up to 40 Gb in size. It can also process many files in one batch. Agile recommends not exceeding 15,000 files per processing batch.

Disabling Synchronous Full-Text Indexing

Before using FileLoad, turn off synchronous full-text indexing of files. When synchronous full-text indexing is enabled, FileLoad does not report progress, the browser times out on long uploads, and file-loading is extremely slow. After you finish using FileLoad, you can turn on synchronous full-text indexing of files again.

To disable synchronous full-text indexing:

1. Start Agile Java Client and log in as an administrator.
2. Click the Admin tab.
   The Full Text Search window appears.
4. Click the Indexing list and select Manual or Scheduled.
5. If you chose Scheduled, click the Recurrence field and schedule indexing to start after file-loading will be finished.
6. Click Save.

For more information about how to change full-text indexing settings for Agile PLM, see the Agile PLM Administrator Guide.
Turning Off Antivirus Software

If you use an antivirus tool, turn it off before using FileLoad. An antivirus tool will scan every new uploaded file, which will slow down the loading process.

Required Agile PLM Privileges

To use FileLoad to load file attachments to Agile PLM objects, you must have the same privileges as you would need to modify those objects in Agile PLM clients. In other words, you must have the Modify privilege for any object to which you are attaching a file.

In addition, you must also have the FileLoad privilege.

To change your Agile PLM roles and privileges, see your Agile PLM administrator.

Uploading Files From a Local Drive

Agile recommends that you upload files from a local drive. Otherwise, there is a risk that network-stored files, especially if they are very large, may cause FileLoad to quit, leaving the loading process only partially completed.

Uploading Files Remotely

Although Agile recommends uploading files from a local drive, you can also upload files remotely. Before trying to upload files from a remote computer, make sure:

- There is a shared folder in which to save attached files.
- If you are using the Agile Web Client, the operating system user that runs the Agile Application Server (such as System for Windows or Root for Solaris) must have Read access to the referenced file.
- If you are using the Agile Java Client, the operating system user logged into the client computer must have Read access to the referenced file.
- The network path is included in the Index files. For example:
  
  ITEM,P00001,,\computer\sharedfolder\file.txt,FILE,description

If these criteria are not met, you will see the following error message when you try to upload files remotely: “Cannot find the file to be attached.”

Setting Up a Custom File Vault

If you are using the Agile Java Client to upload references to files stored in a Custom file vault, the Agile PLM administrator must set up the vault first. For more information about administering Agile File Manager, see the *Agile PLM Administrator Guide*.

To set up a Custom file vault:

1. Start the Agile Java Client and log in as an administrator.
2. Click the Admin tab.
3. Choose Server Settings > Locations. The Server Location window appears.
4. Click the File Manager tab to bring it forward.
5. Double-click the entry to display the File Manager dialog box.
6. Click the + button to add a new vault.
7. In the Vault Type field, select Custom.
8. In the Description field, type a description of the vault.
9 In the **Base Storage Directory** field, enter the primary location where the files are stored. There can be other subdirectories containing files located beneath this directory.

10 Click **OK**.

11 Restart the Agile File Manager.

**Important** If you don’t restart the Agile File Manager after setting up the Custom vault, the FileLoad utility won’t be able to find the vault.

**Process Outline**

The FileLoad process follows these stages (the stages are discussed in detail in the sections that follow):

- **Stage 1: Prepare the Index File** (page 11-6) – Prepare an attachment Index file.
- **Stage 2: Process Attachments** (page 11-10) – Use FileLoad and the Index file to process the attachments.
- **Stage 3: Evaluate the Results** (page 11-13) – Evaluate the results. If any attachments were rejected, open the FileLoad log file and view the error messages.
- **Stage 4: Revise and Reload Rejected Attachments** (page 11-14) – Revise the rejected attachment rows in the “Bad” file. Save the Bad file as a new Index file, and load it.

Repeat Stages 3 and 4 until all attachments are loaded successfully.

The figure below depicts the FileLoad process.

**Important** It is recommended that no more than 200–300 items be loaded against one change. If a larger number of affected items are loaded against a change, FileLoad will take much longer to load the files and it will take much longer to bring up revisions of any item on that change.
Preparing the Index File

The first stage in batch-loading attachments with FileLoad is to prepare an attachment Index file. The Index file is a text file in which each row describes one file to be loaded as an Agile PLM attachment.

Each row that is updated must have at least six entries separated by delimiters, such as commas. To support uploading information to flex fields, additional attribute-value pairs can be specified.

Index File Structure

Each row in the Index file must have the following structure:

```
ObjectType, PrimaryKey, SecondaryKey, Path/Filename, AttachType, Description [,attrib1=value1,attrib2=value2,...attribn=valuen]<CR>
```

where

- **ObjectType** = A keyword identifying the object type. For a list of supported keywords, see “Object Type Keywords” on page 11-7.
- **PrimaryKey** = The value of a primary key field for the specified object type. For most objects, the primary key is the object number. The object you specify must already exist; FileLoad won’t create it.
- **SecondaryKey** = The value of a secondary key field for the specified object type. If the object doesn’t require a secondary key, leave the field blank.
- **Path/Filename** = A URL or a fully qualified path and filename.
  - If you specify a URL, make sure it’s correct. FileLoad does not validate URLs.
  - For the INPLACE attachment type (see below), the path you specify should be relative to the Base Storage Directory of the Custom file vault. For example, if the Base Storage Directory is d:/files, and the file you want to load is located in d:/files/cad/0021c.dwg, enter the following relative path: cad/0021c.dwg. The Agile File Manager iterates through all vaults (both standard and custom) until it finds the first matching file.
  - **Note:** Although Windows supports pathnames with backslashes (\), Solaris and other Unix operating systems do not. Consequently, forward slashes are used in path examples in this chapter.
- **AttachType** = Enter one of the following case-insensitive values:
  - **FILE** — Uploads a file to a Standard file vault.
  - **URL** — Adds a URL attachment to the object. A URL is a Web location, such as http://www.agile.com. You can specify non-HTTP URLs, such as an FTP site.
  - **INPLACE** — Uploads a reference to a file located in a Custom file vault, which is read-only.
  - **Note:** The INPLACE attachment type is supported only in the Agile Java Client and only if a Custom vault has been set up by the Agile PLM administrator.
- **Description** = An optional description of the file.
- **[,attrib1=value1, attrib2=value2,...attribn=valuen]** = Optional pairs of attribute names and attribute values used to load data into flex fields. The default separator character for attribute names and values is an equal sign (=), but you can specify another character. Separate each attribute/value pair with an attribute delimiter, such as a comma.

The following is an example of one row of an Index file:

```
ITEM,P00010,,C:/temp/logo_color.bmp,FILE,Description="Fileload,Test",Date01=12/12/00,
List01=Select1,Text01="Test_Fileload",Text02=DFSF<CR>
```
To make sure the line is interpreted correctly, the value for the Description attribute is “Fileload, Test”. Quotes are included around the text containing a comma so that it is not interpreted as an entry separator.

PrimaryKey and SecondaryKey field content requirements depend on the attachment object type. The specific requirements for each object type are described in “Primary and Secondary Keys” on page 11-8.

Here are some general notes on the Index file structure:

- All attachment flex fields must be enabled (made visible) from the Admin tab of the Agile Java Client. Flex fields that are used in the Index file but are not enabled will cause FileLoad to report an error.
  
  **Note** You cannot access administrative functions unless you have been assigned the Administrator privilege; please see your Agile PLM administrator for assistance.

- Each field must be separated by a delimiter character, such as a comma. The same delimiter character must be used throughout the Index file. The delimiter used in the index file must match the Attribute Delimiter that you select in the FileLoad utility. For more information about delimiter options, see Table 11-5 on page 11-12.

- The flex field attributes and values must be separated by a different delimiter from the delimiter used for the rest of the Index row.

- Doubled delimiters identify a blank field. In comma-delimited files, a blank field is specified by two commas, with no space between them, like this: ,,.

- Each row must always have a minimum of six delimited fields.

- Each attachment row must end with a carriage return.

- Short Index files of 100 to 200 lines can help you monitor what is going on and correct any problems more easily.

- Agile PLM does not change the incorporation date on the target object.

- To accommodate temporary files, FileLoad requires twice as much disk space as the size of the attachments being loaded by each Index file. If you do not have room to load all attachments at once, try using more Index files with smaller total attachment sizes to reduce the space required for each one. The temporary files are automatically deleted after the loading process is done.

- Successful attachments are logged in the **History** tab for the object.

- Maximum number of characters allowed:
  
  - Filename – 255 characters or the number of characters specified for the MaxLength property of the File Folders > Files > File Name field, whichever is less.

  - Description field – 100 characters or the number of characters specified for the MaxLength property of the File Folders > Files > File Description field, whichever is less.

### Object Type Keywords

The following table lists object type keywords for each base class that FileLoad supports. Use these keywords in the **ObjectType** field of your Index file.

Table 11-3: Object type keywords

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td>CHANGE</td>
</tr>
<tr>
<td>Declaration</td>
<td>DECLARATION</td>
</tr>
<tr>
<td>File Folder</td>
<td>FILEFOLDER</td>
</tr>
<tr>
<td>Item</td>
<td>ITEM</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>MFR</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>MFR_PART</td>
</tr>
<tr>
<td>Part Group</td>
<td>COMMODITY</td>
</tr>
</tbody>
</table>
Primary and Secondary Keys

The following table lists the primary and secondary keys required for each object type that FileLoad supports. If a secondary key is not required for an object, you may leave that field blank in the index file.

Table 11-4: Primary and secondary keys required by FileLoad

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Primary key</th>
<th>Secondary key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td>Change number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Declaration</td>
<td>Declaration number</td>
<td>[blank]</td>
</tr>
<tr>
<td></td>
<td>(equivalent to the <strong>Cover Page &gt; Name</strong> field)</td>
<td></td>
</tr>
<tr>
<td>File Folder</td>
<td>File Folder number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Item</td>
<td>Item number</td>
<td>Revision (optional)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Item Revisions” below.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Manufacturer name</td>
<td>[blank]</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td>Manufacturer Part number</td>
<td>Manufacturer name</td>
</tr>
<tr>
<td>Part Group</td>
<td>Part group number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Price</td>
<td>Price number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Product Service Request</td>
<td>Product Service Request number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Program</td>
<td>Program number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Quality Change Request</td>
<td>Quality Change Request number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Request for Quote</td>
<td>Request for Quote number</td>
<td>[blank]</td>
</tr>
<tr>
<td>RFQ Response</td>
<td>Request for Quote number</td>
<td>Supplier number</td>
</tr>
<tr>
<td>Sourcing Project</td>
<td>Project number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Specification</td>
<td>Specification number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Substance</td>
<td>Substance number</td>
<td>[blank]</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier number</td>
<td>[blank]</td>
</tr>
</tbody>
</table>

Item Revisions

If you are loading files for Items, you can specify an optional revision identifier in the SecondaryKey field. Use a valid revision identifier. For example, your company may use letters to identify revisions, such as A, B, C, and D. The following example loads a file for revision A:

```
ITEM,P00561,A,D:/dwg/00561a.dwg,FILE,Torque Widget
```
Chapter 11 Using FileLoad

To specify an Introductory revision (one that is newly created and unreleased), leave the SecondaryKey field blank, as in the following example:

ITEM, P00545,, D:/dwg/00545.dwg, FILE, Battery Cover

To specify a pending revision (one for which the change order has not yet been released), enclose the revision in parentheses, as in the following example:

ITEM, P00561, (B), D:/dwg/00561b.dwg, FILE, Torque Widget

Note If any revisions have been specified incorrectly in the Index file, the FileLoad utility has an option named Attach to the latest revision when the specified revision cannot be found to handle them. See Table 11-5 on page 11-12.

Sample Index Files

This section shows examples of how the comma-delimited Index files should look. Although these examples show the use of FILE, INPLACE, and URL attachment types in different Index files, they can also be used in the same file.

Sample Index File Used to Upload Files

The following rows are from a sample comma-delimited Index file that uses the FILE attachment type. The object types have been arranged in alphabetical order for readability.

ACTIVITY, PG0278,, D:/myprograms/phasecost.doc, FILE, Phase Cost Report
ITEM, P00545,, D:/dwg/00545.dwg, FILE, Battery Cover
ITEM, P00561, A, D:/dwg/00561a.dwg, FILE, Torque Widget
ITEM, P00561, (B), D:/dwg/00561b.dwg, FILE, Torque Widget
CHANGE, 25000,, D:/dwg/00561b.dwg, FILE, Torque Widget
COMMODITY, PG0278,, D:/groups/guidelines.doc, FILE, Part Group Guidelines
DECLARATION, MD00007,, D:/docs/DecInstr.doc, FILE, Instructions
FILEFOLDER, FOLDER00042,, D:/specs/92master.doc, FILE, 9.2 Master Spec
MFR, Manutech,, D:/dwg/0021c.dwg, FILE, Torque Widget
MFR_PART, WE10023-45, Manutech, D:/dwg/0021c.dwg, FILE, Torque Widget
PRICE, CONTRACT00001,, D:/pricing/price_sheet.xls, FILE, Price Sheet
PROJECT, PRJ00046,, D:/projects/dell/resources.xls, FILE, Resource Spreadsheet
PSR, PR00004,, D:/pt.sn00241.doc, FILE, Support Notes
QCR, CAPA00001,, D:/capa/details.doc, FILE, Problem Details
RESPONSE, RFQ00001, SUP00067,, D:/rfq/notes.doc, FILE, Notes
RFQ, RFQ00001,, D:/quotes/guidelines.doc, FILE, Price Quote Guidelines
SPECIFICATION, SPEC0023,, D:/specs/rohs.doc, FILE, ROHS Guidelines
SUBSTANCE, SUB0104,, D:/subs/cas_numbers.doc, FILE, CAS Numbers
SUPPLIER, DISTRIBUTOR00001,, D:/suppliers/wextronics.doc, FILE, Wextronics Profile

Sample Index File Used to Upload References to Files

The following rows are from another sample comma-delimited Index file that uses the INPLACE attachment type.

Important The INPLACE attachment type is supported only if you use the FileLoad utility in the Agile Java Client and the Agile PLM administrator has set up a Custom (read-only) file vault. See “Setting Up a Custom File Vault” on page 11-4. The Agile Web Client FileLoad utility doesn’t support INPLACE attachments.

ITEM, P00240, A, dwg/00240a.dwg, INPLACE, CAD Drawing
ITEM, P00262, B, dwg/00262b.dwg, INPLACE, CAD Drawing
ITEM, P00262, (C), dwg/00262c.dwg, INPLACE, CAD Drawing
ITEM, P00310, A, dwg/00310a.dwg, INPLACE, CAD Drawing
ITEM, P00337, A, dwg/00337a.dwg, INPLACE, CAD Drawing
Sample Index File Used to Upload URLs

The following rows are from another sample comma-delimited Index file that uses the URL attachment type.

| FILEFOLDER, FOLDER00010,,http://www.yourcompany.com, URL, Home Site |
| FILEFOLDER, FOLDER00010,,http://www.yourcompany.com/Mfg/, URL, Manufacturing Services Site |
| FILEFOLDER, FOLDER00010,,http://www.google.com, URL, Google |

Loading Multiple Files into the Same File Folder

If consecutive rows of the Index file have the same PrimaryKey value (that is, they reference the same object), FileLoad can either create a separate file folder for each file or put the files in one file folder. For example, the following rows from an Index file reference the same item, 76-2063:

ITEM, 76-2063, D, C:/load/fileload/2063P1.tif, FILE, AMP Specifications
ITEM, 76-2063, D, C:/load/fileload/2063P2.tif, FILE, |

If you unchecked the box named Create a Separate Folder for Each File, the same description will be used for both files and they will be added to the same file folder. If you check the Create a Separate Folder for Each File box, then separate file folders will be created for them with separate file descriptions.

Another way to create separate file folders and separate file descriptions for consecutive rows that have the same PrimaryKey value is to add a blank row with a carriage return between the rows. This works regardless whether the Create a Separate Folder for Each File box is checked or unchecked. However, the consecutive rows that have the same PrimaryKey value must also have the same attachment type. A FILE and a URL attachment cannot be added to the same file folder.

How File Manager Locates INPLACE Files

To locate a file, File Manager interates through all vaults (both standard and custom) until it finds the first matching file. If there are files with duplicate filenames in different vaults, it’s possible to upload a reference to the wrong INPLACE file. To uniquely identify an INPLACE file located in a file vault, make sure its path is unique even if its filename is not.

Note File Manager information is downloaded and cached when the server is started. If you used the Agile Java Client to add a new custom (read-only) vault, don’t forget to restart the File Manager. Otherwise, File Manager won’t be able to find the new vault.

Processing Attachments

After you have created your attachment Index file, you can start FileLoad and process the attachments.

Caution! Be aware that different users may have rights to load files to different file vaults. If you are supervising the loading of a large number of files with different users (for example, over day and night shifts), be aware of the influence of the login user on any machine being used for processing.

To start FileLoad:

1. In either the Agile Java Client or the Web Client, choose Tools > FileLoad.
2. Specify the Index file and other FileLoad options.
3. Click OK (Java Client) or Start Loading (Web Client) to begin loading files.

The following figures show FileLoad in the Agile Java Client and Web Client.
Chapter 11 Using FileLoad

Figure 11-2: FileLoad window in Agile Java Client

Figure 11-3: FileLoad page in Agile Web Client
The following table lists FileLoad options.

Table 11-5: FileLoad options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Index File** | Click **Browse** to locate and select the attachment Index file. The path and filename of the attachments Index file appears.  
**Note:** It is recommended that .LOG and .BAD not be used as filename extensions for the Index file. The extension of the Index file can be anything as long as its content is in ASCII encoding, but it is helpful to pick an extension that will not be confusing. |
| **Attribute Delimiter** | Select the delimiter used in the Index file. You can select **Tab** or select **Other** and provide another delimiter in the field. For **Other** delimiters, only the following characters are allowed:  
<space>, | ; ' [ ] '< > '?' '{ } ' ~ @ $ % & ( ) _ + - =  
You cannot use any characters that are created by pressing ALT+keypad combinations.  
**Note:** Do not use a colon (:), period (.), slash (/) or backslash (\) in the **Attribute Delimiter**, **Attribute Name-Value Separator**, **Text Qualifier**, and **Multilist Delimiter** fields, as those characters can be used in the filename or path. |
| **Attribute Name-Value Separator** | Select the delimiter used in the flex fields. This delimiter must adhere to the same rules listed for attribute delimiters, but cannot duplicate the choice for any other delimiter. |
| **Text Qualifier** | The delimiter used to specify a text string within the Index row. It is recommended that this be set to quotes, but it can be set to any valid delimiter. This delimiter must adhere to the same rules listed for attribute delimiters, but cannot duplicate the choice for any other delimiter. |
| **Multilist Delimiter** | This delimiter is used to separate entries in a multilist field. The default is a semicolon, but it can be set to any valid delimiter. This delimiter must adhere to the same rules listed for attribute delimiters, but cannot duplicate the choice for any other delimiter.  
**Note:** The Attachments tab does not have MultiList flex fields, but the Files tab of File Folder objects does. Consequently, the Multilist Delimiter is used only if you are loading files into File Folders. |
| **Number of Dedicated Threads** (Java Client) | Enter a value from 1 to 100 to specify the number of threads dedicated to the FileLoad process. Increasing the number of dedicated threads, particularly if the client and server are multiprocessor machines, can improve FileLoad performance. |
| **Attach to the latest revision when the specified revision cannot be found** | Select this option if you want files for items containing revision values that do not exist in the Agile PLM database to be attached to the latest released revision of objects in Agile PLM. If no released revisions exists, Fileload adds the file to the Introductory revision. (The **SecondaryKey** field in the Index file holds the revision value of the item.)  
The attachment is rejected and written to the Bad file and Log file under the following conditions:  
• If you do not select this option, the Index file attachment rows for items containing revision values that do not exist in the Agile PLM database are rejected and written to the Bad file and the Log file for later troubleshooting.  
• If **Attach to the Latest Revision** is checked, the file is attached to the latest released revision of the object. If the object is in Preliminary status, it is attached to the Introductory revision.  
• When an Index file contains a blank **SecondaryKey** field, the file is attached to the Introductory revision of an item. The Null revision in the Index file means the Introductory revision.  
• To upload files to pending revisions, the revision value in the Index file should be enclosed in parentheses, for example, (A) or (1.0). |
Chapter 11 Using FileLoad

Table 11-5: FileLoad options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Attach Files to Incorporated Items | Check this box if you want to allow attachments to be added to incorporated Items (assuming you have appropriate privileges). If this box is not checked, and FileLoad attempts to attach files to an Item that has been incorporated, you may see the message “Cannot perform this operation because the object <Object number> has been incorporated.”  
  Note: If any item in your Index file is already incorporated, make sure Attach Files to Incorporated Items is checked. |
| Create a Separate Folder for Each File | When this box is checked, FileLoad load files into separate file folders. Otherwise, FileLoad handles consecutive rows that have the same PrimaryKey value differently. It uses the same file description for both files and adds the files to the same file folder. |
| Log File Directory (Java Client)   | Specify a location in which to create log files.                                                                                                                                                       |
| OK (Java Client)                   | Starts reading the Index file and processing attachments.                                                                                                                                              |
| Start Loading (Web Client)         |                                                                                                                                                                                                        |
| Close (Java Client)                | Closes the FileLoad window or page. Note: The Cancel and Close buttons are disabled once the loading process has started.                                                                             |
| Cancel (Web Client)                |                                                                                                                                                                                                        |

**Important**  If FileLoad stops without a completion message, it may have encountered severe network difficulties and not completed the load. In this case, you must validate that the last file in the “load” is in the target database. If it is not and it does not appear in the Bad file, you must determine where FileLoad stopped, then load the remaining files.

**Evaluating the Results**

This section describes how to evaluate FileLoad results in the Java Client and Web Client.

**Evaluating FileLoad Results in the Java Client**

In Agile Java Client, the FileLoad summary appears in an expanded portion of the FileLoad window.

Figure 11-4: FileLoad summary (Java Client)

<table>
<thead>
<tr>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
</table>

FileLoad log files are stored in the specified Log File Directory. You can open the log files in a text editor to view them. For each session, FileLoad creates the following log files:

- `indexfile.date.time_BAD` – Contains the rows from the Index file that were rejected during the FileLoad process.
- `indexfile.date.time_LOADED` – Contains the rows rejected from the Index file that were successfully loaded during the FileLoad process.
- `indexfile.date.time_LOG` – Contains each row from the Index file that was rejected during the FileLoad process, along with an error message.
- `indexfile.date.time_SUMMARY` – Contains the FileLoad summary information.

**Note**  If you rename the log files and give them a `.TXT` extension, they will automatically be associated with a text editor.
Evaluating FileLoad Results in the Web Client

In Agile Web Client, the FileLoad Summary appears after FileLoad has finished processing the Index file attachments.

![FileLoad Summary](Image)

Attachment loading results are shown in FileLoad Summary.

Click **View Bad File** to open or save the log of bad records (LogFile.BAD). It contains rows from the Index file that were rejected during the FileLoad process.

Click **View Log File** to open or save the log file (LogFile.LOG), which contains each row from the Index file that was rejected during the FileLoad process, along with an error message.

**Note** Agile recommends that you save log files to disk first and then view them. When you save a log file, add `.TXT` as the extension so the file is automatically associated with a text editor.

To close the FileLoad page, click **Done**.

Sample Log File Output

Each rejected Index file row in the Bad file is also written to the Log file with an explanatory error message:

```
CHANGE,23450,,D:/dwg/0021c.dwg,FILE,Torque Widget
< Cannot find the file to be attached. >

ITEMBAD,1000-02,666,D:/dwg/0021c.dwg,FILE,Torque Widget
< Invalid object type. >

MFR,MFR_TEST1,,D:/dwg/0031e.dwg,FILE,Cap Widget
< Object not found. >
```

Revising and Reloading Rejected Attachments

Each rejected row from the Index file is written to both the Bad file and the Log file.

- The Bad file contains only the rows rejected from the Index file.
- The Log file is the same as the Bad file, but also includes an explanatory error message for each rejected attachment row.

Use the error messages in the Log file as a guide to revising the rejected rows in the Bad file. See page 11-15 for information about the error messages.

**Important** Do not commit to using the loaded-in files until you have verified that they are exact copies of the source files. That is, all source files should be preserved while there remains any possibility that a file or files could be needed if there was a problem during the loading operation.
To work with the Log and Bad files:
1. Locate the Bad file and Log file, and open each in a text editor.
2. Revise the rejected attachment rows in the Bad file, using the error messages in the Log file.
3. Save the revised Bad file as a new Index file, but add a number to the filename. For example, IndexBAD1.txt. This allows you to avoid overwriting the original Index file, and maintains an archive of processed Index files.
4. Select and process the new Log file. See “Processing Attachments” on page 11-10.
5. Repeat this revision and reloading process until no more bad records appear in the FileLoad Summary.

Caution! FileLoad will attach all specified files again if it is re-run against an Index file that has already been loaded. If you are using multiple Index files, always track which files have been loaded successfully. It is difficult and time-consuming to determine and remove duplicate attachments.

Error Messages

This section lists FileLoad error messages you may see, with explanations:

Attachment tab is invisible.
Attachment tab of the objects that you want to add files is not active in Administrator. Attachment tab must be marked visible by an Agile PLM administrator using Agile Java Client.

Cannot find the file to be attached.
Revise and correct the path and spelling of the attachment file name in the Index file entry. If you attached a URL, note that the supported protocols are FTP, HTTP, file, and HTTPS; there is no verification of the address.

Cannot find object <primary key>.
The target object to receive the attachment cannot be located in the database. The object is the combination of the first three row fields: ObjectType, PrimaryKey, SecondaryKey. Verify that the values for these fields are entered correctly in the Bad file and that an object of that name exists in the database. Add the object or modify the Index file, as necessary.

Cannot find specified revision.
The Item revision identifier in the Index file does not exist in the database, and Attach to latest revision was not selected in the FileLoad Options. See “Processing Attachments” on page 11-10.

Cannot find the Index file or the Index file is empty.
The path of the Index file is not correct (if you entered the Index file path manually) or the Index file you located is empty.

Cannot find the list value.
All or some list values for flex List or Multilist fields are not valid.

Cannot perform this operation because the attachment is checked out.
The file folder for the specified attachment is checked out, so the file can’t be uploaded. Make sure the file folder is checked in, and then use FileLoad again to upload the file.

Cannot perform this operation because the object <Object number> has been incorporated.
The attachment table is read-only because the Item is incorporated by an ECO. To add attachments to incorporated Items, make sure Attach Files To Incorporated Items is checked in the FileLoad Options dialog box.

Failed to attach files.
Reason for rejection unknown or the result of multiple errors. Make sure the object exists in the database, check the Index file entry, and retry. Make sure that you have the Creator role.
Empty files are not valid to be added.
  Attached files are 0 (zero) in size.

FileServers may be down. Please check the FileServer Configuration.
  The Agile File Manager server is down. Go to the machine where File Manager is installed and start it. On
  Windows, this involves starting the Apache Tomcat service.

Invalid date format.
  The date format in flex Date fields is not in accordance with the Date/Time formats in the user's profile.

Invalid number.
  The value for flex Numeric fields is not numeric (for example, it could include a letter string).

Invalid object type.
  Be sure the Index file row starts with a valid object type keyword. See “Object Type Keywords” on page 11-7.

Invisible attribute fields.
  The specified flex field is not visible. Flex fields must be enabled (that is, made visible) in the Administrator
  function.

Not a legal attachment type. Must be FILE or URL or INPLACE.
  If you use the FileLoad utility in the Agile Web Client, the AttachType (attachment type) field value must be FILE
  or URL. If you use the FileLoad utility in the Agile Java Client, a third attachment type, INPLACE, is supported.

Number of fields provided is less than the minimum required.
  Each Index file row must have at least six delimited fields. Empty fields must be marked by a double set of
  delimiter characters.
  Note When using the tab as the delimiter, be sure there is no tab after the last field in each row.

Primary Key (2nd) field empty.
  The second field – PrimaryKey – is always required. It must always contain, depending on the base class, a valid
  object number or name. See “Primary and Secondary Keys” on page 11-8.

The attribute fieldname was not found in the Attachments tab.
  This message indicates that the specified flex field name cannot be found. Flex fields must be enabled (that is,
  made visible) in the Administrator function. Also, if the Attribute Name-Value separator in Index files is not correct,
  the fieldname cannot be properly identified.

The number length exceeds maxlength.
  The string length for flex Numeric fields exceeds the maxlength defined in Administrator.

The number value is not between Min Value and Max Value.
  The value for flex Numeric fields is not between Min Value and Max Value defined in Administrator.

The string length is not between 0 and Maxlength.
  The string length for flex Text fields exceeds the maxlength defined in Administrator

The user has insufficient privileges.
  The user has insufficient privileges to files attached to objects.

Unable to connect to Agile Application Server.
  Make sure that the Agile Application Server is running and that you log in as a user with the Checkin privilege.
INDEX

A
Agile Classes Report 6-5
Agile eXpress 2-16
Agile eXpress, PDX packages and 10-4
Agile Import Server, prerequisites 1-2
Agile systems, sending data between 10-4
Agile XML (aXML) 2-16
AML 2-16
AMLs 3-1
delimiters 3-2
error messages 11-15
importing from Agile packages 3-14
latest revisions 3-13
processing 11-10
redlines 3-14
revising 11-14
rollback of parent objects 3-14
structure 11-6
URL attachments 3-14
attributes
read-through 2-3
Authoring mode 3-8, 6-6, 8-2
AutoNumber sources 8-4
aXML 2-16

B
Big5 encoding 2-16
bills of material 3-3
rollbacks 3-4
bills of material See BOMs
BOM 2-16
BOM & AML Import Behavior preference 8-3
BOMs 3-1
delimiters 3-9
sites 3-10
rollbacks 3-9
sites 3-10
sorting 2-12

C
canceling an import operation 9-1
carriage returns 2-11, 2-12
Cascade Delimiter Character preference 8-1
cascading lists 2-8
Case Validation Action preference 8-1
Change Mode preference 8-2
coma-delimited (CSV) format 10-3
coma-separated files 2-15
commodity offerings 4-2
continuation rows 2-9
country names 2-8
currency conversion rates 4-7
currency, importing 2-5
currency, preferred 2-7
customers 3-2
delta BOMs and AMLs 10-7
delimiters 3-9
equations 3-10
antivirus software 11-4
approved manufacturer lists 3-5
attachments 3-2
delimiters 11-7
error messages 11-15
importing from Agile packages 3-14
latest revisions 3-13
processing 11-10
redlines 3-14
revising 11-14
rollback of parent objects 3-14
structure 11-6
URL attachments 3-14
attributes
read-through 2-3
Authoring mode 3-8, 6-6, 8-2
AutoNumber sources 8-4
aXML 2-16

D
data types 2-2
date formats 2-3
date values preferred date format 2-3
supported formats for import 2-3
time zone 2-5
upper limit 2-3
declarations 3-2, 3-11
exporting and importing 3-12
default mapping 6-9
Default Types preference 8-4
delimited text files 2-10, 2-15
delimiters 11-7
cascading list 8-1
field 2-15, 2-16
MultiList 2-11, 8-1
reference designator 2-9, 8-3
delta BOMs and AMLs 10-7
Document Type field 3-2
dynamic lists 2-8
exporting data 10-1
delta BOMs and AMLs 10-7
coding type 10-5
file formats 10-3
filters 10-5
delta BOMs and AMLs 10-7
delimiters 3-9
importing from Agile packages 3-14
latest revisions 3-13
processing 11-10
redlines 3-14
revising 11-14
rollback of parent objects 3-14
structure 11-6
URL attachments 3-14
attributes
read-through 2-3
Authoring mode 3-8, 6-6, 8-2
AutoNumber sources 8-4
aXML 2-16

E
ECO 2-16
ECR 2-16
effectivity periods 5-1
empty fields, replacing 7-4
encoding 2-16
encoding type 10-5, 10-8
encrypted PDX data 10-4
error messages, FileLoad 11-15
Errors/Warnings box 6-9
Excel See Microsoft Excel
expanding mapping fields 6-7
expansion of reference designators 2-9
Export button 10-8
Export privilege 10-1
export, required privileges 10-1
exporting data 10-1
export, required privileges 10-1

F
fields
data types 2-2
delimiters 2-15
key fields and required fields 6-1
maximum length values 2-3
FILE attachment type 11-6
file encoding 2-16
FileLoad
batch limits 11-3
error messages 11-15
file size limits 11-3
index file 11-6
index file results 11-14
index file structure 11-6
installing 11-1
logging in 11-10
object type keywords 11-7
overview 11-1
primary and secondary keys 11-7, 11-8
revising attachments 11-14
FileLoad privilege 11-4
FileLoad, required privileges 11-4
files
FileLoad index 11-6
PDX 10-4
filters
delta BOMs and AMLs 10-7
exporting data 10-5
formulas in Excel files 2-11
full-text indexing 11-3

G
General number format 2-13
GMT 2-5

H
header rows 2-11, 2-14, 2-15
horizontal price points 4-6

Index–1
import preferences 8-1–8-4
  AutoNumber sources 8-4
  BOM & AML Import Behavior 8-3
  Cascade Delimiter Character 8-1
  Case Validation Action 8-1
  Change Mode 8-2
  Default Types 8-4
  Length Validation Action 8-2
  Log Transformations 8-1
  Multi Row Update Mode 8-3
  Multilist Delimiter Character 8-1
  parsing and validation options 8-1
  Price Quantity Break Default 8-3
  Redline Mode Behavior 8-3
  Reference Designator Delimiter Character 8-3
  Reference Designator Range Character 8-3
  Smart Rules Warning Violation Behavior 8-2
  Whiteline Validation Action 8-1
import log 9-2
Import privilege 1-3
Import, required privileges 1-3
importing, PDX packages and 10-4
  index file
    attachments 11-10
    delimiters 11-7
    error messages 11-15
    evaluating attachments 11-14
    preparing 11-6
    revising attachments 11-14
    structure 11-6
  index file, FileLoad 11-6
INPLACE attachment type 11-6
installing
  FileLoad 11-1
Introductory revision 11-9
ISO date formats 2-5
ISO-8859-1 2-16
items 3-1, 3-2
  automatic creation 3-4

K
key fields 6-1

L
large import files 1-4
leading zeros 2-10
Length Validation Action preference 8-2
level template 2-19
linefeed characters 2-11, 2-12
lists, cascading 2-8
lists, dynamic 2-8
log file 9-2
Log Transformations preference 8-1
LogFile.xml 9-2

M
manufacturer offerings 4-2
manufacturer parts 3-1
  automatic creation 3-5
manufacturers 3-1
mapping files 6-1
  creating 6-6
    default mapping 6-9
    editing 6-9
    errors and warnings 6-9
    expanding fields 6-7
    key fields 6-1
    quantity breaks 5-2
    required fields 6-1
    reusing 6-8
    unmapping fields 6-7
mass, importing 2-8
maximum length
  reference designators 2-11
maximum length values 2-3
Microsoft Excel
data parsing 2-14
  editing CSV files 2-13
    example of importable file 2-13
    file configuration 2-14
    guidelines 2-10
  importing CSV files 2-14
  removing carriage returns and linefeed characters 2-12
Microsoft Excel format 10-3
money, importing 2-7
Multi Row Update Mode preference 8-3
Multilist Delimiter Character preference 8-1

O
object type keywords 11-7
overview
  FileLoad 11-1

P
packages
  importing attachments from 3-14
  packages (PDX files) 10-4
    creating 10-4
parent items 3-3
parent-child fields 2-3
parent-child template 2-21
parsing and validation options 8-1
part groups 3-2, 3-11
Part Type field 3-2
PDX packages 10-3, 10-4
  creating 10-4
    default mapping 6-9
    reference designators 2-10
pending revision 11-9
preferred date format 2-3
PREFIX operation 7-2
prerequisites 1-2
price points 4-6
Price Quantity Break Default preference 8-3
price scenarios 5-1
privileges
  Export privilege 10-1
  FileLoad privilege 11-4
  Import privilege 1-3
    required for
      Export 10-1
      FileLoad 11-4
      Import 1-3
Product Data Exchange (PDX) 2-16, 10-4
Product Governance & Compliance data 3-11
product service requests 3-2
projects 5-1–5-3
provinces 2-8
Published Prices
  importing 3-5
published prices 3-2

Q
quantity breaks 5-1, 5-2
Quantity field 2-11
quantity rollups 5-2
Quote Histories
  importing 3-5
quote histories 3-1
  quoting 4-3

R
ranges of reference designators 2-9
read-through attributes 2-3
Redline Changes Only filter option 10-7
Redline Mode Behavior preference 8-3
Redlining mode 1-5, 3-8, 6-6, 8-2
Reference Designator Delimiter Character preference 8-3
Reference Designator Range Character preference 8-3
reference designators 2-9
continuation rows 2-9
expanding and collapsing 2-9, 2-10
leading zeros 2-10
maximum length 2-11
PDX packages 2-10
ranges 2-9
Reference Designators Allow Range Expand Collapse preference 2-10
regions 2-8
regular expressions 7-3
REPLACE operation 7-2, 7-3
required fields 6-1
required privileges
  Export 10-1
  FileLoad 11-4
  Import 1-3
responses, supplier 4-3
revising attachments 11-14
revisions 11-8
rollbacks 3-4, 3-9
S
saving the log file 9-2
scientific notation 2-13
search results, exporting 10-8
security, PDX data 10-4
sending data between Agile systems 10-4
sites
  BOM and AML import 3-10
  SJIS encoding 2-16
Smart Rules Warning Violation Behavior preference 8-2
sorting
  BOMs 2-12
  import fields 6-7
specifications 3-2, 3-11
states 2-8
substances 3-2, 3-11
SUFFIX operation 7-2
supplier responses 4-3
  editing guidelines 4-4
  price points 4-6
suppliers
  commodity offerings 4-2
  importing 2-8, 4-1
  manufacturer offerings 4-2
synchronous full-text indexing 11-3
T
templates 2-18
  level template 2-19
  parent-child template 2-21
text files
  exporting data to 10-1
  importing 2-15
Text format 2-13
text qualifier character 2-15
time zone 2-5
transformation files
  item numbers 7-5
  list values 7-5
  manufacturer names 7-6
  PREFIX, SUFFIX, and REPLACE operations 7-2
  product lines 7-5
  regular expressions 7-3
  replacing empty fields 7-4
  required columns 7-2
  reusing 7-6
  template 7-4
troubleshooting
  FileLoad 11-15
  import 9-2
U
unmapping fields 6-7
URL attachments 3-14, 11-6
W
Whitespace Validation Action preference 8-1
X
XML format 10-4
Z
zeros, leading 2-10